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1. AFCEE

The Air Force Center for Environmental Excellence (AFCEE), is one of three service centers
supporting Air Force Major Commands (MAJCOMSs) and their installations in conducting
Installation Restoration Program (IRP) remedial investigations and feasibility studies. The
objective of the Air Force integrated IRP is to assess past hazardous waste disposal and spill
sites on Air Force instalations and develop remedial actions consistent with the National
Contingency Plan (NCP) for those sites which pose a threat to human health and welfare or
the environment. All aspects of the IRP must be in compliance with provisions of Public Law
96-510, the Comprehensive Environmental Response, Compensation and Liability Act of 080
(CERCLA) and Public Law 99-499, Superfund Amendments and Reauthorization Act of 1986
(SARA); with Environmental Protection Agency regulations; and with all applicable state laws
and regulations.

IRP investigations and studies involve extensive fieldwork and the collection and analysis of
groundwater, surface water, sediment, soil, air, socioeconomic and ecological data. The
Mission Support Computer (MSC) Division maintains all data collected in these efforts Air
Force wide in the Environmental Resources Program (ERP) Information Management System
(ERPIMS). The Air Force has directed ERPIMS to be the central database for the entire Air
Force ERP. This datais ultimately used by an in-house staff consisting of contract specialists,
analytical chemists, biologists, hydrologists, environmenta engineers, civil engineers, and
system analysts. The data will also be made available to personnel external to AFCEE.

ERPTo0ls/PC has been developed by AFCEE for distribution to contractors to assist them in
preparing ERPIM S data submissions. The goal is the production of data files that accurately
describe ERP data. ERPTo0ls/PC has also incorporated the ERPIM S functionality of
ERPTools/LAB and will alow laboratories to create submission files that are sent to their Prime
contractors.

1.1 IDENTIFICATION

This User Manual provides step-by-step operating instructions to end users of ERPTools/PC v.
4 in support of ERPIMS. 1t is organized into sections, including:

1 AFCEE

2 Referenced Documents

3 System Overview

4 What's New in Version Four
5 Setup and Configuration

6 Using ERPToolsPC

7 Techniques

8 Menus and Toolbars

9 Error Messages
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10 Acronyms

11 Table Descriptions

12 Import/Export Specifications
13 vdid Vdue Ligs

14 Table Field Descriptions
Index

1.2 AFCEE SupPORT

AFCEE is responsible for ERPTools/PC. This user manual has been designed for distribution
to assist contractors in preparing data submissions using ERPTools/PC. Written inquiries
concerning the user manual, help files, ERPTools/PC or ERPIMS should be addressed to:

HQ AFCEE/IMSC
Attn: ERPIMS
3207 North Road, Bldg 532
Brooks AFB TX 78235-5363

World Wide Web: http://www.af cee.brooks.af . mil

WWW ERPIMS: http://www.af cee.brooks.af.mil/M S/msc_irp.htm

(Access the ERPIM S website by selecting the Help-> Tech Support option in
ERPTools/PC.)

In addition, AFCEE provides the ERPIMS Help Desk
1-877-ERPIMS3 (377-4673)

Fax: (210) 223-8820

ERPIMS Help Desk
118 Broadway, Ste 316
San Antonio, TX 78205
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2. REFERENCED DOCUMENTS

The following documents of the exact issue shown are referenced in this plan. This section
also identifies the source for al documents not available through norma Government stocking
activities.

FIPS PUB 183, 21 December 1993, Integration Definition for Function Modeling (IDEFO).

FIPS PUB 184, 21 December 1993, Integration Definition for Information Modeling
(IDEF1X).

DoD 8320.1-M1, January 1993, DoD Data Element Standardization Procedures.

DoD 8320.1-M-X, November 1994, Enterprise Data Model Development Approva and
Maintenance Procedures.

MIL-STD-498, 5 December 1994, Software Development and Documentation.

MIL-STD-1521B, 19 December 1985, Notice 1, Technical Reviews and Audits for
Systems, Equipment and Computer Software.

PWS F41624-97-D-8014-0006, dated 4 August 1998, Support and Maintenance for Air
Force Environmental Resources Program Information Management System (ERPIMS) and
Support Systems.

AFCEE Software Programming Standards, 18 June 1998.
AFCEE Software Design Standards, 20 March 1998.
IRPIMS Data L oading Handbook Version 4.0, July 1997.
AFCEE Configuration Management Standard.

F41624-97-D-8014-0002, 13 February 1998, Interface Requirements Specification (IRS)
for ERPToolg/Convert, Environmental Resaurces Program Information Management
System (ERPIMS).
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3. SYSTEM OVERVIEW

ERP Contractors are required to submit data files to AFCEE in electronic formats compatible
with the ERPIM S database. ERPToo0ls/PC was developed by AFCEE for didribution to those
contractors.

3.1 PurpostEoF ERPTooLs/PC

ERPTo0ls/PC prepares data submissions that comply with ERPIMS Data L oading Handbook
(DLH) specification 5.0. It incorporates a number of automatic error checking routines to
identify duplicate record sets; incorrect date/time/number formats; invalid codes; failure to
complete required data fields essential for file integrity and field, record and submission level
validation.

ERPTools/PC v. 4 supports validation rules, which have a separate version number. These
validation rules may be changed and reissued more often than the basic program. It aso
incorporates the capabilities of the ERPTools/LAB program designed for laboratories
processing samples for prime contractors.

3.2 ERPToOOLSPROJECTS

There are two types of projectsin ERPTools/PC. There are Prime projects and Lab projects.
A Prime project is a grouping of ERPIMS data that belongs to a particular contract, delivery
order and installation. A Lab project is strictly the Sample, Test, and Results information that
is needed for the lab’s Prime contractor. Under this version of ERPTools/PC each project’s
files are maintained in a separate database file, in arelated set of tables.
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Figure 3-1 Table Relationship Structure

It is important to understand these rel ationships because they are the basis to the operation of
ERPTools/PC. The relationships can be compared to afamily tree. LDI is the parent to
fourteen tables, including SAMPLE. SAMPLE has one child, TEST, and TEST has one child,
RESULT. There are several crossreference tables (usually identified with an “X” in the name)
that tie data between two associated tables.

One place where these relationships comeinto play is when arecord is added or deleted. A
record cannot be added to a child table if there is no parent. For example, a TEST record
cannot be inserted if there are no SAMPLE records.

Data entry is aso affected. If one user isimporting to or aliting a table, no other table in that
line, either parent or child, may be edited.

Deleting records is far more serious. If a parent record is deleted, ALL CHILDREN of that
parent are deleted. Delete a TEST record and al results for that test are deleted. Delete a
SAMPLE record and &l TEST and RESULT that are related are deleted. Delete alocation
record (LDI) and al datarelated to that LDI record is deleted in SAMPLE, TEST, RESULT
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and al the other tables subordinate to LDI. There is no way to prevent this automatic deleting

of child records.

A project of either type is created using the Create Projectmenu command. ERPTools/PC
users can change from one project to another using the File=> Open Project menu command.
Project information can be edited using the File> Edit Project Info command.

A project may be deleted using the File Delete Project menu command. Only administrative

users can create, edit, and delete projects.

3.2.1 Typesof ERPIMS Data

ERPTools/PC can be used to prepare the following types of Prime and LabERPIMS data:

3.2.1.1 PRIME CONTRACT DATA

Analytical Result (RESULT)
Aquifer Test (ATI)

Calculated Hydrology (CALC)

Contract (PROJECT)

Environmental Measurement (EMI)

Groundwater Level (GWD)

Hydrostratigraphic Unit (HSU)

Lithologic Description (LTD)

Location (LDI)

Location and Operable Unit Cross Reference
(LOX)

Location and Remediation System Cross
Reference (LSX)

Location and Remediation Technology Cross
Reference (LTX)

Location and Site Cross Reference (SLX)

Location and Zone Cross Reference (ZLX)

Map Reference (MRI)

Observation Well Water Level (OWL)

Operable Unit (OU)

Operable Unit Contaminant (OUC)

Pump Rate (PUMPRATE)

Pumping Interval (PUMPINT)

Remediation and Operable Unit Cross
Reference (ROX)

Remediation and Site Cross Reference (RSX)

Remediation System (RSI)

Remediation System Performance (RSP)

Remediation Technology (RTI)

Remediation Technology Performance (RTP)

Sample Collection (SAMPLE)

Site and Operable Unit Cross Reference (SOX)

Site Contamination (SCC)

Stratigraphic Unit (STU)
Test Procedure (TEST)

Test Well (TWI)

Tracer Injection (TRI)

Tracer Observation Well (TOW)
Well (WCI)

Well Construction Interval (WINT)
Well Maintenance (WMI)

Zone (ZDI)

Figure 3-2 Types of Prime Contract Data

3.2.1.2 LAB CONTRACT DATA

Analytical Result (RESULT)
Contract (PROJECT)

Sample Collection (SAMPLE)
Test Procedure (TEST)

Figure 3-3 Types of Lab Contract Data
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3.3 UsER RESPONSIBILITIES

Responsibilities for the use and maintenance of ERPTools/PC are shared by AFCEE and the
two types of users, Admin and Data Entry, designated by contractors.

3.3.1 AFCEE Responsibilities

AFCEE/MSC sends historical data to users engaged in new projects and maintains the list of
current VVL values. The final submission is sent to AFCEE/MSC for approval before bading
it into the ERPIM S database.

3.3.2 Admin User Responsibilities

Admin users are responsible for the configuration of ERPTools/PC and al the officia
communications between AFCEE and the user’s organization. Admin privieges are required to
create projects, user accounts and local methods. Admin users are also the only ones
authorized to load VVLs and AFCEE supplied data. Finally, the submission process and the
datafiles utilities are also the responsibility of the Admin user. The Admin user role includes
all the functions of the Data Entry user.

3.3.3 Data Entry User Responsibilities

Data Entry users perform tasks related with creating and editing data until it is valid, including
local import, local export, and field and record validation.

3.4 USER SECURITY

ERPTools/PC security is based upon a username/password system. Users are granted either
Administrative or Data Entry privileges. Administrative users have full system privileges
including the ability to create and delete projects; import, export and create submission files;
create, modify, or delete users. Data entry userscan only open an existing project, edit data
and change their own password.

Warning: Once a user’s password is entered and ERPTools/PC opensthere are no
further limitsto access. If a user, either Administrative or Data Entry, leaves the
computer unsupervised an unauthorized user will have full access as if authorized.
User s should always close ERPTools/PC befor e leaving the wor kstation.
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4. WHAT'SNEW IN VERS ON FOUR

S0 you are an experienced ERPTool/PC user and want to know what has changed. The
changes can be broken into Database Changes and Business Process Changes.

4.1 DATABASE CHANGES

The database changes that were made can be divided into changes to the structure of the base
tables, changes to the structure and location of the support tables, and adding new support
tables.

4.1.1 Base Table Changes

4.1.1.1 TEST TABLE

Changed the length of the LABSAMPID from 12 characters to 20 characters. This has
changed the import/export specification for the Test table.

4.1.1.2 RESULT TABLE

Changed DILUTION from along number (no decimals allowed) to a floating point
number (can have up to four decimals). This has changed the import/export
specification for the Result table.

Added PERCENT_RECOVERY, RPD, UPPER_ACCURACY, and

LOWER _ACCURACY fidds. Thesefields existed in the current ERPTools/LAB data
structure and it was decided to include them in the Prime project data structure for this
new version of ERPTools/PC. Thesefieldswill not be included as part of a
submission, but they are included as part of a Local Import/Export. This has changed
the import/export specification for the Result table.

4.1.1.3 EMI TABLE
A Data Quantifier field was added.

4.1.1.4 ALL TABLES

Added RECNO, VALSTATUS, and SUBMDATE fields. These are internd fields used
to track record status. They are not included in either submission or import/export
files.

4.1.2 Support Table Changes

4.1.2.1 LOCAL METHODS TABLES

The Loca Methods tables have been moved from the reference database
(REFINFO97.MDB for the previous version of ERPTools/PC) into the Project
databases. This removes the problems some users had with Local Methods when the
Project Name field in the Loca Methods table did not exactly match the Project Name
for the currently open project.
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Added RPD, UPPER_ACCURACY, and LOWER _ACCURACY fidds. Thesefields
existed in the current ERPToolS/LAB data structure and it was decided to include them
in the Prime Local Methods data structure for this new version of ERPTools/PC.
These new fields will be included with the data inserted into the Result table during the
Create Default Results process.

Loca Methods data can be exported and imported between projects.

4.1.2.2 VVL TABLES

Added the following four Vaid Value tables. EXT_AMC (Extraction Method—
Analytical Method Category Cross Reference), PRC_AMC (Parameter Classification
Code — Analytical Method Category Cross Reference), and VVLAMC (List of
authorized Analytical Method Categaries), and VVLEDQ (EMI Data Qualifier).

Changed VVLANM to include the AMC field.
These changes were made to support several new validation rules.

4.2 BUSINESSPROCESS CHANGES

There aremany changes to the way ERPTools/PC now waks; new features, improved
functionality, and modifications to some of the processes that are used.

4.2.1 Project Types

ERPTo0ls/PC now supports both Prime project and Laboratory project types. The
Prime project type is essentially what was used in the previous version of
ERPTools/PC. This project captures data from the location down to the results and
also remediation data. The Lab project type is an ERPTools/LAB ERPIMS project
without any of the QAPP cdlibration data. The Lab projecttype is only concerned with
data from samples through results. Lab projects will not need to have any location
data.

4.2.2 Import

The import processis similar to the ERPTools/LAB process with some minor differences. For
users of previous versions of ERPTools/PC the Import process is quite different.

The first difference is the data from the import files moves directly into the base data
tables and not into temporary tables. A log file (*.LOG) is aways created for each
import and three additional files may be generated during an import. The three
additiona files are an error file (*.ERR), a duplicates file (*.DUP), and a referential
integrity file (*.REF). These three files contain the actual data records that were
rejected during the import because of errors, duplicates, or referential integrity issues.

The Log file shows the record number of the record in the original import file, the
problem type and alonger description of the problem. The problem types will be either
afield name or one of the following:
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UNK (unknown error — Usually a database constraint error and the actual error
generated is reported)
DUPREC (this record is a duplicate record that WAS NOT overwritten)
CRDDUP (LDI table only — the coordinates in this record duplicate existing
coordinates)
DUPOVR (this record was a duplicate but used to overwrite the existing record)
DUPIDX (this record is a duplicate because of a secondary index on the table.
Thisis similar to the CRDDUP error)
REFINT (there was a referentia integrity error with thisrecord. It ismissing a
parent record in one or more tables).
Those records where the problem type is a field name will be present because of a
variety of datatype problems, i.e. dates that are not dates, numbers that contan letters,
bad format, etc. The problem description will give a clear reason why the record was
rejected.

Below is an example of the contents of a Log file.

ERPTo0ls/PC Data Import - B7-Sep-2808 12:29

G:\TestDbs\Prime Import\ImportCALC.txt => CALC

Overwrite Duplicates => OFF

Record: 2 UNK Unknown Error. Err = 3314, The field 'CALC.LOCID|
Record: 3 AQBASEDEPTH Field is not a number

Record: 4 AQTHICK Field is not a number

Record: & UNK Unknown Error. Err = 3314, The field 'CALC.LOGDA
Record: 6 LOGDATE First date delimiter {-) is missing from position|
Record: 6 LOGDATE Second date delimiter (-) is missing from positio
Record: 6 LOGDATE Field does not contain a valid date

Record: 6 LOGDATE The Year must be a 4 digit year {i.e. 2881)
Record: 7 UNK Unknown Error. Err = 30858, Index or primary key
Record: 8 LOGTIME Field does not contain a valid time

Record: 9 LOGTIHE Field does not contain a valid time

Record: 18 LOGTIHE Field does not contain a valid time

Record: 11 LOGTIHE Field does not contain a valid time

Record: 12 DUPRECG Duplicate record

Record: 13 REFINT Referential integrity error

Record: 14 WTDEPTH Field is not a number

Record: 15 REFINT Referential integrity error

Record: 16 AFIID AFIID does not match project definition

Record: 17 WELLDIST Field is not a number

Record: 18 PRRUAL Field is not a number

Import completed at B87-Sep-2088 12:29

1 records appended, 8 records replaced.

Figure 4-1 Typical Log File

The user can now select to overwrite duplicate records. This can be used to update
parent records without having to delete the child records.

Apart from the validation that was previously mentioned, no validation will occur
during import. All records imported will be flagged with a VALSTATUS of NV.
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4.2.3 AFCEE Supplied Data

AFCEE supplied datais loaded into a project in a similar manner to the import where
the AFCEE data is loaded for a specific project. Unlike the previous version of
ERPToo0ls/PC where the user had to load AFCEE data into special AFCEE tables and
then use a secondary process to move the data over to the project, in this version the
user will only have to load the AFCEE data directly into the project.

4.2.4 Validation

If validation does not occur during import, when does it occur? Field and Record
validation occurs from the Data Entry screens when you want or need it to happen.
After you have imported some data, go to the data entry screen, make changes(if
necessary), apply afilter (if necessary), and click the Validate button on the toolbar or
select the Edit->Validate Current View option. The current set of data in the data entry
screen will be validated for Field and Record errors. Once the validation is complete
and there are errors you will be given the option of opening the Error Editor screen. If
there were no errors you will be returned to the data entry screen and the VALSTATUS
field isset to FR. You can aso start Field and Record validation from the Data—> Field
& Record Validation menu option. Thiswill present alist of al the tables from which
you select the tables you want validated. The table list allows for mult-select of tables.

If you make changes to data using the data entry screens several things will happen
before the data is written to the database. The system automatically prevents records
with invalid key field information from being saved. If you find that you cannot move
off arecord, click the save record toolbar button. An error message will open telling
you either which fields are missing or that a duplicate record would be generated if the
record was saved. You are also prevented from entering invalid data types. If the
record passes these system checks the VALSTATUSfidd is changed to NV and the
UPUSER and UPDATE fields are changed to reflect the current user and date and time.

The Error Editor is very similar to the Error Editor in previous versions of both
ERPTools/PC and ERPTools/LAB. The primary difference for ERPTools/PC usersis
you can now select to display data “By Error” or “By Record.” If you select “By
Error,” all the records that have the error you select in the top portion of the Error
Editor will be displayed. If you select “By Record” then al the errors for the record
you select will be displayed. You can aso revalidate the data directly from the Error
Editor.

4.2.5 Submission Validation and Creation

Submissions for Prime projects are still formatted in the four groups. Lab projectsuse
only Group 3. What has changed is that you can now submit data based on three
different criteria. As before, you can submit all datain agroup. In addition, you can
now submit only new data, i.e. datawith anull SUBMDATE field, or resubmitting
previously submitted data by selecting a submission date. With this last option you are
provided with alist of submission dates for the group you are submitting.
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In order to create a submission file the data selected must pass all submission level
validation rules. Therefore you cannot create a submission if any of the selected data
has not passed Field and Record level vaidation. When submission level validation
starts, ERPTools/PC will rerun all Field and Record validation for each of the tablesin
the submission group. If there are any Field and Record level errors the submission
validation will not be run and you will be presented with an error message. If the data
passes all vaidation then submission files are created and PDF versions of the Itens of
Interest report and VVL Changes report are included in the submission file.

If you have installed ERPTools/PC in Trial Mode (i.e. Serial Number of 99999), then
you can perform the submission process up to the creation of the submission file. If
you arein Trial Mode then no submission file is created at the conclusion of the
submission process. To upgrade your installation of ERPTools/PC see Section
6.17.5.1

4.2.6 Export

Y ou can now create an export directly from the Data Entry screens in addition to
selecting the table from the Table Selection List. If you choose to export from the Data
Entry screen this will export only the data that is in the current set of data. If you have
applied afilter only the data that matches the filter will be exported. The only exception
isthat you can never export AFCEE data so if you create afilter that shows only
AFCEE data and then export you will end up with an empty file.

4.2.7 System Statistics

These are a set of reports and a screen that will help you manage your Local Methods,
VVLs, and validations. There are two reports on the current project’s Local Methods,
a Submission Status report which details the number of records in each table according
to validation status, and a Changed VVL report. You can also open aValidation History
Screen that will show you the validation history for the active project and allow you to
ddlete history records.

4.2.8 New Reporting Features

ERPTools/PC no longer uses Crystal Reportsa for its reporting tool. The reports are now an
integral part of ERPTools/PC. This allows usto do more complicated reports and to provide a
couple of new features for you the user.

You no longer have to make any changes because you already use a different version
of Crystal Reportsa .

Y ou now have the ability to save your reports in either PDF or RTF formats.

All Field and Record Errors reports have an interactive Table of Contents (TOC) that
allows you to click on an error and move to that part of the error report.
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We have added the capability to print a rudimentary report from the data entry screen.
This report uses some features in the data entry grid itself and does notlet you save the
reportsin PDF or RTF formats. Y ou can preview or print all the datain the current
data entry screen, or selected records only.

4.2.9 Filtering Records

ERPTo0ls/PC has an improved Filter capability. The new Filter allows you to build
complex filters without detailed knowledge of the SQL language. You can aso
combine sorts (Order By) with your filters. If afilter or sort is active on a Data Entry
screen an orange box will appear in the bottom right of the screen. You can right-click
on the box and the current filter will be displayed.

4.2.10 Find and Replace

Find and Replacenow allows you to search for a Null or Empty field and also do a
replace on a Null or Empty field.

4.2.11 Create Default Results

The Create Default Results screen has changed. When you open the screen you will
see al Test records that do not have any Result records. In addition, you can
immediately tell whether you will be able to create default results for a particular test.
The screen indicates whether there is a Local Method that can be associated to a Test
record by comparing the ANMCODE in the Test record and the associated parent
Sample's MATRIX to the ANMCODE/MATRIX combinations in the Locd Methods
table. Any Test record that does not have an associated Local Method is highlighted in
yellow.

Once the default results are created you are asked if you want to open the Result Data
Entry screen and see the newly added records. If you choose todo so, the Result Data
Entry screen is opened with the filtered set of the results that were just added.

4.2.12 Help and Tech Support Options

There is an improved help file with better layout, table of contents, and search features.
We have also changed the listing of Validation Errors so they are in Error 1D order and
not in Message order.

If you have an Internet connection you can get to the AFCEE ERPIM S web site by
using the Help-> Tech Support menu item. This will bring up an internal web browser
with the AFCEE ERPIM S web site active.
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5. SETUP AND CONFIGURATION

Admin users set up and configure ERPTools/PC as a stand-alone program to run under
Microsoft Windows 95 or 98, or Windows NT.

5.1 SysSTeEM REQUIREMENTS

The ERPTo0ls/PC System Requirementsinclude hardware and software requirements and
information required for configuration.

NOTE: You must have MS Internet Explorer v5.x (IE5) installed in order to install
ERPTools/PC v4.x. If you do not have | E5 installed the PC installation will terminate
with an error message.

5.1.1 Hardware Requirements
The minimum hardware requirementsfor ERPTools/PC are:
A Socket 7 compatible CPU running at a minimum of 133 MHz.

A minimum of 16 MB of Random Access Memory (RAM) for Windows 9x systems.
NT machines should have minimum of 48 MB of memory. As with most software, the
more memory the better the application will perform (especialy on NT).

An SVGA or better display capable of 800x600 resolution with 256 colors. The
application is best viewed at High Color settings (16 bit color).

A mouse or pointing device.

At least 50 MB of available hard disk space. (Disk space is for the ERPTools/PC
application only; disk space for data is not included).

Warning: The ERPTools/PC program hard drive space requirements do not include
space for data. Asdataisadded, ERPTools/PC will take up more space on the hard
drive used for data storage. A minimum of three megabytes is recommended for each
project.

5.1.2 Software Requirements

The minimum software requirements for ERPTools/PC are:

Windows 9x. ERPTo0ls/PC has been tested under Windows 95 but developed on a
combination of Windows 95 and 98 SE machines and no anomalies have been detected in
the Windows 98 environment.

Windows NT SP4.

5.1.3 Other Information Required

To completely install ERPTools/PC you will need to enter a serial number. Call the
ERPIMS Help Desk to get one.
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If you are installing ERPTools/PC on a Windows NT system, you will need NT
Administrator privileges and the ability to configure the registry.

5.2 SeTuP AND CONFIGURATION PROCEDURES

Warning: If you areinstalling ERPTools/PC on a Windows NT system, you will need to
have NT Administrator privilegesto do so. Oncetheinstall is complete, you will have
to take several additional stepsto complete the install.

Note: If you want to evaluate copy of ERPTools/PC, enter 99999 as the serial number.
The program will install in trial mode, and you will be able to perform all the actions
except create submission files. If you register ERPTools/PC in trial mode, you can
change the serial number to an active number later, using the About ERPTools/PC
screen.

Double click on the Setup.exe program to begin setup. The PC4 Registration screenwill open.

Please enter your Company Mame and Serial Number.

Ta use ERFTonls/PC in a Trial Mo enfer 39999 as the Serial Number, Wit
ial Mode you can perfom all actions except cieate a submission .

Company Name
I

Serial Number

_ o |
Figure 5-1 PC4 Registration Screen

Enter your company name and the serial number assigned by AFCEE. If you do not have a
serial number contact the ERPIMS Help Desk. If you want to evaluate copy of ERPTods/PC,
enter 99999 as the serial number. Once both fields are complete click the Continue button.

The Welcome screen will open.

Welcome

‘Welcome to PC4 Setup program, This program wil
install FC4 on pour computer

It s strangly rscarmendad that you exit allWindows programs
Before tunning this Setup Pragram

Click Cancel ta quit Setup and close any programs you have
running. Click Nest to continue with the Setup progiam

WARMING: This progiam s protected by capyright law and
international treaties.

Unauthorized reproduction or distrbution of this program, or any
pottion of t, map result in severe civil and criminal penalies,
and will be prosecuted to the maximum extent possible under
[

Figure 5-2 Welcome Screen

The Welcome screen will remind you to close al Windows programs before proceeding.
When you are ready to proceed click Next. The Read Me File screen will open.
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Read Me File <]
ERPTools/PC ersian 4.0 -
Contents:
-ERPTools Overview

- ERPTools/PC Installation

- ERPTooks/PC Frogiam Group
- ERPTooks/PC Installed Files

- Releass Notes

ERPT ool Owerview

Developed for the Air Force Center for Envionmental
Ercellence at Brooks AFB. San Antonio Texas. The Air

Force Center for Ervironmental Excellence (SFCEE], iz

one of thiee service centers supporting &it Force

M ajar Commands (MAJCOMs) and their installations in
onducting Installation Restoration Program (IRP)

remedial investigations and feasibiity studiss.

The objective of the At Force integrated IRP i to =

Cancel

< Back

Figure 5-3 Read Me File Screen
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The Read Me File contains last minute program information. Click Next, and the Choose

Destination Location screen will open.

Choose Destination Location

Setup will install PC4 in the following folder

Toinstallintor a different folder, click Browse, and select
another folder.

Yau can chosse not to install P4 by clicking Cancel to exit
Setup.

Deestination Folder

[E SProgram Filesh\PC4 Browse. ‘

eBack  [THE T Cancel |

Figure 5-4 Choose Destination L ocation Screen

The Windows default is to place the program files in CAProgram Files\PC4. |f you wish to
select a different directory click the Browse button and navigate to the directory. Click Next,

and the Select Program Management Group screen will open.

Select Program Manager Group [=]

Enter the name of the Frogiam Manager gioup to add PC4
icons to:

PC4

Aoressonies

Cormmunications

Graphics

Miciosaft Office Small Business Tools
T

NetTadls
FHR

RDI

Reference
RoboHELP Office
Startlp

System Todks

<Back Carcel |

Figure 5-5 Select Program Manager Group Screen
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The default is to add a program group to your start menu, named "PC4." If you want the
program icons stored elsewhere, select the desired location. Click Next, and the Start
Installation screen will open.

Start Installation [ %]

i “Tou are now ready to install FC4,

Press the Next button to begin the installation or the Back
button to reenter the installation information.

sk [T Carcel |

Figure 5-6 Start Installation Screen

If you are ready to load the ERPTools/PC files on your computer, select Next. The Installing
screen will open.

Installing [<]

Time Remaining 0 minutes 15 seconds

e i N F

Figure 5-7 Installing Screen

Progress bars on the Installing screen will show the progress of the installation. When the
installation of files is canplete the Installing screen will close. The installation program will
then update the configuration of your PC, so the Updating System Configurationmessage will
open.

g Updating System Canfiguration, Please ',
=

Figure 5-8 Updating System Configuration Message

The message will automatically close, and the Installation Completescreen will open.
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Installation Complete [ <]

PC4 has been successhully installed.

Pres the Finish button to exit this installation.

N [

Figure 5-9 Installation Complete Screen

The Restart message will remind you that you need to restart your computer to complete
setup. Depending on the current configuration of the machine ERPTools/PC was |oaded onto,
you may not get this message.

Install <]

This system must be restarted to complete the
irestallation. Press the OK. button to restart this
computer. Press Cancel ta retun to Windows
without restarting

Figure 5-10 Restart M essage

Click OK to restart your computer, or Cancel to close the message and return to Windows.
Some of the ERPTools/PC features may not work until you restart.

Note: If you areinstalling ERPTo0ols/PC on a WindowsNT system, you will need to
complete these additional steps, asan NT Administrator, after running the installation
program.

Open the Registry and navigate to
HKEY_LOCAL_MACHINE> SOFTWARE-> AFCEE->PC->4.

5 Registry Editor - [HKEY_LOCAL MACHINE on Local Machine]
. Begtry  Edit Tree  Yiew
= HKEY_LOCAL_hACHIME

Optionz "Wwindow  Help
ions... UBEL:BREG_=Z:t

— 51 HARDWARE Auditing... ate REG_S7 : 4-
- G S e ath: REG_SZ:C!
— 3 SECURITY = =ppversion : REG_SZ
— =1 SOFTYWARE Compamdlame : REG.
= AFCEE hMRELFQFilename : RE
LEPC MRUZFOFilename : RE
L@ bMRLUIFOFilenarme - RE

DefData MRELFQOFilename : RE

1 Tlazzas BetFriFilanamea - BFE

Figure 5-11 Permissions Menu

Select the Security menu and the Permissions sub-menu and the Registry Key Permissions
screen will open.
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Registiy Key Permissions [<]

Flegistiy Key 4

Ouner. Administratars

¥ Rieplacs Permission on Esisting Subkeys

0K | Concel | Add. | Aemore | Hep |

Figure 5-12 Registry Key Permissions Screen

Click the Replace Permissions on Existing Subkeys check box. Next select the Everyone
name and in the Type of Accessdrop-down select Full Control. If you wish to assign these
privileges to specific users, select the individua’s name instead of the Everyone user. Your
screen should look like the figure above. Click OK and the Windows NT message will open.

Windows NT =]

& De you want to replace the permission on all existing subkeys within DefData?

Figure 5-13 Windows NT Message

This change is required because ERPTools/PC reads and writes to the registry, and by default
NT does not give Write privileges to standard users.

5.3 CONVERTING EXISTING PROJECTS

ERPTo0IS/PC v. 4 usestables and procedures that have been modified from earlier versions
of ERPToolg/Lab and ERPTools/PC. Therefore the projects devel oped with the earlier
program versions must be transferred and converted before they can be loaded into this
version of the software. Two conversion utilities are included in the ERPTools/PC v.4
installation to perform this task.

5.3.1 Converting Prime Projects

The PC Conversion Utility is used to convert ERPTools/PC 3.X pojects into ERPTools/PC v.
4.0 lab project files.

Open the PC Conversion Utility by double clicking on itsicon, or selecting the option from the
Windows Start menu. The main form will open.
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= ERPTools/PC 3.0 Conversion Utility H[=] E3

1. Select the ERPTools/PC v3 Project file that contains the project you want to convert

T Select Ul Praiest

2. Selectthe ERPTools/FC v3 REFINFQ file. This is used to convertthe project's Local Methods.

Select Old REFINFO

3. Selectthe new ERFTools/PC Projectfile (Do Not Select an existing Projectfile because itwill be overwritten)

Select New Praject

4. Startthe Conversion process by clicking the Convert Praject buttan

Start Conyersion

[ 0%

Figure 5-14 PC Conversion Utility Main Screen

Click the Select Old Project button, and a Select Project browse window will open.

Select ERPT ools/PC Praject File HE
st 23 Projects RN =z =

[Dats; % ] RicksE pimsPro2 MDB
andiw.mdb %Second MDB
Lab_FRValidation MDB %] submSuccess.MDB

LabSubmission MDB % subrmtest MDB
New.MDB % Success.MDB
REFINFO97.MDE ) SuccessZMDE

Files oftype:  [Froject Fies = Carcel

Figure 5-15 PC Conversion Project Selection Window

Select the ERPTools/PC v3 project file you want to convert and click Open. The window will
close. Click the Select Old REFINFO button on the Main Screen. A Select REFINFO browse
screen will open.

Select ERPTools/PC REFINFO File HE
Logkin: |3 Proiects SN =] =

Data @ RicksErpimsFrol2. MDB
andiw.mdb % 5econd MDE
Lab_FAValidation MDB ] submSuccess MDB
LabSubmission MDE  $submtest MDE
NewMDE %] 5uccess MDB

%7 5uccess2 MDE

Filepame:  [REFINFOS7.MDB oo |
Files of type:  [Froiect Fies = Cancel

Figure 5-16 PC Conversion Select REFINFO Window

Select the REFINFO97.MDB file in the PC3 directory and click Open. The REFINFO97.MDB
file is used as the source for your new project’s Local Methods. The window will close.
Click the Select New Project button on the Main Screen, and a New Project browse screen
will open.
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Enter New Project File Name HE
Savein | Projects Eil=l= A==

Data % RicksErpimsProj2. MDB
andiw.mdb @) 5econd MDE
Lab_FAVaidation.MDE %] submSuccess.MDB
LabSubmissionMDE ] submtest MDB
NewMDB %) Success MDB
REFINFO97.MDB %7 5uccess2MDB

File pame:  [andmi2 Save |
Save as type: [Froject Fies = Caneel

Figure 5-17 PC Conversion New Project Window

Navigate to where you want to store the new project and erter a file name. Click Save to
close the window. Click the Start Conversion button to begin the process. The status bars
will update as the table conversions progress.

% ERPTools/PC 3.0 Conversion Utility M=l B

1. Select the ERPTonls/PC v3 Project file that contains the project you want to convert

ol e Rz CAProcram Files\PC4\Projects\andrw. mlk

2. Selectthe ERPToals/PC v3 REFINFO file. This is used to convertthe project's Local Methods.

(5 i 0 FIER IR C.\meamF\Ies\PC4\I§\gds\REFINFOB?.MDB

3. Selectthe new ERFTools/PC Project file (Do Mot Select an existing Project file because it will be ovenwritten),

Select e Proet | CAProgram Files\PC4\Projects\andrw2 MOB

4. Startthe Comvarsion process by clicking the Convert Project button

Siar Conversion Conveting Froject Flles
I 5
Conwerting the RTI table

] 22%

Figure 5-18 PC Conversion Screen During Conversion

When conversion is complete a message will open. Click OK to close the message, then either
close the PC Conversion Main Screen or select another project for conversion.
5.3.2 Converting Lab Projects

The Lab Transfer Utility is used to convert ERPTools/Lab 2.X projects into ERPTools/PC v.
4.0 lab project files. In particular, Lab projects are now stored in separate *.MDB files rather
than a single datafile.

Open the Lab Transfer Utility by double clicking on itsicon, or selecting the option from the
Windows Start menu. The main form will open.
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% ERPTools/LAB 2.0 Conversion Utility

1. Selectthe ERFTools/LAE LABI7 DAT file that contains the projects wouwantto convert.

Select LAB.DAT

2. Selectthe project you want to conwvert.

[Project Type_[Project Hame [Installation [Cantiact Number Delivery Order [ Prire Contractor

N [ |

3. Selectthe new ERFTools/PC Projectfile (Do Mot Select an existing Project file because itwill be overwritien).

Select Project File

4. Start the Conversion process by clicking the Convert Project button

Convert Project

Figure 5-19 Lab Transfer Utility Main Form

Click the Select LAB.DAT button to open a browse window.

Select ERPTools/LAB LAB37.DAT File HE
Logkin: |23 Pod BB =] =

Piojscts

labd7. dat

File pame: || Open |
Files of type D Files = | Cancel

Figure 5-20 Lab Transfer Browse Window
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Select the LAB97.DAT file to be converted and click the Open button. When the browse
window closes the project selection grid on the main form will list the projects that are stored

in the data file.

4 ERPTools/LAB 2.0 Conversion Utility

1. Selectthe ERPTools/LAB LABI7 DAT fils that contains the projects you wantto comvert.
{Beiec CAEBAT | C\Program Files\PC4labd7.dat

2 Selectthe project you want to conwvert.

[ [Proiect Type |Pigiect Hame Installation Contiact Number | Delivery Order | Prime Conlractor
QAPP Only | Data Intearity Check MYAFE F123450-66:9576_ | 0001 Piime Co 1
ERFIMS Oniy |ERIFIMSVAL OURSFE F245800 659876 0010 Fiime Co 2
Bath Lab2PcConvert OURAFE F135790-66:9875 | 0100 Piime Co 3
ERPIMS Only | Lab2PCCorverTwa THEIRAFE FO9676.0-689876 1000 Pime Ca 4
Bath Prelty Fine Projet (B atch Analysk | HERAFE F51605.0-639876 1001 Fiime Co 5
N |

3. Selectthe new ERFPTools/PC Projectfile (Do Mot Select an existing Project file hecause itwill be overwritten)

Select Project File

4. Start the Conversion process by clicking the Conwvert Praject buttan

Convert Project

Figure5-21 Lab Transfer With Projects Listed
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Click arecord selector to the left of the record of the project you wish to transfer. Click the
Select Project File button. The Enter New Project File Name window will open.

Enter New Project File Name HE
Savein =P &|&E ok [@EE
[Projscts;
Eipimsd.mdb
labihmdp
Rfinfod mab
File pame: | Save |
Save as type: [Froject Fies = Caneel

Figure 5-22 Lab Transfer New Project Window

Navigate to the directory where the new file will be stored, then enter a name for the new
project file. Click Save to create the project and close the window. On the Main screen click
the “ Convert Project” button. The status bars will update as the conversion is run.

4% ERPTools/LAB 2.0 Conversion Utility

1. Selectthe ERFTools{LAB LAB37 DAT file that contains the projects wou want to convert.

Select LAB.DAT | CAProgram Files\PCa\ab97. dat

2. Selectthe project you want to conwvert.

| |Project Type |Project Name Installation Contract Number Delivery Order | Prime Contractar
QAPP Only | Data Integrity Check MTAFE F12345-D-68-9876 | 0001 Prime Co 1
ERFIMS Only [ERIPIMSWVAL OURAFB F24620D-68-9876 | 0010 Prime Co 2
Bath Lab2PeCorert OURAFB F13573-D-68-9876 | 0100 Prire Co 3
ERFIMS Only |Lab2PCConverTwo THEIRAFE FO9876-0-68-9876 | 1000 Prime Co 4
Bath Pretty Fine Project (Batch Analysi HERAFE F&1605-0-65-9876 | 1001 Prime Co 5§
N [ |

3. Selectthe new ERFToolg/FC Projectfile (Do Mot Select an existing Project file hecause itwill be overwritten),

Select Project File | C\Program Files\PC4Projects\Both MDB

4. Start the Conversion process by clicking the Convert Project button.

{Convert Project | Transfering RESULT table

e R R e E

Figure 5-23 Lab Transfer During File Updating

When the transfer and conversion are complete a message will open. Click OK to closeit.
Y ou can then close Lab Transfer Utility or select another project for transfer.

Note: Due to index changes, it is possible some of thelocal methods stored in the
LAB97.DAT filewill be duplicatesin the new ERPTools/PC 4.0 project. If this happens,
a message box will inform the user of this situation and the duplicate records will be
stored into a file named LAB97.DUP.
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6. USING ERPTOOLSPC

This section will show you how to do very specific tasks in ERPTools/PC, from logging on to
creating a submission. Section 7, Techniques discusses how to use some of the components
within ERPTool/PC.

6.1 CoMMON TECHNIQUES

Refer to section 7, Techniques if you are new to ERPTools/PC or Microsoft Windowsa . It
will show you how to use the common elements of ERPTools/PC. This aso includes some
editing features such as creating and saving a new record, deleting a record, cut, copy, and
paste, etc. Section 8, Menus and Toolbars describes each menu and toolbar button.

6.2 LOGGINGIN

Tolog in to ERPTools/PC first double-click the program icon to open the program. The Login
screen will open.

App. Version: 4. 0. 0,
Val Version: 4. . 0i. O

Ugm}{ NWPQ [2DMIN
Ewptd*li”m”*

Login | Cancal |

Figure 6-1 Login Screen
Enter your user name and password in the fields provided and click the Login button. The
ERPTools/PC Main screen will open with your user name in the title bar.

Note: ERPTools/PC installs with a default user of ADMIN and a default password of
PASSWORD. You should create a new administrative user or change the ADMIN
user’s password at the first opportunity.
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|
# ERPTools <ADMIN> o=
Fle Took Window Help

e B v R R e == e e N = = T = T

Figure 6-2 Main Screen

If you fail to enter a user name or password, or if one of them isinvalid, awarning will open
telling you what the error was.

ERPTools/PC =]
Q The entered password is inconest. Pleass reenter or contact the System Administrator

Figure 6-3 Login Warning
Click OK to close the warning, and reenter the appropriate vaue. If you fail to login after
three tries ERPTools/PC will close.
Clicking the Cancel button on the Login screen will close the program.

Note: Only Admin users can look up user names within the program, and no one can
look up passwords. |f you forget your password an Admin user will have to delete and
re-create your user account, which will set your password back to “password.” Editing a
user’srecord will no longer change the password.

6.3 MAINTAINING USERS

6.3.1 Changing Passwords

All users are responsible for setting their own passwords. Passwords must have at least eight
and no more than twenty characters, and may use a combination of letters, numbers and
punctuation marks. They are not case sensitive.

Warning: If you leave your computer unobserved while running ERPTools/PC, an
unauthorized user can change your password and prevent you from reopening the
program.

Note: The password may not be left empty.
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To set your password select the Tools= User Maint- Change Password option. The Change
Password screen will open.

NewPassword |
Confiim new password

Figure 6-4 Change Password Screen
Enter your new password in the New Password field, and again inthe Confirm New
Password field. Click OK to submit the new password.

Clicking Cancel will cancel the action, leaving your existing password in place.

6.3.2 User Maintenance
Admin users only.

Admin users are responsible for adding, editing, and deleting user records, which contain the
user name and the type of user, Admin or Data Entry.

To maintain user records select the Tools> User Maint-> Edit User Accounts option. The User
Maintenance screen will open.

) User Maintenance

TI5ER AOMIN_[UPUSER UFDATE
DATA YES |AFCEE 259G 2199 D000
FRED YES | ADMIN 035 ope 2000 16:38
RICK YES | ADMIN 05402000 1623
SHRAN HO | ADMIN 13- ope2000 1154
1040 YES | ADMIN 13 ep-2000 11:54

* |

W] 4] ien Recard » M

Clase

Figure 6-5 User Maintenance Screen

The User Maintenance screen has a spreadsheet listing all the registered users except the
current user. Therefore, you cannot edit or delete the record of the user who opened the
program.

Click the Closebutton to close the screen.

6.3.2.1 ADDING A USER

To add a user, click into the new record at the bottom of the spreadsheet (identified by the * in
the row selector) or click the New Record button on the toolbar. Enter a user name in the
USER field. If the user is an Admin user you must either type “YES’ in the ADMIN field, or
select the “Yes’ option using the drop down list. If you leave the record without selecting the
user type the ADMIN field will default to “NO.”
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6.3.2.2 EDITING A USER RECORD

To edit auser record, select the record, then change the user name or change the ADMIN
designation.

6.3.2.3 RESETTING A PASSWORD

Warning: Since the User Maintenance screen does not show the current user’srecord,
you cannot edit or delete the record of the user who opened the program. Therefore, if
thereis only one Admin user registered and that user’s password is changed or lost,
thereis no way to open the program and reset the password.

If the user has forgotten a password, you will need to delete and recreate the user account.
Thiswill reset the password to PASSWORD. Editing a user’s record will no longer change
the password.

6.3.2.4 DELETING A USER

To delete a user record, select the record by clicking on the record indicator, highlighting the
record. Then press the Delete key or click the Delete Selected Records toolbar button. A
message box will open requesting confirmation of the action. Click OK to delete the record, or
Cancel to abort the action.

Note: Deleting a user cannot be undone.

6.4 MAINTAINING VALID VALUELISTS

6.4.1 Viewing Valid Values

Any user can view valid values by selecting the Tools=> VVL Mant-> View VVL Data option.
The ERPTools VVL Tables screen will open.

. ERPTools VWL Tables

on Method/SMC et

Site

PRC_AMC PRCCODEAMC Xref
LA Air Force Installstion
WULAMEC Analytical Method Classifi

WVLANG | Analte Gioup
WVLANM | Analyiical Method
WYLANT | Analysis Type
WVLAST | AGTM Cade
V/LBAS  |Basis

ol o
P iiin it ibn it xitnllx] 2

Figure 6-6 ERPTools VVL Tables Screen

Select one or more tables and click the Select button. A View VVL Data screen will open for
each VVL table sdlected showing the values for the VVL.
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A205 [- [ 5C 120, 40 UMHES]
A2034 W TS50 50, 20/ MG
AZ2038 W DS 70 10/MGA
A203C W 55 200 100/ WGA
A2320 W ALK 150 B0/ MG
423408 W HARD
425108 W 5C LIMH.
425208 W SALINITY
A2540C W DS MG
425400 W S5 MG
|A26400 S SOLID PER(+
N F— _'l_I
4] 4|Record 1of 501 (211

Figure 6-7 View VVL Data Screen

Use the horizontal and vertical scroll bars to review the information. Although you cannot
select arecord and edit it, clicking on the button at the left end of the row will highlight a
record, and make it easier to follow it across the fields.

6.4.2 Editing Valid Values
Admin users only.

Admin users can edit VVL values. Select the Tools=>VVL Mant=> Edit VVL Data option. The
VVL Tables screen will open. Select one or more tables and click the Select button or double
click on an individua table. An Edit VVL Data screen will open for each VVL table selected.
Once the screen is open you can add, edit, and delete VVL values. The standard editing
techniques are covered in Section 7, Techniques.

Note: You must contact the ERPIM S Help Desk before making any changes to the
VVL tables. If you do not get approval for the change thereis a good probability that
your submission will be rgjected by AFCEE.

2k PC103: Analytical Method/Analyte Cross Reference (AMPARXREF) Edit VVL Data

ANMCODE MATADS PARLABEL MDL RAL[UNIT «
)y =W ED) 120, 40/ UMH:
[ |Az0 W 50 50 Z0[MEA
] W 08 70 T0[M&EA
EEES W S 2-}1 100 MG/
52320 W ALK 150, B0 MG/
T w HERD
[~ [&a5108 w B UMH
[ |az5208 W SALINITY
L W 08 MG/
L W S MG/
[ |az5a0m 5 SOLD PER(+
N — _'l_I
W[ 4]Recod 1of 501 » bl

Figure 6-8 Edit VVL Data Screen

6.4.3 Importing Valid Values
Admin users only.

Select Tools=>VVL Maint->Import VVL to import one or all AFCEE provided VVL filesinto a
VVL table. You will see a message asking if you want to import all VVL files.
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ERPTools/PC =]

@ Import all available VWL files? Press Na to import 3 single fil

Ve Mo | Cancel |

Figure 6-9 Import All VVLs M essage

Select Yesto import all VVL files, No to import asingle file, or Cancel to cancel the VVL
import process.

6.4.3.1 IMPORTING ALL VVLS
If you select Yes (import al VVLS), you will see aVVL Import diaog.

ERPTools/PC VWL Import [F]

Select the directory where the WL files are
located.

=1 Pod =
© [ Data
i = Setup
i =0 TestDbs J
i1 AFCEE Import
. Export
i+ Lab Import
o LabDups
(1 LocaMethods
.0 Prime Impart

Figure 6-10 VVL Import Dialog

Use this dialog to select the directory where al the AFCEE provided VVL files are located.
Click OK to start the import. The VVL Import screen will open.

ERPTools VWL Import

File 1 of E7
Importing C:AAWORKADOWNLOADYWPCANSE TUPATESTDBSMWLIMPORTAGS ] DAT inta
G5 table. Plaase Wwait

_ W

[—

Figure 6-11 VVL Import All Screen

The screen will indicate which file number it is processing (i.e. File 16 of 40), the file name it
is processing, and the table name the datais importing into. A progress bar will show the
progress of the import.

Note: Importing all VVL filesis an extensive process and, depending on your PC,
usually takes an hour or more.

You can click the Cancel button to halt the import. A warning will remind you that canceling
will leave the table in an invalid date.
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ERPTools/PC B

Are you surs you wouldlike ta ancel the YL Import operation? Canceling the impat wil
leave the VL table in an invalid state

Figure 6-12 Cancel VVL Import Warning

6.4.3.2 IMPORTING A SINGLE WL

If, on the Import VVL message, you select No (import asingle VVL file), the Import VVL
selection screen will open showing dl VVL tables.

8 PC178: ERPTools Import WL Tables

Sie
PRCCODE/AME Href 168
it Force Instalition C105
Analytical Method Classi S
Analyte Gioup C
Analytical Methad T
Analysis Type C

C

C

ASTM Code
Basis

= | ——

Figure 6-13 Import VVL Selection Screen

Select the table you wish to import and click the Select button. The Import VVL Data
selection screen will open.

ERPTools/PC Import VWL Data - VVLANG HE

Lookjr |23 Yllmport cl@lck BE
[2facidat aps dat et dat edg.dat
afi.dat astdat cpe.dat edglist T
2] ame. dat [ bas.dat 5] crd dat 5] el dat
ang dat chd dat ertdat esc dat
anm.dat cla.dat dat.dat exc.dat
[2] ant.dat [2] ome dat dil dat exm dat

|
File pame: | Open |
Files o typex [+t = Cacel

Figure 6-14 Import VVL Data Selection Screen

Use the selection screen that appears to select the individual file to import. The file names of
the files provided by AFCEE are formatted in a very specific way and should not be changed
or the data may be imported into the wrong table. Click Opento start the import. The VVL
Import screen will open.

ERPTools VWL Import

Importing C:h&%/ 0RKAD OWwNLOADYPCASETURNTESTDES WYLIMPORT WAPR.DAT into
ANPARKREF table. Please Wait

]

Figure 6-15 VVL Import One Screen

PAGE 42



FA41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

For asingle VVL import the screen will indicate which table is being imported. A progress bar
will show the progress of the import.

You can click the Cancel button to halt the import. A warning will remind you that canceling
will leave the table in an invalid state.

When the import process is completed the VVL Completion message will be displayed.

Import of C: %AW DRKADDWNLOADYPCASETUPNTESTDBSMYLIMPORTAAME DAT
into YWLAMC has completed

Figure 6-16 VVL Completion M essage

6.4.4 Creatinga VVL Listing

Select Tools=>VVL Maint-> Create VVL List to create alisting of the selected VVL tables. The
Create VVL List selection screen will open.

[ sl Ste PCi0s
FRC_AME | PACCODE JAHC el FLicE
VVLAF it Force Instalision PCI0S
VLAME | Anabtical Method O FCige
WWLANG | Analyte Giroup FCIDE
VYLENM | Analptical Method PCI07
VYLENT | fnalysic Type FCI0E
VWLAST | ASTH Code PCI03
VlBAS | Basis FCI10 |

selest | e |

Figure 6-17 Create VVL List Selection Screen

Select one or more tables and click the Select button or double-click on the table. If you select
atable with site specific values a message will open asking if you wantto first open a project,
or ligt al the table values.

ERPT ools/PC ]

@ Na project is currently Open. Do you want to creats & YL Listfor the entire GS| tabls?

Figure 6-18 VVL No Project Open Warning

Either click Yes to proceed, or click No to halt the process so you can open a project, then
select atable. If you have selected multiple tables, ERPTools/PC will loop through each
selected table displaying the Create VVL List dialog screen. If you cancel out of the file
selection screen, a message is displayed giving you the option of continuing with the next file
or cancelling the process.

PAGE 43



F41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

ERPTaols/PC B

You havs ot selected a fil into which the WL Listing for the YWLCLA VWL wil be
created. Do you want ta cantinue processing the selected tables?

Figure 6-19 Select File M essage

After each list is created you will be asked if you want to continue the listing process.

ERPTools/PC ]

@ Da ou want ta confinue processing the selected tables?

Figure 6-20 Continue Processing Tables M essage

Click Yesto continue and No to abort the process.

ERPTools/PC Create VWL List - GSI HE
Savein | S Dets S N =] =

=] iand. esulls bt towe bt 2 ot
2] Idibut samples. e st
2] il tut soe bt ok

2] owltat E woi
IZ] purpirt st sttt wink et
1Z] purnprate bt tests bt v bt

| ol
File pame: | Save |
Save 5 type [ Te Files = Cancel

Figure 6-21 Create VVL List Dialog

Enter afilename for the VVL Listing and select the directory where it will be stored. Click the
Save button to save this file. A message will open confirming the file creation.

ERPTools/PC

@ Creation of WL List for GSI table completed.

Figure 6-22 VVL List Creation Message

This listing is atext file formatted with the VVL Name and Desaiption at the beginning of the
file and then al the valuesin the VVL listed below the VVL Name. Thisfile can then be
brought into any text editor or word processor to print or review. It cannot be reimported
into ERPTools/PC.

6.5 CREATING AND M ANAGING PROJECTS

6.5.1 Opening a Project
This option is unavailable if a project is open.

All users can open a project by selecting the File-> Open Project option. The Project Open file
dialog screen will gpen.
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ERPTools/PC Project Open HE
Lookjne | 4 Projects Eil=l= A==
Dt
HewMDB
RicksErpimsProj2.MDB
Second MDB
submSuccess MOB
subrrhest MDB
File pame: | Open |
Files oftype:  [Froject File = Caneel

Figure 6-23 Project Open Dialog
Note: ERPIMSA.MDB, LAB4.MDB, and REFINFO4.MDB are program files, not
projects. Tryingto open one of them resultsin an error message.

Select a project and click the Open button. The Open ERPTools Project Information screen
will open.

. PC176: Open ERPTools Project Information

Project Type PRIME

File Mame C:\Program Files\PC4\Projects\New.MDB

Piciect Name NEW PROJECT

AFID KNGSN KING SALMON AFS
Coniracl F12345-00-A-6789
Delivery Order 01
Open | T Cancal I

Figure 6-24 Open Project Screen

Confirm that you have selected the correct prgject and click the Open button. When the
project opens the project information will display on the window's Application bar.

Figure 6-25 Application Bar Project Information

The information includes the username, project file name, project name, AFIID and contract
number-delivery number. If the project isa Lab project some of the elements may display an
<UNK> if the data was not entered when the project was created. The Data menu also
appears, alowing you to complete project tasks including data import, export, submission, and
editing.

Y ou can also open a project by selecting it on the File menu’ s list of recently opened projects.
6.5.2 Creating a Project

Admin users only. This option is unavailable if a prgect is open.
Select the File-> Create Project option. The ERPTools/PC Project Create dialog will open.
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ERPTools/PC Project Create
Savein | Projects Eil=l= A==
Dats
HewMDB
RicksErpimsPrai2.HOB
Sesond MR
submSuccess. MDB
subrbest MDB
File pame: | Save |
Save as type: [Froject Fie = Caneel

Figure 6-26 ERPTools/PC Project Create File Dialog

Enter afile name for the project and select the directory where it will be stored. The Create
ERPTools Project Information screen will open.

. PC100: Create ERPTools Project Information

Project Type [FEEE =

File Mame C:\Program Files\PC4\Projects\New2. MDE

Ficject Name I

AFIID ~
Contract
Delivery Order

Prie Contractor |

Create | Cancel |

Figure 6-27 Create ERPTools Project I nformation Screen
Using the Project Type drop downlist designate whether the project is a Prime or Lab project.

6.5.2.1 PRIME PROJECT

You must enter or select values for the Project Name, AFIID, Contract, and Delivery Order
fields, and click the Create button. The Prime Contractor field will be unavailable. The project
will open, and display project information in the title bar.

6.5.2.2 LAB PROJECT

Enter the project name in the Project Name field. You are not required to enter values in the
other fields but it is recommended to fill in the AFIID field if it is known. InaLab project the
Prime Contractor field is available. Click Create to open the project and display project
information in the title bar.

6.5.3 Editing Project Information

Admin users only. This option is unavailable unless a project is open.

Warning: Do not edit any of this project information after the first submission file has
been sent to AFCEE. Any subsequent submissions for that project will be returned.

To edit project information select the File-> Edit Project option. The Edit ERPTools Project
Information screen for that project will open. You can edit the information for only the
currently open project.
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w. PC101: Edit ERPTools Project Information [x]

Project Tupe  PRIME

File Mame C:\Program Files\PC44Frojects\New. MDE

Project Name INEW PROJECT

AFIID | KNGSN ~ | KING S4LMON AFS
Contract  [F17345-00.4-6783
Delivery Order  [01

Prie Contractor |

Edit | Cancel |

Figure 6-28 Edit ERPT ools Project | nformation Screen

Edit the information in the fields that need changing. Click the Edit button to accept the
changes and close the screen.

6.5.4 Closing a Project

This option is unavailable unless a project is open.

To close the open project select the File> Close Project option.  All open screens will close,
and the project information will be removed from the title bar.

Note: You must close one project before you can open another.

6.5.5 Deleting a Project
Admin users only. This option is unavailable if a project is open.

To delete a project, select the File> Delete Project option. A file dialog screen will open.
Select the project to be deleted and click the Open button. The ERPTools/PC Project Delete
screen will open, displaying project information for the project.

. PC177: Delete ERPT ools Project Infarmation <]
Project Type PRIME
File Mame  C:\Program Files\PC4\Projects\Second MDB
Project Mame  PRIME
AFIID  ACADM AIR FORCE ACADEMY

Contract  A12345-00-B-6789
Delivery Order 1

i Cancel

Delete |

Figure 6-29 Delete Project Confirmation Screen

Confirm that you have the correct project. Click the Delete button to delete the progct. A
warning will open asking you to confirm the deletion. Click the Y es button to delete the
project. A message box will open saying that the project has been deleted.

Warning: Deleting a project deletes the physical database file (*.mdb) from the drive
and thisfile ISNOT placed in the Recycle Bin. Therefore deleting a project cannot be
undone and all data islost.
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Click the Cancel button to close the screen without deleting the project.

6.6 UsINGLocAL METHODS
Admin users only. This option is unavailable unless a project is loaded.

Admin users can create, edit, delete, import, and export local methods. When the user saves a
new Loca Method record, ERPTo0ls/PC creates default analytes from the official methods
that are stored in the ANPARXREF table if they exist. If no analytes exist in ANPARXREF
there will be no analytes inserted for this local method. The user can then go to the analytes
grid and modify or add analytes to account for local practices.

6.6.1 Importing Local Methods

To import atext file of local methods select the Tools=> Loca Methods Maint->Import Local
Methods option. A file dialog screen will open.

ERPTools/PC Local Methods Import

Look in 3 Data === =
[ oosd lhered2 TXT Simpat it ME T H1SWB240MABCRE FTRIZBPHISTD UG /LF aloell0
) ’ ol
=] Laita Idifitered3 TXT Tinpot st ME TH1ISWE240MASCRE FTI32PN1OLIORGIIUG/LIFalsella
E Idit. TT Idifitersdd. THT vl T=T ME TH1|SWwB2400WIACRE FTI32PRYINTOLIORGIIUG /LF alselio
2. T<T T W2 TRT METH1SWB240MAIACRE FTIIACCNIORGILG ALIF lselin
-- : ME TH1[SWB240MW/IACRE FTI3ACEDRGIG/LF aleellD
£ a3 =T T VS TRT ME TH1 51w/ B2408ACRE FTIRIACALDAGILIG /L skselin
Idifitered. TXT Rimport bt METH1 40IBCRE FTI3BCRNIORGIIVG ALFalsello
METH1SWB240MAIACRE FTI3I2B2D 105 TDIUGLFabelil
ME TH1[5WB240M/IACRE FTBOCMEIDRGIIUG /L Folsell0
METH1ISWB240MIACRE FTIIBR4FEZIS TDIIUG/LIFalscli0
Fiepame: oot 5T ME TH1[SWB240MIACRE FTISIBACLMEIDRGIIUG,LF alsellD
temme: | Lo | METH1 400/IACRE FTRBRMEIORGIUG/LFalseliD
: = ME TH1EWB240MABCRE FTBEZI0RGILIG LIFskell0
Fles of ype: [Tt Files I~ Cancel MF TH1IR0/R74 NN ABCRF FTRIRZMEINRRINR A F Alelin

Figure 6-30 L ocal Methods Import File Dialog

Select the text file to import. A preview of the file will be displayed in the field on the right
side of the screen. Clicking Open will begin the import process. If you click Cancel the
import process is cancelled.

6.6.2 Creating/Editing L ocal Methods

Select the Tools=>Loca Methods Maint->Edit Local Methods to edit the project’s local
methods. The Edit Local Methods screen will open.
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B Edit Local Methods [x]
Local Methods |
METHOD_NAME _|ANMCODE MATRIXTYPE UNITS PRECISION[UFUSER UFDATE
¥ |HETHT 5w/B240 i ACRE FT 3 |ADMIN 25:Aug-2000 14:35
METHZ SWE240 s FT3 T [ADMIN 28Aug 2000 14:34
* | |
] 4fRecord 1 of 2 AL
Analptes
| [PARLABEL PRCCODE SURROGATE MDL RL[UNITS RPD] P~
¥ | 2BFH =|5TD NO UG/L
2PNTOL ORG NO UG/
2PRYNIOL ORG NO UG/L b=
ACCN ORG NO UG/L
ACE ORG NO UG/L
ACAL ORG NO UG/L hd
1 S 2
I4] 4 | datDetais (211

Figure 6-31 Edit Local Methods Screen

6.6.2.1 CREATING LOCAL METHODS

Select the new record in the Local Methods worksheet identified by the * in the record
selector button on the left of the worksheet. Y ou can also use the Add New Record toolbar
button. Typein a name for the method, then select values for the remaining fields with the
drop down lists. When you save the record ERPTools/PC will create default analytes from the
official methods in the ANPARXREF table if there are matching records with the same
ANMCODE/MATRIX combination as the new Local Method.

Y ou can then go to the Analytes worksheet and edit the analyte records to conform to local
methods. There are severa new fields in the Analytes section (RPD, UPPER_ACCURACY,
and LOWER_ACCURACY) which were added in this version. If an analyte should be treated
as a Surrogate and its PRCCODE is not STD then you must change the Surrogate column
from NO to YES.

6.6.2.2 EDITING LOCAL METHODS

To edit alocal method select the method' s record in the Local Methods worksheet. The
method' s analytes will disday in the Analyte worksheet. Select the cell containing the value
you want to change, either in the Local Methods or Analytes worksheet, and edit it. The new
value will be saved when you exit the record. The options of sorting, copying, and pasting are
also available. The standard editing techniques are covered in Section7, Techniques.

6.6.2.3 DELETING LOCAL METHODS

To delete one or some local methods or analytes select the row or rows to be deleted in either
worksheet and click the Delete Selected Records button. A warning will open asking if you
want to delete the number of records selected.
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ERPTaals B

@ 1 1ow will be deleted! Continue?
f O o

Figure 6-32 Record Deletion Warning

Click Yesto delete the records.

Note: You can only select records from one worksheet at atime. Deleting a local
method deletes all the analytes associated with that method.

To delete al records click the Delete All Records button. The Delete All Records warning will
open.

ERPTaols =

All 5 records in the Location table wil be deleted if this operation is continued. Would you
I records?

ke to delete all
L | N

Figure 6-33 Delete All Warning

Click the Yes button to delete all the records. A message will confirm that the records have
been deleted.
6.6.3 Exporting Local Methods

To export local methods select the Tools-> Local Methods Maint-> Export Local Methods
option. The Local Methods Export file dialog screen will open.

ERPTaols/PC Local Methods Export

Savein |y Dats Eil=l= A==
Cinood dfitered2 TXT Simport ot

[£] Lditat Idifitered3 TXT Timport tat

2] 11 T<T Idifikeredd. TXT WA TET

5] 1diz2 7T locmeth1. T<T w2 TXT

5] 163 T<T Rickldi TXT W3 THT

2] idffilered. TXT Rimpart.tat

File pame: |

Save |
Save as tpe: [Text Files = Caneel

Figure 6-34 Local Methods Export File Dialog Screen

Navigate to the directory whereyou want to store the file, type afile name in the File Name
field, and click the Save button. A message will tell you when the export is complete.

6.7 LoADING AFCEE SuppLIED DATA

Admin users only. Prime Project Only. This option is unavailable unless a project is loaded.

Note: If at all possible AFCEE supplied LDI, SLX, OU, RSI, RTI, WMI, WCI, and
WINT information for the AFI1D should already be loaded before doing any importing
or data entry of user generated data. If you need the AFCEE supplied data files,
contact the AFCEE Help Desk.
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To import AFCEE supplied datafor a project select the Data> Load AFCEE Supplied Data
option. A message box will indicate that AFCEE datais usal for reference only.

ERPTaals/PC =

*You have selected to perforn an AFCEE Supplied Data impott. Diata imported in this
manner i aniy used fat reference purpases and will not be inchided in the submission fil.

Do you want to continus?

o

Figure 6-35 AFCEE Reference M essage

Click Yesto continue. The Load AFCEE Supplied Data selection screen opens, allowing you
to select one or more tables you want to load with AFCEE Supplied Data.

5 Load AFCEE Data For: B

TABLE DESCRIPTION PCH
LIRS Location/Site Cross Reference PC202
[ [ou Operable Unit PC226
RSl Remediation System PC228
RTI Remediation Technology PC230
Wl “well PC203
WINT “Well Construction Interval PC208
WL ‘Well Maintenance PC2039

e | T Cace |

Figure 6-36 Load AFCEE Data Selection Screen

Select tables and click the Select button or double-click on the table name. The Import
AFCEE Data File dialog will open.

ERPTools/PC Import AFCEE Data [2]x]

Lookin: | =3 AFCEE lmpuort === =

AFP23 01-5B-01 bh | 3325601.00 1811201.00 N27 GPS
F 08-4UG-2000 RAD apc MA B N& - FT
M 3300 52.00 TX_SCOMERC HA
NONE

AFP28 01-5B-02 bh | 392660200 181120200 N27 GPS

FT 08-AG-2000 RAD apc MA B 14220 NA FT
M 3300 51.00 TX_SCOMERC MA
NONE

2 2
BFF23 015803 b | 3925603.00 191120300 N27 GPS
Fopes I FT DBALIG-2000 FAD apo NA. B 14320 NA FT
tegane: [lyrn (= [ Y TR SCOMERC  MA.

Files of type:  [LDI AFCEE Supplied File =l Cancel ‘Nr?qNE 9
Figure 6-37 Import AFCEE Data File Dialog

Use the file dialog screen to select the AFCEE supplied file. Once you select afile, a preview
of its contents will be displayed on the right side of the screen. Click Open, and the Import
Data dialog will open.

Data File => C:\awork Download\PCANAFCEEALynn. LD li‘

Feiected Records

Empty Recards:
Data Type Erfars:
Duplicates:
Referertial Integrity:

™ Ovemwite Duplicates

cocoo

Figure 6-38 Import Data Dialog
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If you have selected multiple tables, ERPTools/PC will loop through each selected table
displaying the Import AFCEE Datafile dialog. If you cancel out of the file selection screen, a
message is displayed giving you the option of continuing with the next file or canceling the
process.

ERPTools/PC

You have not selected a fils to import the data inta the 5L table. Da you want to
continue pracsssing the selected tables?

J No

Figure 6-39 Cancelled Table Import Message

After each AFCEE Supplied file is loaded you will be asked if you want to continue the AFCEE
Load process.

ERPTools/PC =]
@ Do you want to continue prosassing the selected tables?

Figure 6-40 Continue Processing Tables M essage
Click Yesto continue and No to abort the process.

6.7.1 Overwriting Duplicates

Select whether you want to over-write duplicates or not.

B ERPTools/PC - Import LDI Data <]
DataFile =5 C:A8MWark\Dawnload\PCAYAFCEE\Lynn LDI E

™ Ovemwite Duplicates

cocoo

| 0%

Figure 6-41 Import Data Dialog

Note: Selecting to over-write duplicates can have a significant impact on your currernt
data.

When over-write duplicates is selected, ERPTools/PC will over-write ANY duplicate record
with AFCEE data and flag that record as an AFCEE record. This may have the effect of
converting some of your own user entered data into AFCEE data ssimply because the key fields
of the two records matched and you had over-write duplicates selected. The old (over-
written) data is not stored anywhere and is not recoverable unless an export or a backup was
made before doing the import.

If you do not select the over-write duplicates option and duplicate records are found during the
AFCEE Supplied Data load, only AFCEE records are updated. Records you have edited will
not be overwritten. In the unlikely event that over-writing a duplicate causes a duplicate error
in a secondary index, the record will be rejected and placed in the * .DUP file.
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To start the import, click the Start button. The progress bar will update, and the dialog will tell
you what records are being updated. When import is complete, the Import Data didog will list
the records rejected in the Rejected Records area, and tell you how many records were
imported.

) ERPTools/PC - Import LDI Data

Import complete: 105 records appended, 2 records replaced E

Fiejected Records

Empty Records
Data Type Eniors:

Duplicates
Closs Feeferential Integrity

100%

I™ fiverite Duplicates

oo =

Figure 6-42 Import Data Dialog Completed

Click Close to close the dialog.

6.8 IMPORTING DATA
This option is unavailable unless a project is |oaded.
Note: Seethe What's New section for changesin how Imports are done.

To import data for a project select the Data> Import Data option. The Import Tables screen
will open.

. PC178: ERPTools Import Tables [X]
TABLE __|DESCAIFTION FCN_ |«
SLX Location/Site Cross Feference PC202
SCC Site Cortamination PC205
Z00 Zone FC205
ZL¢ Location/Zone Cross Reference PC207
MRl Map Reference PC204
Wl el FC203
WINT wiell Constiuction Interval PC208
Ml Well Mainienance FC203
LTD Lithologic Description PC214
3TU Shatigraphic Unit P21z x|

e | T Cace |

Figure 6-43 Import Tables Screen

Select one or more tables to import data for and click the Select button or double-click on the
table name. A file dialog screen will open allowing you to select the file youwant to import.

ERPT ools/PC Import Data - LDI HE
Lookin | =3 Prime Impart Bli== = =

[Z] ImportaTLet ImporL O bt ImportOUC
1Z) ImponCALC bt ImportL S bt ImportDWL bt
=] ImportEML 1wt ImporLTD bt ImportPINT st
IZ] ImponGwD st ImportL T bt ImportPRATE ket 1
] ImporHE L1t ImparMFL ImparlPLMPINT LEN O SB D o S22o538.00, 1811297.00 M27 GRS
E ImporPUMPRATE . 2| |yaa00 5200 T
NONE

|4FF23 01-5B-01 bh|3920639.00 1871297.00 N27 GPS
FT 0B-AUG-2000 RAD apc NA B N& FT
N3300 5200 ZTZZ
NONE

L

2

[4FP29 015801 bk 395563300 1811257 10 N27 GPS

Flegane;  moarioion [meen | [ B Bt
ONE

Fils of ype: [ Tet Files | ol e

Figure 6-44 Import Data File Dialog Screen
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When you select afileits contents will be previewed on the right side of the screen. Click the
Open button to begin the import. The Import Table Data screen will open.

w. ERPTools/PC - Import LDI Data [ <]
Data File => C:\Pragram Files\PC4\ProjectsDatatldi bt E1

Fieiected Records

Emply Records:
Data Type Enrs:
Duplicates:
Fieferential Integiity:

I~ Ovenute Duplicates

cocoo

Figure 6-45 Import Table Data Screen

If you have selected multiple tables, ERPTools/PC will loop through each selected table
displaying the Import Data file didlog. |f you cancel aut of the file selection screen, a message
is displayed giving you the option of continuing with the next file or canceling the process.

ERPTools/PC

You have not selected a file ko import the data into the SL< table. Do you want to
contin :essing the selected tables?

Figure 6-46 Cancelled Table Import Message

After each file isimported you will be asked if you want to continue the import process.

ERPTools/PC =]

@ Do you want to confinue processing the selected tables?

.

Figure 6-47 Continue Processing Tables M essage

Click Yesto continue and No to abort the process.

Click to select the Overwrite Duplicates check box if you want duplicate records in the
imported data to take the place of records in the current table. A record will be considered a
duplicate if the key fields in the imported record match key fields in an existing record. If you
select this option a warning will open.

ERPTools/PC =]

You have selected the option to averwits eristing duplicate records. Are you sure this is
what you want to do?

Figure 6-48 Overwrite Records Warning

Click Yesto continue and overwrite the records. |f you choose to overwrite duplicate records
the application overwrites the non-key fields of the existing database record. A DUPOVR
message will be written in the log file for each record that is overwritten in this manner.

Click No to return to the default of rejecting duplicate records. If you choose to reject
duplicate records ERPTools/PC wiites a DUPREC message to the log and the rejected record
to the *.DUP file.
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Click the Start button to begin importing. The screen will update a status bar showing the
import progress, and the Rejected Records area will summarize the types of errors.

Clicking the cancel button in the middle of an import will stop the import after the current
record finishes processing. A message indicating that the import was cancelled will be
included in the log file.

&, ERPTools/PC - Import LDI Data
Import complete: 0 records appended, 2 recards replaced. E

Fiejected Records

Empty Records
Data Type Eniors:
Duplicates

Closs Feeferential Integrity

100%

I™ fiverite Duplicates

c-oo

Figure 6-49 Import Data Screen, Import Complete

When the import is complete the screen will display the number of records appended and
overwritten. Click the Close button to close the screen.

6.8.1 Import Log File

During the import process ERPTools PC writes alog file that details the results of the import
process. Thislog file islocated in the same directory as the import data file and uses the same
filename as the import file but has a .LOG extension. The *.DUP, *.ERR, and *.REF files are
the same way. Refer to the table below for an example.

File Type File Name

Import File C:\Work\BrooksLdi. TXT

Log File (*.LOG) C:\Work\BrooksLdi.LOG
Error File (*.ERR) C:\Work\BrooksLdi.ERR
Duplicates File (*.DUP) C:\Work\BrooksLdi.DUP
Referential Integrity File (*.REF) C:\Work\BrooksLdi.REF

Figure 6-50 Import File Extensions

If data conversion errors are detected, the application writes the relevant error information to
the log file and the rejected record is written to the * .ERR file. If referential integrity errors
are found, the application writes a REFINT message to the log file and the rejected record is
written to the *.REF file.

The LOG file may also show several other error messages. Thesemessages are:

UNK: Unknown error — Usually a database constraint error and the actual error
generated is reported.

CRDDUP LDI table only — the coordinates in this record duplicate existing coordinates.

DUPIDX This record is a duplicate because of a secondary index on the table. Thisis
similar to the CRDDUP error.

Any specific errors for specific fields such as invalid date and time, wrong data type,
etc.
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6.9 EXPORTING DATA
This option is unavailable unless a project is loaded.

To export al the datain a project table select the Data> Export Data menu option. The Export
Tables screen will open.

. PC179: ERPTools Export Tables
TAELE _ [DESCRIPTION FCN =
3 Location/Site Cross Refersnce PC202
) Site Cortamination FC205
ZDI Zane PC205
ZLX Localion/Zone Cross Reference PC207
Ml Map Felerence PC204
Wl wel PC203
WINT wiell Constiuction Interval FC208
Ml well Maintenance PC203
LTD Lithologic Diescription FC21¢
sTU Statigraphic Unit Fziz |

e | T

Figure 6-51 Export Tables Screen

Select one or more tables to export and click the Select button. The Export Data file dialog
screen will open.

ERPTools/PC Export Data - LDI [7]=]
Savein |3 Export e =z =

[EIME ot T,

File pame:  [LDIEsport tat Save |
Save astype: [Text Files = Carcel

Figure 6-52 Export Data File Dialog

Navigate to the directory where you want to store the file, enter a file name for the export, and
click the Save button. The Export dialog will open.

Expart File:  C:\Program Files\PC4\Projects\Data\ldifiltered2. TXT

ERPTools Specified Farmats
( ¥ DataLoading Handbaok Farmat (Fiked Format

Texnt Delimiter: [ ¥ Field Separator: [ =

General Text Export Formats
{ I Inchide IPUSER, and UPDATE fields

Stat | Close |

Figure 6-53 Export Dialog

If you have selected multiple tables, ERPTools/PC will loop through each selected table
displaying the Export Data file dialog. If you cancel out of the file selection screen, a message
is displayed giving you the option of continuing with the next file or canceling the process.

PAGE 56



FA41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

ERPTaols/PC =

You havs ot selected a fils o import the data inta the SLX table. Da you want to
anfinue prace Jected tables?

Figure 6-54 Cancel Table Import Message

After each table is exported you will be asked if you want to continue the export process.

ERPTools/PC [>]
@ Doy waint o continue processing the selected tables?

Figure 6-55 Continue Processing Tables M essage

Click Yesto continue and No to abort the process.

If you want to export the data in the ERPTools Daa Loading Handbook format, leave the
check box for that option selected. Data in this format can be imported into another project.
If you want a general text import format click the Data L oading Handbook check box to
unselect it. Thiswill enable the fields in the General Text Import Format area. Select
characters to act as text delimiters and field separators. Select the checkbox if you want to
include the UPUSER and UPDATE fields. Click the Start button to begin the export. When
the export is complete a message will appear. Click OK to close it.

Project records can aso be exported from data entry and error editor screens. This allows
you to export only a subset of data. To export from the data entry or error edita screens
click on the Export Current View toolbar button.

6.10 CREATING AND USING DEFAULT DATA
This option is unavailable unless a project is loaded.

Default Datais used to help facilitate data entry. Y ou can prefill common valuesfor four
tables (LDI, WCI, SAMPLE, and TEST) and then when you want to use these values you can
enable the Data> Use Default Data menu option. When this menu item has a check mark next
to it, any new records, in the tables listed above, will fill with these default data values. The
values will be entered in the fields of a new record as soon as you start typing in any field.

You must first setup the default data and then enable or disable the Use Default Data menu
item.
6.10.1 Setting Default Data Values

To create default data select the Data=> Setup Default Data option, and the Default Data Setup
Screen will open.
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PC500: ERPTools Default Data §etup

T i Wl 1 sampe T TEST

CMCCODE CRDUNITS ELEVUN EXCCODE
cs =] = - -

CRDMETH DRLCODE ELEVUNITS LPRCODE
=] Jecce =l = |

CRDUN ELEVMETH ESCCODE LTCCODE
[ 7| = ]
save | Undo | cose | @)

Figure 6-56 Default Data Setup Screen
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The Default Data Setup screen is a dialog screen with four tabs, containing fields for LD,
WCI, SAMPLE, and TEST. In Prime projects the following fields are available, while in Lab
projects only the Sample and Rest tabs are active. In aLab project, SMCODE does not appear

on the Sample tab.
Prime Projects Only Prime and Lab Projects

LDI WCI SAMPLE TEST
CMCCODE GZCCODE LOGCODE ANMCODE
CRDUNITS WDPROC SMCODE* LABCODE
ELEVUN SAQCODE EXMCODE
EXCCODE WELCODE LCHMETH
CRDMETH WCMCODE * This field is
DRLCODE WTCCODE .
ELEVUNITS onlly avallgble to
LPRCODE Prime projects
CRDUN
ELEVMETH
ESCCODE
LTCCODE

Figure 6-57 Default Data Fields by Table Tab

You can enter a specific value for each field, or choose from a drop down list if the field is
validated against aVVL.

The Unsaved Values warning is in the lower right corner of the screen. When it is green, there
are no unsaved values. When the warning is red, at least one of the values on the screen is
unsaved.

Click the Save button to save the default values entered so far. Clicking the Undo button
returns the values to those present when the last save occurred. Clicking the Close button
closes the screen without saving. If you close the screen with unsaved values, the Unsaved
Changes warning will gpen.
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ERPToals/PC =]

@ “You have unsaved changes. Click OK.to save your changes or Cancel ta returh to editing

the Default Data
| cancel

Figure 6-58 Unsaved Changes Warning

Click Ok to save the changes and continue closing. Click Cancel to return to the Default Data
Setup screen for more editing.

6.10.2 Turning Default Data On and Off

Once default data is entered into the Default Data Setup screen it is available, and you may
choose whether or not to use it.

The Use Default Data Vaues option is only active if the Data> Use Default Data option is
checked. Selectthe option to check or uncheck it.

[BEER Tool: 'Wwindow Help

[ata Entry
Error Editor

Setup Default Data
v Usze Default Data
Create Default Besulkz

Impaort D ata
Export D ata
Load AFCEE Supplied Data

Create Submizzion

Figure 6-59 Default Data Checked

6.11 PERFORMING DATA ENTRY
This option is unavailable unless a project is loaded.
To enter data select Data-> Data Entry. A Project Tables screen will open.

. PC240: ERPTools Project Tables [x]
TAELE __|DESCRIFTION PEN
(3 Localion/Site Cross Reference PC202
£ Site Cortamination FC205
Z0I Zane PC205
74 Localion/Zone Cross Feference FC207
MRl Map Reference PC204
Wl wel PC203
WINT well Constiuction Interval FC206
I wiell Maintenance PC203
LTD Lithologic Description FCZ14
STU | Sratigraphic Unit FC212 =]

Selest | T Canca ]|

Figure 6-60 Project Tables Screen
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Select one or more tables to be edited and click the Select button or double-click on the table
name. A Data Entry screen will open for each Data Table selected.

=% PC201: Location (LDI) Data Entry
RECWO|LOCID LTCCODE LPRCODE NCOORD! ECOOR| &
» 254]1 T 1 7 7.
265/ 22 T [ 7
256/ B84 WL [ 3
211 (8400 & N 2
250/ 88881 & N 223
251|BA0A2 & N 4z
253 BA0RE & N 34211
22| ABARASD B N 34
230/ BALRASDS & N 23;|
227 | AABADDD & N 32|
;I_I 257 ARC WT I EEEEREE] Saﬂﬂﬂiid
W] 4JRecad 1af 18 »[M

Figure 6-61 Typical Data Entry Screen

The standard editing techniques are covered in Section 7, Techniques. This section will cover
many of the specific features that you will use while doing data entry.

6.11.1 General Data Entry Notes

If you attempt to enter data that does not match the data type of the field, exceeds the
field length, causes referential integrity errors, or violates index restrictions an error
message is displayed. Read the error message and click OK to return to the field and
make corrections.

If you are creating or editing a new record and are unable to move off the record by
either clicking or using the arrow keys, this indicates there is a problem with the record
you are adding or changing. Click the Save Record toolbar button and an error
message will be displayed. The usua cause for this type of error is missing key field
information or key field information that cdbes not match to any existing parent record.

After you successfully save arecord by clicking the Save button or by entering another
record you cannot use the Undo button to reverse changes to the record. If you
receive an error message, and the pencil icon remains on the record selector, you can
till Undo.

Any edits will change the VALSTATUS field of the edited record to NV and change the
UPUSER and UPDATE fields.
6.11.2 How to Find and Replace
The Find option searches for records with data that matches the search criteria. The Replace
option substitutes a new value for the one found.
6.11.2.1 HOW TO FIND VALUES

The Find Dialog box is used to search for values in a specific field. To find records containing
a specific value, first select the column to be searched. Y ou cannot search more than one
column at atime. Then click the Find toolbar button. The Find dialog will open.
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Find [y7

Replace I

Find |
Find Next
Heplace

Close

Heplace All

The criteria is: LTCCODE =" T"

Match B
’76' ‘wihole Field € Start of Field " Any Part of F\eld|

Figure 6-62 Find Dialog

Enter the search criteriain the Find box. If you want to find for a Null or Empty field, leave
the Find box empty. Inthe Match By area select one of the radio buttons to indicate whether
you want to match the whole field, the start of the field, or any part of afield. To start the
search, click the Find button. The program will select the first record where the value
appears, and the Find Next button will become active. Currently only the record selector will
change to aright triangle on the row where the value was found but the actual cell will not be
highlighted. The criteria for the search will be displayed below the Close button. Click the
Find Next button to continue the search. After you have located all acurrences of the text in
that column a message will appear telling you no more values match.

6.11.2.2 HOW TO REPLACE VALUES

The Replace Dialog box is the Find Dialog box, with the Replace field and buttons active. To
replace values in acolumn first select the column to be searched. Y ou cannot replace values
in more than one column at atime. Then click the Replace toolbar button. The Find and
Replace didog will open.

Find [i7
Find
Replace [ —I

Match B
’7(-' ‘whols Field ¢ Start of Field

£ AnyPat of Field |

Replace All

The Replace All SAL Sting is: UPDATE LDI SET LDI LTCCODE =
S WHERE [LOCID <> FIELDOC' AND LOCID <> LABOCAND
[LTCCODE = WTY

Figure 6-63 Replace Dialog Box

Enter the text to be searched for in the Find box. Enter the new text to replace it in the
Replace box. If you want to replace a value with a Null or Empty string, leave the Replace
box empty. Inthe Match By area select one of the radio buttons to indicate whether you want
to match the whole field, the start of the field, or any part of afield. Clicking the Find button
will select the first occurrence of the existing text, and the Find Next and Replace buttons will
become active. The criteriafor the search will be displayed below the Close button. Clicking
the Replace button will replace the selected occurrence of the text and search for the next one.
Continuing to click the Replace button continues the search and replace. The Replace All
button replaces all occurrences of the text in the column. Clicking the Find Next button will
look for the next occurrence of the value without replacing. After you have located all
occurrences of the original text in that column a message will appear telling you no more
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values match. If you use the Replace All a message will tell you how many records were
edited and how long it took.

6.11.3 How to Filter and Sort Tables

Filtering and Sorting allow you to manipulate your datain such away that makes iteasier to
work with. When you sort data you are ordering one or more columns in either ascending or
descending order. Thisisthe Standard Query Language (SQL) Order By clause. Filter alows
you to limit the set of data you are working with, essentially building a SQL Where clause.
Records in ERPTo0ls/PC screens may be sorted and filtered to enable you to organize groups
of records. Sorting puts all of the records in a set in order according to one or more of the
record fields. Filtering selects those records in a set that match one or more specific criteria.

6.11.3.1 HOW TO SORT DATA

Y ou can sort records one of two ways. The easiest and simplest way isto Quick Sort. See
6.11.4, How to Quick Sort.

If you need to do a more complex sort you will need to use the functionality found by
selecting Edit-> Filter menu option or clicking the Filter/Sort toolbar button. The Filter menu
command or toolbar button opens a Create Sort Dialog Box. You will aso use this same menu
or toolbar to get to the Filter functionality.

Create Sort for LDI

Sort On Field(s) Sort [Drder By) Statement

D~ =] Sort Option [OADER BY LOCID
LPRCODE & Ascending
NECOOAD

ECOORD € Descendig
CRDTVFE

CRDMETH

ERDLNITS

CRDUN

ESTDATE E

AddField | DeleteLast| Deleteall | RunSon | Addwhere Clause|  Cancel |

Figure 6-64 Create Sort Dialog Box

By default the current Sort (Order By) Statement will be displayed when you open the dialog.
There are several tables that have system specified sorts that will always be added to any sort
or filter you create and you may see these in the SQL Statement window. Y ou will see alist of
fields/columns present in the data entry screen, an option group with an Ascending option and
a Descending option, a SQL Statement area that will hold the Order By clause, and some
command buttons on the bottom of the dialog box. The buttons are Add Field, Delete Last,
Delete All, Run Sort, Add Where Clause, and Cancel.

Select the first field you want to add to the Order By clause by double-clicking on the field or
clicking once and clicking on the Add Field button. Continue doing this until all the fields you
want to use are added. If you want to change the sort order from Ascending (default) to
Descending, click the Descending option before selecting the field. Don't forget to set it back
for the next field. If you make a mistake you can click the Delete Last button. This will
remove the last field added to the Order By clause. Y ou can continue to click the Delete Last
button to move back through the set or Order By clauses or you can click the Delete All button
to delete all the Order By clauses.
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To apply the Order By clause click the Run Sort button. The dialog box will close and the data
entry screen will reappear with the data sorted based on the new Order By clause ard an
orange FILTER flag will appear in the bottom right of the screen. Y ou can right click on the
FILTER flag and the current filter will be displayed in a message.

The Order By works by telling the datasheet to present the information sorted by the first
column added to the clause, then the second column added to the clause, etc. For example:

Lab Sample ID: |Matrix: [Logging Date: Logging Time:
D96-2694-01n  |SE 01-Jan-1996 1300
D96-2694-010  [SE 01-Jan-1996 1200
D96-2694-01p  |SE 01-Jan-1996 1250
D96-2694-01z 2z 01-May-1€97 1200
D96-2694-0la |SE 01-May-1€97 1210
D96-2694-01x SE 01-Jan-1996 1210

Figure 6-65 Data to be Sorted

Select the Logging Date and Logging Time field to sort by and the SQL Statement area will
have the following statement in it: “ORDER BY LoggingDate ASC, LoggingTime ASC” Click
the Run Sort button. The data will look like this:

Lab Sample ID: |Matrix: [Logging Date: Logging Time:
D96-2694-010  [SE 01-Jan-1996 1200
D96-2694-01x SB 01-Jan-1996 1210
D96-2694-01p [SE 01-Jan-1996 1250
D96-2694-01n  [SE 01-Jan-1996 1300
D96-2694-01z zz 01-May-1€97 1200
D96-2694-01la |SE 01-May-1€97 1210

Figure 6-66 Sorted Data

6.11.3.2 HOW TO FILTER DATA

If you need to Filter your data, basically building a SQL Where clause, select the Edit-> Filter
menu option or click the Filter/Sort toolbar button. The Filter menu command or toolbar
button opens a Create Sort Dialog Box. |If you also need to sort the data build your sort using
the techniques discussed in Section 6.11.3.1. To access the Create Filter screen click the Add
Where Clause button. The Create Flter dialog will open.
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Create Filter for LDI

LOCTD j Equal To [WHERE DRDER BY RECNG ASC
LTCCODE Hot Equal To

LPRCODE Less Than

NCOORD Less Than or Equal To

ECOORD Greater Than

CROTYPE Greater Than o Equal To

CROMETH like

CRDUMITS Between ... And

CRDUN JeHul

ESTDATE = s ot b

Adipuie|  [Deleteilast Ruie)| | Delete AuRuies | Run Gucy) |

Figure 6-67 Create Filter Dialog

You will see alist of fields and columns present in the data entry screen, alist of equivalency
options which define how the data will be limited, a SQL Statement area that will hold the
Where clause, and a row of command buttons on the bottom of the dialog box. Unlike the
Sort screen, you will not see the existing Where clause.

Select the first field you want to add to the Where clause by selecting the name in the Field
Name list. The equivalency options will become enabled. Select the equivalency option you

want. If you select the Between ... And equivalency option, a Between and an And field will
be displayed.

Create Filter for LDI

Field Name: & And C Oris: Select Statement

Equal To [WHERE ORDER BY RECND ASC
Hot Equal Ta
Less Than

Greater Than or Equal To

Like
CROUN Tehud
ESTOATE = s Mot hul
Between
And |
AddRule | [Deleie Last Aule | Delete Al B | Fun uey || Close |

Figure 6-68 Create Filter Dialog With Between Option

If you select the Is Null or Is Not Null equivalency options, no comparison fields are
displayed.

Create Filter for LDI

Field Hame & And C Oris: Select Statement

Equal To [WHERE ORDER BY RECND ASC

Hot Equal Ta

Less Than

Less Than or Equal To
Greater Than

Greater Than or Equal To

e N G| Fun uey || Close |

Figure 6-69 Create Filter Dialog With Null Option

For dl other equivalency options a single Compared To: field becomes visible.
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Create Filter for LDI
Field Name & And C Dris: Select Statement

[WHERE ORDEFR BY RECNO ASC

Less Than or Equal To
Greater Than

Greater Than or Equal To
Like

Between . And

CRDUN I3 Hul

ESTDATE = s ot Hul

AddRule | Delete Lost Auie || Delete A1 Bulcs | AunOucw || clese |

Create Filter Dialog With Equal Option
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Enter the value that is appropriate and click on the Add Rule button. This addsthe rule to the

SQL Statement area.

To add a second or subsequent rule, click on the field list to select afield. An option group
with an “And” selection and an “Or” selection appears above the egquivalency option list. The
default is set to “And” asin “Anima Equas ‘Dog’ AND Color Equals ‘Black’.” In an“And”
statement both values must be true for the record to be retrieved. The*Or” statement will

retrieve records when either one value OR the other value OR both are True.

To delete the last added rule click the Delete Last Rule button. To delete al the rules click the

Delete All Rules button.

Click the Run Query button to apply the Where clause to the datasheet. The dialog box will
close and the data entry screen will reappear with the data sorted based on the new Where
clause and an orange FILTER flag will appear in the bottom right of the screen. Y ou can right

click on the FILTER flag and the current filter will be displayed in a message.

The following section explains each of the equivalency options available in the Equivalency

Options list.
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Equivalency Usage Example
Option
Equal To The field selected MUST Equal the value LABSAMPID Equal To “1234abc” will
entered in the Compared To field. retrieve records with a LABSAMPID of
“123abc”.
Not Equal To The field selected MUST NOT Equal the LABSAMPID Not Equal To “1234abc”
value entered in the Compared To field. will retrieve records with a LABSAMPID
other than “123abc”.
Less Than The field selected MUST be Less Than the | SAMPLENUMBER Less Than 2 will

value in the Compared To field.

retrieve records with a
SAMPLENUMBER of 1 or lower.

Greater Than

The field selected MUST be Greater Than
the value in the Compared To field.

SAMPLENUMBER Greater Than 2 will
retrieve records with a
SAMPLENUMBER of 3 or higher.

Less Than or
Equal To

The field selected MUST be Less Than or
Equal to the value in the Compared To
field.

SAMPLENUMBER Less Than or Equal
To 2 will retrieve records with a
SAMPLENUMBER of 2 or lower.

Greater Than or

The field selected MUST be Greater Than

SAMPLENUMBER Greater Than or

Equal To or Equal to the value in the Compared To Equal To 2 will retrieve records with a
field. SAMPLENUMBER of 2 or higher.
Like The field must match the pattern specified | MATRIX Like “S*” will retrieve record

in the Compared To field. Wildcards can
be used. Please refer to the Note after this
table for a detailed explanation of
Wildcards.

with a MATRIX that starts with an “S”.

Between ... And

The field must be between the TWO values
specified in the Compared To field. The
Between is inclusive of the two values.

You must enter the word AND between the
two values and put quotes around any text
(non-numeric or date) value.

SAMPLENUMBER Between 4 AND 6
will retrieve records with a
SAMPLENUMBER of 4, 5, and 6.

Null The field selected in the Field list must be | MATRIX is Null will retrieve any records
Null. No Compared To field will appear. with a Null (Empty) Matrix.
Just press the Add Rule button after
selecting the Null equivalency option.

Not Null The field selected in the Field list cannot MATRIX is Not Null will retrieve any

be Null. No Compared To field will
appear. Just press the Add Rule button
after selecting the Not Null equivalency
option.

records with a Matrix value.

The following is quoted from Microsoft Access' s Help File:

Using Wildcard Charactersin String Comparisons
Built-in pattern matching provides a versatile tool for making string comparisons. The

following table shows the wildcard characters you can use with the Like operator and the
number of digits or strings they match.
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Character(s) in pattern | Matchesin expression

? Any single character

* Zero or more characters

# Any single digit (0-9)

[charlist] Any single character in charlist
[!charlist] Any single character not in charlist

Figure 6-71 Wildcard Characters

A group of one or more characters (charlist) enclosed in brackets ([ ]) can be used to match
any single character in expression and can include almost any characters in the ANSI
character set, including digits. The special characters opening bracket ([ ), question mark (?),
number sign (#), and asterisk (*) can be used to match themselves directly only if enclosed in
brackets. The closing bracket (]) can't be used within a group to match itself, but it can be
used outside a group as an individual character.

In addition to a simple list of characters encbsed in brackets, charlist can specify a range of
characters by using a hyphen (-) to separate the upper and lower bounds of the range. For
example, using [A-Z] in pattern results in a match if the corresponding character position in
expression contains any of the uppercase letters in the range A through Z. Multiple ranges can
be included within the brackets without any delimiting. For example, [azA-Z0-9] matches any
alphanumeric character.

Other important rules for pattern matching include the following:

An exclamation mark (!) at the beginning of charlist means that a match is made if any
character except those in charlist are found in expression. When used outside
brackets, the exclamation mark matches itself.

The hyphen (-) can be used either at the beginning (after an exclamation mark if oneis
used) or at the end of charlist to match itself. In any other location, the hyphen is used
to identify arange of ANSI characters.

When a range of charactersis specified, they must appear in ascending sort order (A-Z
or 0-100). [A-Z] isavalid pattern, but [Z-A] is not.

The character sequence [ ] is ignored; it is considered to be a zero-length string (“*).

The following table shows how you can use Like to test expressions fa different
patterns.
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Kind of match Pattern Match (returns True) No match (returns False)
Multiple characters “a*a” ‘aa”, “aBa”, “aBBBa” “aBC”

“*ab*” “abc”, “AABB”, “Xab” “‘azb”, “bac”
Special character “a[*]a” “a*a” “aaa”
Multiple characters “ab*” “abcdefg”, “abc” “cab”, “aab”
Single character “a?a” “‘aaa”, “a3a”, “aBa” “‘aBBBa”
Single digit “atta” “afa”, “ala”, “a2a” “aaa”, “al0a”
Range of characters “la-z]" “7,"p”, 1" “2" &
Outside a range “l'a-z]” “9” “&", “%” “b”, “a”
Not a digit “['0-91" “A”,“an, “&", 1~ ‘0", “1", “9”
Combined “a[lb-m]#” “An9”, “az0”, “a99” “abc”, “aj0”

Figure 6-72 Characters Used to Test Like Expressions

6.11.3.3 CLEARING A FILTER OR SORT

To remove the Sort or Order By clause select Edit-> Show All or click the Show All Records
toolbar button. All records will be displayed and the FILTER flag will disappear.

6.11.4 How to Quick Sort

Select a cell in the column in the table you want to sort by or select an entire column. Then
select one of the Sort options on the Record- Quick Sort menu or click one of the Sort
buttons on the toolbar. The Sort Ascending option arranges the records in a table according to
values in the selected column, with the smallest value first. The Sort Descending option
arranges the records in a table according to values in the selected column, with the largest

value first.

Note: If you sort using this technique, the screen will not show theorange Filter

war ning.

6.11.5 How to Calculate Percent Recovery
This function is only available with a Lab project loaded and the RESULT Data Entry

wor ksheet open.

Select the Edit-> Calculate Percent Recovery option, and a message will open.

ERPTools/PC

iy Walues in the RESLILT table.

@ You are abaut to calculate Percent Recaver)
Do you want to Update Al Percent Recovery values?
Press YES to Update &l Percent Recovery values,
Press MO to Update Only Mul Percent Recovery values, and
Press CANCH

0 M|

EL to caneel the Update

Cancel |

Figure 6-73 Calculate Percent Recovery Message

This option allows you to calculate the Percent Recovery field automatically. Y ou can update
all appropriate Percent Recovery fields or just thoseappropriate Percent Recoveries where the
field is Null. The message asks if you want to update all Percent Recovery values. Click Yes
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to update all records, No to update only records with Null in the Percent Recovery field, or
Cancdl to return to the Result table without making any changes.

6.11.6 How to Export Filtered and Sorted Records

To export afiltered or sorted version of atable, first open a Data Edit screen for atable and
apply the filters and sorts desired. Then select the Edit->Export Current View option or click
the Export Current View button. The Export Data File dialog screen will open.

ERPTools/PC Export Data HE

Savein | Dets SN =] =
T Lot A THT

w2 TKT

Filepame: | [ s |
Save s type: [Text Files = | Cancel

Figure 6-74 Export Data Dialog

Navigate to the directory where the data is to be stored, then enter a file name in the File Name
field. Click the Save button to create the file. The Export dialog will open.

Export File: C:\Program Files\PC4\Projects\Data\ldifiltered2. TXT

" ERPTools Specified Farmats

¥ DataLoading Handbook Farmat (Fixed Format)

General Text Export Formats
’VTExtDEmtEv B L ] a—

T Include UPUSER and UPDATE fields,

Statt Close |

Figure 6-75 Export Dialog

The path and file name will be shown at the top of the screen. If you want to export the data
in Data Loading Handbook format leave the ERPTools Specified Formats check box selected.

To select a different format first click on the Specified Formats box to uncheck it. The
Generd Text Export area will become active.

. Export [x]

Export File:  C:\Program Files\PC4\Projects\D ata\ldifiltered2 TXT

" ERPTools Specified Formats

I~ DataLoading Handbask Farmat [Fiked Famat)

Text Delimiter: [ > Field Separator: || -

General Text Export Formats
{ ™ Include UPUSER, and UFDATE fields

Statt Close |

Figure 6-76 Export Dialog with General Area Active
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Note: Data exported in General Text Export Formats cannot be imported into
ERPToolg/PC.

Select a Text Delimiter and Field Separator using the drop down lists, then select the check
box if you want to include the Upuser and Update fields in the export. Click Start to begin the
export. Once export is complete an Export Complete message will be displayed.

6.11.7 Printing or Previewing Records From The Data Entry Screen

ERPTools/PC now provides a rudimentary print/preview function to allow you to print the
contents of a data entry screen. You can print or preview the entire table, afiltered set of
data, or only selected records.

There is no provision in the printing process to limit the number of columns printed, so your
output may be several pages wide. You can limit this effect by manually closing unnecessary
columns before selecting Print Current View. See 7.4.4 How to Change Column Width.

Once you have determined what records you wish to print (by filtering or selecting) then
select the File-> Print Current View option or click the Print Current View button. The Page
Setup dialog will open.

Page Setup [ 7] x]

Figure 6-77 Page Setup Dialog

Select the desired printer and layout options. When you click OK the Preview message will
open.

ERPTaols/PC =

would yau like ta print previsw?
Click YES to pint preview, click NO ta send the print diectly to the printer,

Figure 6-78 Print Preview M essage

Click No to print the report directly to the printer. Click Yesto open a Print Preview of the
report. If you have selected records the Selected Records message will open asking if you
want to print al the records or only the selected records.
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ERPTools/PC =]
wiould you ke ta print only the selected records?

Click YES ta print selected records, click NO to print al records,

Figure 6-79 Selected Records M essage

Click Yesto print or preview only selected records, or No to print or preview all records. |f
you are previewing, the Print Preview report will open.

[ Print Preview of LDI - Location

Ele View

g QB =k ¢ > dpageids | &

¥

Figure 6-80 Report Print Preview

Some tables have alarge number of records, and it may take an extended time to paginate the
report. The Stop Pagination button will halt this process and allow you to escape from the
report screen.

Using the Print Preview toolbar you can navigate through the report and zoom in and out, then
either print the report or close without printing.
6.11.7.1 HOW TO PRINT PREVIEWED RECORDS

With the Print Preview screen open and using the Print Preview menu, select the File> Print
option or click the Print button to send the table to the printer you selected on the Print Setup
screen. A message will open showing the progress of the printing.

Fiinting page 3 on HP 5 51...

Figure 6-81 Printing Print Preview Message

To print part of the pages, select the File> Print Some Pages option. The Print Range dialog
will open.
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Print range

Please specify the pages to print

Figure 6-82 Print Range Dialog

Enter the pages you want to print. To select a range of pages enter the first and last page
number with a hyphen between; for example 25. To select several individual pages enter page
numbers separated by commas; for example 7,9,12. These techniques can be combined; for
example; 25,7,9,12. Click OK to print.

To print one page, navigate to that page and select the File> Print Current Page option. The
page will print from the selected printer.

6.12 CREATING DEFAULT RESULTS
This option is unavailable unless a project is loaded.

Once the Local Methods have been created you can create default results. These results can
also be edited as needed after they are created.

To create default results select the Data—> Create Default Results option. The Create Default
Results screen will open.

Create Default Results

2|5 20 53510 BB
es NOME
MNONE
o N
Yes 9/SwB2408 Sw3n10 NONE AEE

Create Resulls | Close |

Figure 6-83 Create Default Results Screen

The screen will display test records that do not have any child results. The records are cross
referenced against the Local Methods table, and the HAS LMs? field designates which records
have local methods. Select one or more of the records that have local methods and click the
Create Results button. ERPTools/PC will create default result records based on the contents
of the appropriate local method. A message will open telling you how many Test records had
results added, and asking whether you want to see the inserted records.

ERPTools/PC =]

Result records for 2 Test records were inserted on 14-5ep-2000 1356
Do you wat o see the inserted Result records now?

Figure 6-84 Default Results M essage

PAGE 72



FA41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

Click Yesto open the Analytical Results (RESULT) data entry screen, with the records filtered
SO you can view the new records.

o PC224: Analytical Results (RESULT) Data Entry

RECNO| TEST_RECNO|PARLABEL PRCCODE PARVE PARVAL| «
S 24 2 [T0c ORG J

225 2BPH STD
226 2PH10L ORG
227 2PRYN10L ORG
228 ACE ORG
229 ACRN ORG
230 AZBZD10 STD
231 BDCME ORG
232 ER4FBZ STD
233 BRCLME ORG

wl cof wo| wo| e e wl vl el w

b= BRNE oF6 _l;l
a{ »
W[ 4JFecod 1of 75 » M

Figure 6-85 Analytical Results Screen With New Results

Note: If nolocal method exists for a record the record cannot be selected, however you
may be able to move the selected record marker to a No record if you click on it, even
though therecord is not actually selected. Records with local methods, which are
selected, will remain selected.

If you click Create Results with no record selected a warning will open and the test record will
remain on the list of records without default results.

ERPTools/PC

& o must select at least one walid record with associated Local Methads,

Figure 6-86 Default Results Warning

Click Close to close the Create Default Results screen.

6.13 VALIDATING DATA
This option is unavailable unless a project is loaded and a worksheet open.

There are two levels of validation that will occur in the data entry screens. Thefirst is
Database Level validation and the second isField and Record vaidation.

Before you can save a record the record must have al the appropriate key fields filled in and al
the fields should be of the appropriate data type. ERPTools/PC will not let you leave a record
that will fail areferential integrity constraint. If you are creating or editing a new record and
are unable to move off the record by either clicking or using the arrow keys this indicates
there is a problem with the record you are adding or changing. Click the Save Record toolbar
button and an error message will be displayed. The usual cause for this erroris missing key
field information or key field information that does not match to any existing parent record

Field and Record validation is now done from the data entry screens. This means you can
apply afilter to the data and the filtered set of datawill be the only data validated. If the
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system finds errors it writes them to the error table. If no errors exist, the record will be
marked as validated.

To vdidate a set of data, first open a Data Edit screen for the table. If you want to validate
part of the records, apply the filter desired. Then select the Edit> Validate Current View
option or click the Validate Current View button. The program will begin validating the
records shown on the datasheet, and will show the Validation progress bar. During the
validation you can press the Cancel button to cancel the validation. When the validation
process stops, either cancelled or completed normally, arecord is written to the validation
history table showing the table name, date/time, validation type, and the user name of the
person performing the validation.

B ERPTools/PC - Validate Data

Processing 107 recards

Walidating table LDI - Rule L11

Figure 6-87 Validation Progress Bar

When vadidation is complete you will get one of two messages. If validation finds no errors
the Validation Complete message will open.

ERPTools/PC

& Validation complete. Mo errors were detected.

Figure 6-88 Validation Complete M essage

If errors are found, the Validation Errors warning will open.

ERPTools/PC =]

Field and Record validation ermors have been detected. Do you want to open the Enor
Editor and fix these enors now?

Figure 6-89 Validation Errors Message

The Errors message gives you the option of clicking the No button and simply closing the
message, or clicking Y es to open the error editor screen and correct the records.

6.14 EDITING ERRORS
This option is unavailable unless a project is loaded.

The Edit Errors screen enables you to find and correct errors/warnings in data records. You
can select the Data=> Error Editor option or you may have been brought here directly after
validating some records. If you use the menu option an Edit Errors Table list screen will open.
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[TABLE [DESCRIPTION FON |-
[3711] [Cacafion P01
80 chucal\nn/Site Cioss Fieteroncs FL207
SCC Site Cortamination PC205
Z0I Zane PC205
ZLx Location/Zone Cross Fieference PC207
MRl Map Reference PC204
Wil Well FC203
WINT wiell Constiuction Interval PC208
Ml wiell Mainienance PC203
LTD Lithologic Description FCZ14

STU Shatigraphic Urit Pe2iz =|

R | T Caca |

Figure 6-90 Tables List Screen

Select the table or tables with validation errors and click the Select button or double-click on
the table name. An Error Editor screen will open for each Data Table selected. If you use the
menu option and there are no errors then the following message will be displayed.

ERPTools/PC =]

& Thera are ro errrs for LDI |

Figure 6-91 No Errors Detected Warning

If there are errors/warnings or you were brought here after validating data, the Error Editor
screen opens.

% PC201: Location [LD1) Error Editor
Current Emror

RULEID [FIELD SEVERITY |MESSAGE -
p|L04 |CMCCUDE ERROR  |CMCCODE is not & valid code.
Lo7 DRLCODE ERROR  |DRLCODE is nat a walid code.
L |?LEV WARNING }TLEV should not nomally be null.

15 |ESCCODE  |ERAOR  |ESCCODE s nota vaid code

L

118 TFrrone. FRRMR TESTTINF is vt 2 seahd ende. A,LI
4 13
4] 4|Record 1 of 18 |31
Records Containing Errors
RECNO[LOCID LTCCODE LPRCODE NEOORD ECOORD[CRDTYPE CROMETH
y 39666 2 3
40| ceee z 4
<l | o
4] 4|Recod 1 of 2 A1)

Select View | ' By Rule By Record

Figure 6-92 Error Editor Screen, by Rule

You can display errorsin the Error Editor either By Rule or By Record. The By Rule option
allows you to select asingle error and all the records with that error will be displayed.

Choosing the By Record option allows you to select a single record and have al the errors for
that single record displayed.
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2% PC201: Location (LDI) Error Editor [x]
Current Error
RULEID |FIELD SEVERITY |MESSAGE
»[L38  |DEFTH ERROA  |DEPTH must be gieater than zero
N — |
14 4]Record 1 of 1 > M
Records Containing Erors
RECNO[LOCID LTCCODE LPRCODE NCOORD ECOORD|CADTYPE CRDME
» G W T 7 71N27 SRVET
7|22 T T 7 7N27 SRVET
?ﬂw & N 2 2[5 DIGIT —
45(A8dA1 & N 223 2[5 DIGIT
[LERYS & N 34321 z[5 DIGIT
7| AAARE & N 34211 EH DIGIT
— T [0 ET) Al hH:IT} -
4] 4]Record 1 of 14 AL
Select View |~ By Rule & By Record

Figure 6-93 Error Editor Screen, by Record

The Records Containing Errors datasheet of the Error Editor contains many of the same
editing functions as the typical data entry screen with the exception of applying afilter. Select
arecord in the Records Containing Errors worksheet, then refer to the Current Error datasheet
to see what is incorrect, select the cell, and correct the data.

6.14.1 Printing an Error Report

Sdlect File> Preview Error Report or click the Preview Error Report button to print an error
report for offline analysis. An Error Editor report will open.

i S

# Report Preview
File

@‘égm, ‘Q@quz j|gg|ms
Contents -
L02-FLD - BH
L0O3-FLD - Nu
L04-FLD - Ch
L0 -FLD - Nu
L07-FLD - DF
L08-FLD -EC

L10-FLD - Ny LDI validation Errors
L11-FLD-EL

=) L13-FLD - Nu The following LDI records have failed Field and Record validation:
5 L15-FLD -ES RULEID EELD SEVERITY. MESSAGE
L16-FLD -ES Lo2 BHDIAM WERN BHDIAM should not normally be grester than SOinches.

L19-FLD -EX —————— HeyFislds ————|

L18-FLD -ES
L22-FLD - L0 RECNO  LOCID EHDIAM

‘ + Dack + Fomerd

i i oy oy

L24-FLD - L0
L2a-FLD -LT
L30-FLD - NC
L31-FLD - Nu
L32-REC-LT
L33-REC-LT
5 L34-REC-LT
3] L36-REC -DE
L38-FLD - DE

i i oy oy

M6
"z

RLLE ID
L03

RECHO

01-5B02
01.38.03

FELD
BHDIAM

55
100

SEVERITY MESSAGE
ERR NUmeric valueton large

KeyFields ————————

LoCID

BHDIAM

L33-REC-LT M7 01-58-03 100
L42-REC -EC

Ll-_lua-nscjj . [ . ;
Figure 6-94 Error Editor Report Preview

Use the Report Preview toolbar to view the report. To print the report select the File> Print
option or click the Print button. Use the File-> Printer Setup option if you need to select a
printer.

You can aso click on the Table of Contents (TOC) button (first button on the left) and a TOC
will be displayed. The TOC will display the Ruleld and Message of each error in the report. If
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you want to navigate to a specific error in the report click on the specific Ruleld and the report
will move to display the error in the middle of the screen. Unfortunately this feature is
unavailable in the Submission reports because of a known bug in building a TOC in reports
that contain sub-reports. This will be corrected as soon as the fix is received from the
manufacturer o the reporting tool (estimated end of September 2000).

You can also save these reports in either PDF or RTF format. Click on the File>PDF Export
or File=> RTF Export options. A file dialog screen will be displayed. Select the location and
enter the file name desired and then click the Save button. The report will be saved in the
appropriate format.

6.15 SUBMISSIONS
Admin users only. This option is unavailable unless a project is open.

A submission is created to either pass data to AFCEE or to pass data to the Lab’s Prime
contractor. For a Prime submission, data is submitted to AFCEE in four submission files.
Each submission file contains a group of datafiles. A Lab submission is done only for Group
3 and it excludes the EMI table.

Group Document Files Included

Group | [project name].ZG1 LDI, SLX, SCC, ZDlI, ZLX, MRI, WCI, WINT and WMI

Group Il [project name].ZG2 | LTD, STU, HSU, CALC, GWD, ATI, PUMPRATE, TWI, OWL, TR,
TOW and PUMPINT

Group Il [project name].ZG3 | SAMPLE, TEST, RESULT and EMI

Group IV [project name].ZG4 | OU, OUC, SOX, LOX, RSI, RSP, RSX, LSX, ROX, RTI, RTP and
LTX

An Items of Interest report is generated with each submission file for a PRIME submission.

Figure 6-95 ERPTools/PC Submission Files

Note: If you entered an Evaluation serial number of 99999 when you installed
ERPTo0ls/PC the program will not create submission records until you register it. To
upgrade your installation of ERPT ools/PC see Section 6.17.5.1.

6.15.1 Creating Submission Records

Note: All data MUST be valid before a submission file can be created.

To create a submission select the Data=> Create Submission option. The Submission
Generation Options dialog will open
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. Submission Generation Dptions [<]

Submission Type S [72]

& Fi
© New records

£ Resubmi

Submission Date

Figure 6-96 Submission Generation Options Screen

Select a submission type.
Full submission validates and exports al records in the group.

The New Records option only submits records that have not previously been
submitted.

Resubmission allows the preparation of a set of records previously submitted on a
particular date.

Use the Submit group drop down list to select which group, 1 through 4, you want to prepare.
If itisaLab project Option 3 is chosen for you.

If you selected Resubmission as the submission type the Submission Date drop down list will
be active. Select the original submission date of the records you want to resubmit. Click the
Start button to begin the submission process. All the records that will be included in the
submission are first revaidated using Field and Record validation rules.

B ERPTools/PC - Validate Data =] B3
Processing 109 records ...

Walidating table LDI - Rule LE2

Cancel

Figure 6-97 Revalidate Data Status Bar

If any of the records have not passed field and record valdation an error message will open
and the submission validation process will stop.

ERPTools/PC =]

Same of the recards in the selected submission group do nat pass Field and Recard
walidalion. These have to be corrected before the submission ereation process can take
place. Please open the Error Editor and correct the ertars for the following tables: LDI,
5CC, 5L

Figure 6-98 Submission Validation Warning

Click OK to close the error message, then use the Error Editor for each identified table to
correct the Field and Record level validation errors. If only warnings are identified during the
re-validation process then submission level validation will occur. When @l the records are
validated return to the submission process. If al records have been validated, ERPTools will
begin the submission validation process. The Submission Validation progress bar will show
you the progress.
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Submission Validation - Group 3

Walidating RESULT table

Figure 6-99 Submission Validation Progress Bar

When the submission validation process is complete, if there are submission errors the
Submission Errors report will open in a Report Preview screen.

& Report Preview O[]
File

B & e |Qalm: ]| G ae | + msck + Fowd

Group Three Submission Errors

SubmissionIdentification
Project Name:  SUCCESS Company Mame:  Fr_|
% Cortract: F1
Delivery Oroer: 2
ase: KNGSN
- . Serial Kumber: 51
Subrmission Dete: 25-A.g-2000 ristietice H
The tollowiny TEST records have foi validation:
BULE D EELD SEVERITY MESSAGE
Tas suB ERR Preparation method Is invalid forthis Analytical method, Matrix andL
RECNG LOGDATE ~ SACODE SAMPNG MATRIX ANMCODE EXMCODE RUNNO ANADATE
1 M-lnd1985  FB 1 AD £303 2412 1 30Deci98E
4] | _'DI

Figure 6-100 Submission Errors Report

Note: Thisisthe only report that will appear in a LAB project. A LAB project will not
generate an Items of Interest report or the VVL Changes report mentioned later.

After you review the Submission Errors report cbse it, and the Submission Complete message
will open.

ERPTools/PC =]

Submission process complete
Thank you for using ERPTooks/PC

Figure 6-101 Submission Complete M essage

Return to the Data Entry screen and make corrections and revalidate at the field and record
level. Next return to the Submission process. If there are no submission errors the Items of
Interest report will open.
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= E

CFIEEEC I

‘ + Dack + Fomerd

Group One -Ttems of Interest Report

Project Meme:  SUCCESS

Base: KNGSN
Submission Dte: 25449-2000

Submnission dertification

<

®

Corfracter Pfomaion

Cormpany hame:
Contract:
Delvery Drder-
Serial Mumber:
App rsion: Wl krsion:
RECORD COUNT

1

o

o

o

o

o

o

o -

| W

Figure 6-102 Items of Interest Report
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Review the Items of Interest report. You are only required to send AFCEE a signed copy of

the first page of the Items of Interest report as the entire report is now included in the

submission file in PDF format. Y ou can print the entire report if you need to for your own
purposes. Upon closing the Items of Interest report, if there are new or changed VVL values
then the VVL Changes report will open.

&. Report Preview
File

[_ D] x]

B &@en Q@ = Gaf=

| 4+ Bzck = Fonwerd

WYL NAME: ANPARXREF

List of ¥¥L Changes fer SUCCESS Project

DESCRIFTION: An alytical Method#nalyte Cross Reference

[AFWEO0E | WATRI

FARLABEL

UPLSER

TPORTE

& W PR

RICR

T4 Sep 1800

FCEDIG

RICK,

74 Sep 1800

=

RICK

24 5ep- 1900

Rz

RICK

24 5ep 1000

R

T4 5ep-1999

FCBIZot

245201999

FCBIZo0

245201999

i

34 51000

FrEE6R

74 5ep 1800

Frar

74 Gep 1800

FRAN

74 Sep 1800

PR

74 Sep 1800

g
FEEEEEEEEEEEEE

FRETGF

74 Sep 1800

4

Figure 6-103 VVL Changes Report

Review and/or print the VVL Changes report and closeit. This report is also included in the
submission file in PDF format. After closing the report the Submission Complete message will

open.

6.15.2 Making Submissions

The submission files will be created in the same directory as the project database, and may be

transmitted to AFCEE from there. These files are preformatted and password protected,
compressed files so they can be easily loaded on diskettes for submission to AFCEE.
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6.15.2.1 PRIME PROJECT SUBMISSIONS

If a the end of submission validation there are no errors then ERPTools/PC will create one file
for each group being submitted. The PC submission files use the following naming
convention:

[ProjectName].ZG[submission number] (for example BrooksProject.ZG1).

These files are compressed and ready to submit. In addition to the media containing the
electronic copy of the file you need to include the signed first page of the Items of Interest
Report for each group submitted. Send these items to AFCEE.

6.15.2.2 LAB PROJECT SUBMISSIONS

If at the end of submission validation there are no errors then ERPTools/PC will create 3 files,
one for each group three table. The LAB submission files use the following raming
convention:

ProjectName_TableName. TXF (for example: BrooksLabh SAMPLE.TXF).

The only report a LAB project user will see during submission is an Error Report. If any
errors exist ERPTools/PC will not create any submission files. Send these three files to your
Prime contractor.

6.16 DISPLAYING SYSTEM STATISTICS

This option is unavailable unless a project is loaded.

To view reports about the open project open the Tools> View System Statistics menu and
select the option desired. For Report Preview technigques see Section 7.6.

6.16.1 List Local Methods Report

Selecting the List Local Methods Report option opens the Local Methods Report screen. This
report lists the contents of the local methods tables.

6.16.2 Change Local Methods Report

Selecting the Change Local Methods Report option opens the Change Methods Report screen.
This report details the differences between the local methods and the ANPARXREFtable.
6.16.3 Submission Status Report

Selecting the Submission Status Report option opens the Submission Status Report screen.
This report details the number of records in each table according tovalidation status. The
statuses include:

Designation Validation Status

NV Not validated

FR Field and Record Validated
SV Submission Validated

Figure 6-104 Validation Status Codes
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6.16.4 Changed VVLs Report

Selecting the Changed V'V Ls Report option opens the Changed VVLs Report screen. This
report details any changes made to the official AFCEE VVL lists.

6.16.5 Validation History Screen

Selecting the Vaidation History Screen option opens the Validation History screen. This
screen displays validation history for the active project and allows the user to delete history
records.

Select the Tools> View System Statistics> Vaidation History Screen option to open the
Validation History data entry worksheet.

H ErpTools/PC Validation History [_1T]=]
[ Tatle D ateLastyalidated] ValidationType | User =
1] ROUP 2 [TRIAL) |9/14./20 09,28 PM|SF A
I |5UBM GROUP 1 /1472000 1:52:52 PM | 5R A
[1}:] ROLFP1 /11,20 05:53 PM| SN A -
G| ROUP 3 1#11./20) 04:10 PM| SF Al
SUBM GROUP 1 9/11/2000 45700 PM| SF ADMIN
RO 8/25/2000 3:22: 28 PM|FR ADMIN
LTX 8/25/2000 316:58 PM| FR ADMIN
RSx 8/25/2000 31648 PM | FR ADMIN
RSP 5/25s 31636 PM | FR ADMIN
S| B/25/ 3
Do _ oo |

Figure 6-105 Validation History Screen

This screen will list all the validations performed on the project in chronological order.
Submission Types seen in the Validation History Screen include:

Designation Submission Type

FR Field and Record Validation

SF Full Submission

SN New Record (Partial) Submission
SR Resubmission

Figure 6-106 Submission Type Codes

The records on this worksheet are read-only, and may not be edited, but you can delete
records. To delete arecord, select the record and click the Delete button. A Delete Validation
warning will open.

Validation History Delete

@ Are you sure you wark ta delets this Yalidetion Histary record?

Figure 6-107 Delete Validation History Warning

Click Yesto delete the record, or No to close the warning without deleting the record.
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6.17 ERPTooLs/PC HELP

ERPToo0ls/PC features an extensive online help system. The Help file may be accessed
through the Help menu, or information about specific features may be summoned with the F1

key.

6.17.1 How to Usethe Help File
To open the Help screen select Hdp-> PCHelp.

& ERPTools/PC v.4 Help
File Edt Bookmak Optons Help

[_[O1>]

Help Topics  Back Pint Fields Tables B
(LA Conterts | €, Indes | @ Sesrch]
B/ FiEE

[E] AFCEE Support
@ Systemn Dverview
@ what's New inVersion 4
@ Setup and Configuration
&) Using ERPT ools/PC
- [£] Using ERPTodls/PC
- [2] Logging In
& Maintaining Users
@ Maintaining Valid Value Lists
@ Creating and Managing Praiec
@ Using Local Methods
- Importing and E porting Data
- Data Entry
B Validation
@ Submissions
&) Help and Technical Support
[E] How to Use the Help File
[E] How to Use the Help Con
~[£] How to Use the Help Inde
~[E] How to Use the Help Find
- [E] Interactive Help

[£] About ERPT ools/PT

The Air Force Center for Environmental Excellence
(AFCEE), is one of three service centers supporting
Al Force Major Commands (MAJCOMS) andl their
installstions in canducting Installstion Restorstion
Frogram (RF) remedial investigstions and feasbilty
studies. The objective of the Air Farce integrated P
s to assess past hazardous waste disposal and
spill sttes on Air Force installations and develop
remedial actions consistent with the National
Contingency Plan (NCF) for those sites which pose
3 threat to human hesth and welfare or the
environment. A1l aspects of the IRP must be in complisnce with provisions of Public
Lavw 96-510, the Comprehensive Environmental Response, Compensation and Liablity
At of 1980 (CERCLA) and Public Law 99-493, Superfund Amendments and
Reauthorization Act of 1985 (SARA); with Environmental Protection Agency
regulations; and with all applicabiz state laws and regulations.

IRP investigations and studies involve extensive fieldwork and the collection and
analysis of groundwater, surface water, sediment, sail, sir, socioeconomic and
ecological data. The Mission Support Computer (MSC) Division mairtains all data
collected in these efforts Alr Force wide inthe Environmental Resources Program
(ERP) Information Managemert System (ERPIMS). The Air Farce has directed ERPIMS
to be the certral database for the etire Air Force ERP. This data is utimstely used by
an in-house statf consisting of confract specislists, analytical chemists, biologists,
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@ Frogiam Maintenance
1 @ Techniques
5@ Menus and Toolbars

- @ Tables

<]i‘ Reference | _";I
Figure 6-108 Help Screen

hydrologists, environmertal engineers, civil engineers, and system analysts. The deta
will also be made available to personnel external to AFCEE

|| ERPTocksiPC has besn developed by AFCEE for distribution to contractors to assist
them in preparing ERPMS data submissions. The goal is the production of data fies
that accurately descrive ERP data

This Help File provides step-by-step operating instructions to end users of ERPTools/PC.

Help System Tabs
W contents Tab

&, Index Tab
# Find Tab

Help System Contents
# @ Closed Book
=40 Open Book
El Document
Figure 6-109 Help System I cons
Click the Help Topics button to open the Help Topics dialog. Select Contents (Book), Index
(Key), or Find (Binoculars).

If the Help Topics areais displayed, clicking the Help Topics button will hide it.
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6.17.1.1 HOW TO USE THE HELP CONTENTS TAB

The Help Contents tab contains a graphical table of contents for the ERPTools/PC Help

system.

1L Contents | €, [ndes| @ Sesrch |
R i CCE
. [Z] AFCEE Suppart
@ System Dverview
@ what's New in Version 4
@ Setup and Configuration
([ Using ERPT ools/PC
[] Using ERPT ocks/PC
Logging In
@ Maintaining Users
@ Maintaining Vaid Value Lists
@ Creating and Managing Projec
@ Using Local Methods
Importing and E xporting Data
Data Enlty
@ Validation
@ Submissions
- Help and Technical Support
+[£] How to Use the Help Fils
i+ ] How to Use the Help Con
i 2] How to Use the Help Ind=
i [E] How to Use the Help Find
i [5] Intersctive Help
i... 5] About ERPTools/PC
- Program Maintenance
o @ Techniques
@ Menus and Toolbars

o @ Tables

o @ Reference =
4] | »

Figure 6-110 Help Contents Tab
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W 1f the Help Topics areais hidden, click the Help Topics button to open it. Click on the

Open Book tab to show the Contents.

=@ Double click on a closed book icon, or single click on the plus icon beside it, to open the

book and reveal its contents.

=0 Double dlick on an open book icon, or single click on the minus icon beside it, to close

the book and collapse its contents.

~ElClickona page icon to open that page.
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6.17.1.2 HOW TO USE THE HELPINDEX TAB

& The Help Index tab contains a searchable index of ERPTools/PC keywords.

(01 Conterts G Index | @y Search |

Help

GwD -
Help Menu
How ta Caloulate Percent Recaver
How to Change Column Order
How to Change Column Width
Howi ta Change Row Height
Howi ta Create a New Record
How ta Cut
Copy, and Faste
How ta Delete Records -
How ta Edit Dats Fields
How ta Edit Drop Down Lists
How to Export Fitered and Sorted Resord
How ta Fiter and Sort Tables
How To Fiter Data
Howi ta Find and Rieplace
Haw ta Mave Worksheets
Hawi ta Print Previewed Fiecords
How ta Quick Sart
Howi ta Save & Recard
How ta Select 2 Field
How ta Select 2 Recard
How Ta Sart Diata
How taLinda

How to Use a File Didlog =
4| | >

Display

Figure 6-111 Help Index Tab
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If the Help Topics areais hidden, click the Help Topics button to open it. Click on theKey tab

to show the Index.

As you begin to type a keyword in the field at the top of the section, the index will scroll down
to find that keyword in the list. Click on a keyword in the list to select it and open the topic
associated with it. If there is more than one topic associated with the keyword, a dialog will
open ligting them. Click atopic in the list to open it.

6.17.1.3 HOW TO USE THE HELP FIND TAB

#% The Help Find tab alows the user to search for any word in the Help file.

10 Contents | €, Index @ Seach |

1, Type the wardls) you wish to find
Hef -

2 Select matching wards to nanaw search

3. Choose topic to display.

AFCEE Suppart
ATI

Displaing Syetem Stalisics
Ediing Vsl Valuss

Eqror Hessages

HEADDIF

Help and Tech Suppot Dptions

Help Meru

Fow to Change Flow Heioht

Fow o Lise the Help Cotaris Tab

How o Use the Help File

Fiow to L the Help Find Tab

How to Use the Help Indes Tab
Irteractive Helo ]

Figure 6-112 Help Find Tab
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If the Help Topics areais hidden, click the Help Topics button to open it. Click on the
Binoculars tab to show the Find area.

The first time you open the Find tab the Find Setup Wizard will assist you in setting up the
Find function. You will only have to runthis wizard once. If you want the capability to
search with phrases, select the Maximize option.

To find atopic first type the words you wish to find in the drop down list. The drop down
feature will keep track of recent words you have searched for.

As you type the words listed in the second, scrollable field will filter down. When you see the
word you want to find, click on it to select it.

Clicking on aword in the second field will limit the topics in the last field to the ones
containing that word. Click on atopic to select it and show that topic in the right pane.

6.17.2 Interactive Help

The F1 key calls interactive help screens from several different options. Clicking on a screen
and clicking F1 will call help for the screen. Some controls and fields have their own F1 help
topics. Information about error warnings is available when warning messages or dialogs are
open.

6.17.3 How to Use Help for Errors

ERPTools/PC error messages (see Chapter 9 Error Messages) contain text descriptions of the
errors encountered, eliminating the necessity of looking up error code numbers. If more
information is needed, selecting the error and clicking the F1 key will open the ortline help file
to the error, showing the cause of the error and the action necessary to correct it. The
General System Error message box contains the information necessary to correct program
coding errors.

6.17.4 Technical Support

To open the ERPTools/PC screen select Help> Tech Support. |f you are connected to the
Internet the ERPIMS Home Page will open in a browser window.
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B ERPTools <DATA> - [ERPIMS HOME PAGE] [_[=]x]
% Ele Ioos window Help

===
e o o o e e e o e e e = 2
il e <M NE)
Address
|hnp:uwww afcee. brooks. af. mil/ms/msc_im.htm |

AFCEE HOME | ORGANIZATIONS | SEARCH | PRODUCTS | PERSONNEL

ERFINS Home Page

Emviranmental Resources Program Information Management Systemn

The ERPIMS Help Desk can be reached tol-free at 1-877-ERPIMS3. Please call us if you need the FAX number andfor the e-
mail address.

Effective Novernber 15 1999, as has been indicated on this web page for the prior twelve months, AFCEE no longer supports
nor accepts data submissions prepared using ERPTools/PC versions 1.2 or below. As of 31 December, AFCEE will naither
support nor accept data submissions prepared with any version of ERPTools/PC below 3.0. See the ERPTools/PC page for

details. NOTE: Version 3.0 of ERPTools/PC includes a utility to convert data in version 2.x format to the latest (3.0)
format.

See the ERPTools/PC page for numerous downloads, including the most recent version of the ERPTools/PC software, the
ERPIMS Data Loading Handbook, and an array of other related documentation.

ERFIMS {formerly IRPIMS) is the Air Force system for validation and management of data from emviranmental projects at all Air
Force bases. This data contains analytical chemistry samples, tests, and results as well as hydrogeological infarmation,

Figure 6-113 ERPIM S Tech Support Browser Window

The ERPIMS website contains information about ERPIM S and ERPTools/PC, as well as
access to downloads of the latest information and software.

6.17.5 About ERPTools/PC
To open the About ERPTools/PC screen select Help> About ERPTools/PC.

ERPTools/PC About

~ Product In

Executable Version: 401 Distribution Date: 10-4pr-2000

Validation Rules Version: 04.02.0
Validation Rules Date: 01-lan-2000

Click To Change Registration Information: [~
Serial Number: 51023

Company Name: Fred Red's Med's Clinic

_ Close |

Figure 6-114 About ERPTools/PC Screen

The About ERPToo0ls/PC screen shows program and validation rules versions, distribution
date, and program copy information.

The screen also lets you change the Company Name entered when you installed ERPT ool s/PC.
Check the Click to Change Registration Information check box and the Company Name field
will become editable. Change the information and uncheck the check box.
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6.17.5.1 UPGRADING FROM AN EVALUATION INSTALLATION

If you entered an evaluation mode serial number of 99999 when you installed ERPTools/PC
the Serial Number field will also become active when you click on the Change Registration
Information check box. To fully register the program call the ERPIMS Help Desk (See
Section 1.2 AFCEE Support) for a serial number. Enter it into the field and close the screen,
and your copy of ERPTools/PC will be fully functional.

6.18 OPTIMIZING DATABASES
Admin users only. This option is unavailable if a project is open.

Optimizing the databases should be part of the routine maintenance program. Databases can
become corrupted, and during normal will continue to expand as records are added. The
project files do not automatically contract in size if records are deleted. Y ou should Optimize a
project file after you delete a large number of records. Optimization will help maintain project
databases in good condition. Databases should be optimized any time ERPTools/PC closes
ungracefully: a General Protection Fault that crashed Windows, the PC was turned off or lost
power while ERPTools/PC was running, etc. This procedure also repairs any damaged files.

To optimize a database close all projects, then select the Tools> Optimize Database option.
The Optimize Database file dialog will open.

ERPTools/PC Dptimize Database
Logkjn: | &3 Proiects Cll@lck  BE
Do
HewMDB
RicksErpimsProi2 MO
Second MDB
subriSuccess MDB
subrtest MDB
File pame: | Open |
Files of type: [ Database [“mndb) = Cacel

Figure 6-115 Optimize Database File Dialog

Select the database to be optimized and click the OK button. When the database has been
optimized a dialog will open confirming the success of the process.

ERPTools/PC EZ

Succeszfully optimized the C:\Program Files\PC4\Projectz\Mew MDB databaze.

Figure 6-116 Successfully Optimized M essage
Optimizing a database reduces the size of the database and insures maximum program

performance. For best results, project databases and the ERPIMSA.MDB, LAB4.MDB, and
REFINFO4.MDB database should be optimized regularly.
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6.19 ExiTing ERPTooLs/PC

The File-> Exit menu command or the Exit toolbar button serves a dual purpose. If you have
any screens open the File-> Exit or Exit toolbar button will close the active sareen. If all the
screens are closed these commands will allow ERPTools/PC to exit gracefully to Windows.
As with most programs, quitting without using the Exit procedure will corrupt the program
and files.

6.20 BACKUPPROCEDURE

To perform a backup, use an archiving or backup program to store your project datafilesin a
backup location. 1n addition, to backup your user accounts and VVLs, include the file
REFINFO4.MDB from the ERPTools/PC directory in the backup.

To restore from a backup, overwrite or replace the corrupted documents in your
ERPTools/PC directory with your restored backup file.
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7. TECHNIQUES

7.1 NAVIGATION SCREENS

7.1.1 How to Use a Selection Wor ksheet

. PC240: ERPTools Project Tables [x]

DESCRIFTION
Localion/Site Cross Reference

£ Site Cortamination FC205

Z0I Zane PC205

74 Localion/Zone Cross Rl FC207

MRl Map Reference PC204

Wl wel PC203

WINT well Constiuction Interval FC206

I wiell Maintenance PC203

LTD Lithologic Description FCZ14

STU | Sratigraphic Unit FC212 =]

Selest | T Canca ]|

Figure 7-1 Typical Selection Worksheet

A Selection Worksheet is a worksheet used to select and open a Data Worksheet from a list of
available worksheets. Select the worksheet required and click the Select button.
ERPTools/PC will open that Data Entry Worksheet.

7.1.2 How to Use a File Dialog

ERPTools/PC Local Methads Export HE
Savein |3 Data RN =z =
aood dfitered2 TAT Simport it
1Z] Lditst Idifilered2 TXT Timport tst
5] 11 =T Idifikeredd TXT WA TRT
2] iz TRT lacmeth1 TKT wWIZTRT

2] 16i3.T<T Rickldi, TXT I3 TRT
1Z] idffilered. TXT Rimpart.tat

Save as type: [Tex Files = Carcel

Figure 7-2 Typical File Dialog

Several ERPTools/PC commands open a Windows File dialog that allows you to select a
database or text file. Navigate to the directory where the file is stored. Then click on the file
to select it for the File Name text box and click “OK,” or double click on the file name. Thisis
the standard Windows file dialog and provides all the standard functionality. Some of the file
dialogs will aso include afile preview feature.

7.2 MESSAGE BOXES
ERPTools/PC uses severa types of pop-up message boxes.
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ERPTools/PC =]

Successtully optivized the C:\Program Files\PC4\Projects\New DB database

Figure 7-3 Typical Process Status M essage

Process status message boxes notify you of the status of the process. These message boxes
require you to click a button on the box to continue.

ERPTools/PC ]

@ Result records for 2 Test records were inserted on 14-8ep-2000 13:56

Do you want to see the inserted Resul records now?

Yes Ho

Figure 7-4 Typical Information M essage

Information message boxes notify you that an action is complete, and may offer a choice of
actions.

ERPTools/PC

Some of the recards in the selected submission group have not been validated. Please
validate thess records before attempling to create a submission

Figure 7-5 Typical Error Message

Error message boxes notify you of an error condition. These message boxes require you to
click a button to continue.

ERPTools/PC =]

& el et ep e e erario oA Ao rets Ammmarniisis

what you want to do?
= 3

Figure 7-6 Typical Warning Message

Warning message boxes issue awarning and may ask you to confirm the action about to be
taken.

ERPTools/PC B

Are you surs you wouldlike ta ancel the YL Import peratior? Cancsling the impat wil
leave the WL table in an invalid state.

Figure 7-7 Typical Decision M essage

Decision message boxes explain a situation where you must choose from more than one
possible course of action to continue.
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7.3 How 1o UseE DIALOG SCREENS

Find |
Find
Replace I
Match B Find Hext
’7(-' ‘whols Field ¢ Start of Field " Any Part of F\eld|
Repla
Close
Replace All

Figure 7-8 Typical Dialog Screen

Diadog screens contain fields to hold the entered values. These include text fields, drop down
lists, check boxes, and radio buttons.

7.3.1 How to Usea Text Field

Text fields hold vaues that are not limited to a few valid choices, for example passwords.

Mew Pagzword: ||

Figure 7-9 Typical Text Field

To enter avaluein atext field, either tab into the field or click on it to insert the cursor. Then
type the value you want to enter. Pressing the Tab key will save the value and advance to the
next field. Clicking on another field will save the value and move the cursor to the new field.

Most fields are restricted as to what kind of value is acceptable. Date fields are a typicd
example, and will produce an error if you attempt to enter something besides avalid date.
7.3.2 How to Use Drop Down Lists

Drop down lists limit a field to a choice of one value in alist of valid values, for instance the
list of AFIIDs.

AFID IAE.-‘-‘-.DM vI AFID

AlR FORCE ACADEMY

MHame | ]
AIR FORCE ACADEMY —
AFP MO, 3TULSA

AFF MO, 4FT WORTH

AFF MO, B MARRIETTA
AFP MM 19 S4R MIFGEN ;I

Figure 7-10 Typical Drop Down List

Click on the down arrow to the right of the field to open the drop down list of values. If you
start typing the value you want in the field the list will scroll downto find the first instance
matching what you have typed. You can also scroll down using the vertical scroll bar.

Once you find the value you want to record, click on it. The drop down list will close, and the
vaue will be placed in the field.
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7.3.3 How to Use Check Boxes

Check boxes allow you to select atrue or false response to an item, depending on whether
they are checked or not.

¥ Include UFUSER and LUPDATE fields.
Figure 7-11 Typical Check Box

Click on a check box to change its value. If it contains a check mark it means you want the
statement to be true. If the box is empty, clicking will check it. If it is checked, clicking will
empty it.

7.3.4 How to Use Option Buttons

Option buttons allow you to sdect one of several vaues.

tatch By
’75' “Whale Field ¢ Start of Figld Ay Part of Field

Figure 7-12 Typical Option Buttons

Option buttons come in a set, and you can only select one at atime. Click on the option
button you want to select and a dot will appear in it; while the remaining options are
desel ected.

7.4 DATA ENTRY WORKSHEETS

The Data Entry worksheet is the heart of ERPTools/PC. Data Entry screens hold spreadsheet
type worksheets. Each worksheet displays all the records of a database table, alowing you to
manipulate and edit records. Worksheets are set up in table format with each row representing
one record and each column representing a record field.

=% PC201: Location [LDI) Data Entry

[ [ RECNO[LOCID LTCCODE LPRCODE NCOORD ECOORI=
» 102[ fbtaT v N 223
03[ BAc62 v N 4320
10468083 v N 34211
E—EllAAAAASD A N ﬂ
100[ 84464505 v N ]
HjLAAADDD Al N 342
S6(BEE Al 2
S7|CCCC Al s 2
101\ ZZ7778D520508 (&Y N 123327‘
* \
[l ,
14] 4[Record 20t 10 I

Figure 7-13 Typical Data Entry Screen

Fields that cannot be edited are colored blue. These include record number, date updated, user
updating, validation status, and submission date. The current record is shown by atrianglein

PAGE 93



F41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

the record selector button to the left of the record, which changes to a pencil while the record
isbeing edited. A new record is shown by an asterisk in the record selector.

Below the worksheet is a havigation bar with buttons that allow you to select the first,
previous, next, or last record in the dataset. The center of the bar displays the number of the
active record and the number of records in the set. If the records are filtered the orange Filter
warning will be displayed below the right end of the navigation bar. If the filter warning is
displayed, you can right click on it to see what the actual filter is.

More than one worksheet may be open at atime, limited by available computer memory.
These screens may be resized by dragging the edges or corners with the cursor.

7.4.1 How to Move Worksheets

Y ou can move worksheets within the Main screen to make it easier to see more than one of
them. Click on the title bar and drag the worksheet to the desired location.

7.4.1.1 HOW TO CASCADE WORKSHEETS

Click the Window-> Cascade menu command to cascade the worksheets.

B ERPTools <ADMIN> <New.MDB> <NEW PROJECT> <KNGSN> <F12345-00-A-6789-01> ME E

Fie Data Edit Recod Took Window Help

W] (%5 213 Elm| B XX #]-| S|E| s

=2 PC204: Map R ence (MRI) Data Entiy

=i ference [ZLX) Data Entry

e Cross Reference [5LX) Data Entry
& PC201: Location (LDI) Data Entry
RECNO[LOCID: LTCCODE
G WT

LPRCODE
[

7272 WT

738k WL 3
95| bAAA Y 2
102|dteat Y 273
103 pbeA2 Y 3432
104[ 68843 £l 34201

93 A8AAASD Y 34|

224
342

535599 Bﬁaﬁﬁifill
»

L]

100| AddsASDE A
98| AsAADDD A
74[ABC WT

SEEEEEEE

M| 4|Record 1af 16

Figure 7-14 Cascaded Worksheets

The worksheets will cascade in the order they were last accessed, with the newest on top.

7.4.1.2 HOW TO TILE WORKSHEETS
Click the Window->» Tile Vertical menu command to tile the worksheets in up and down rows.
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B ERPTools <ADMIN> <New MDB> ¢<NEW PROJECT> <KNGSN> <F12345-00-A-6789-01>
File Data Edt Record Took Window Help

HE]E

| 8w 22 mle 8 AxX] o SE] e
wf PC201: Location (LDI) Data E... [ 3 |25 PE205: Site Eontamination (5 1 [=] 3| | == PE207 Location/Zane Cross - M [=| £
LTCi = RECNO]GROUPCODE SITE RECNO[ZONEID LOCID

J #] \ \ #]

L1l

| | o o | L

Bl

4] 4|Record 1of 16

(31 4| 4| New Record (31

| 4Mew Record

|

RECNOD SITEID|LOCID

=ia PC202: Location/Site Cross R_.. 8] [ || = PC206: Zone [ZDI) Data Enuy IS EA || = PC204: Map Reference (MRI)... ISl EX

RECNO|MAPRID MAPCOI

RECHO|ZOMEID ZNAME

* * *
Ll | | el | KN |
H[4]New Record » [ H[ 4] New Resard » ol W[ 4] Wew Resord » ol

Figure 7-15 Worksheets Tiled Vertically
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Click the Window- Tile Horizontal menu command to tile the worksheets in side to side rows.

B ERPTools <ADMIN> (New.MDB> <NEW PROJECT> <KNGSN> <F12345-00-A-6789-01>
Fie Data Edt Hecod Iook Window Help

[_[=]x]

W] B8 7w 2z el 5 HxX] 2= SlE] &

= PC206: Zone [ZD1) Data Entry _{olx]

RECNO|LOCID LTCCODE LPRCODE = RECNO|ZONEID ZNAME ONEDESC
y GG I — * | |
72|22 [
7ala6s [ had
Ll Ll_l o= | i
M| 4|Record 1of 15 M M| 4 [New Recod (A1)

RECHNO SITEID|LOCID

GFCCODE SF RECNO|ZONEID LocID

WALSTATUS

4] 4| New Record

* \ | * \ \
4| | | Ll o
[ 4 [New Record [AI]] W] 4 [Mew Record [AI]]
= PC205: Site Contamination (SCC) Data Entry =l ES |[ = PC204: Map Reference (MRI) Data Entiy O]
RECHNO|GROUPCODE SITEID|YALSTATUS RECHNO| MAPRID MTCCODE
* \ | | * \ \
4| | | Ll o
a3 | 4 |New Record »IM

Figure 7-16 Worksheets Tiled Horizontally

7.4.2 How to Select

7.4.2.1 HOW TO SELECT A FIELD
To sdect afield click onit. All the datain the field will be selected. Typing a new entry will

overwrite the old entry.
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HCOORD
2

—

2431

Figure 7-17 Selected Cell

To change an entry click twice. The entry will reverse color and the cursor will become an I-
beam. Click next to the character to be edited, backspace or delete, and enter the new
character.

NCOORD
2

225
34321

Figure 7-18 I nsertion Point

If the field selected contains data subject to a valid vaue list the VVL arrow will appear.

LTCCADE
A

o

Al

Figure 7-19 Selected VVL Cell

Note: Fields with a blue background are read-only, and cannot be selected. Fieldson
the View VVL Data screen and Validation History screen are also read only, and cannot
be edited.

7.4.2.2 HOW TO SELECT A RECORD

To select awhole record move the cursor al the way to the left of the screen, until it becomes
aright arrow. Click on the record to be selected.

Figure 7-20 Selected Record

7.4.2.3 HOW TO SELECT MORE THAN ONE RECORD

To select more than one record select the first record, then hold the CTRL key down while
selecting subsequent records. Clicking on a selected record while holding the CTRL key down
will unselect it.
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B

104 [ A0843 A

s A

100

Figure 7-21 Multiple Selections
To select a number of adjacent records click the first record, then hold the SHIFT key down
while clicking the last record in the set. All records between the two will aso be selected.

Note: Records on the View VVL Data screen are read only, and cannot be selected.

7.4.2.4 HOW TODESELECT ALL RECORDS
The Record->Desdlect All option or Deselect All toolbar button leaves all records unselected.

7.4.3 How to Change Column Order

To change the order of columns click on the column header to select the column you want to
move. Click on the header again, and a copy of the header will appear under your cursor.
Two red arrowheads will appear on the left side of the column head. Drag the cursor right or
left until the arrowheads are where you want to insert the column you are moving.

& PC201: Location (LDI) Data Entry

RECNO LTCCODE
1 W T

7222
73| hkk
ES

02| fbtal

03[ BAc62

10468083
E—EllAAAAASD

100) fe8885D5
88| adaaDDD
74/ BB

LPRCODE

WNCOORD!

ECOORI -
£ [CCODE 7

223
34321
34

34
234)

342
EEEEEET aaaaﬂifiﬂ
»

4

4] 4 |Record 10f 16 L3I

Figure 7-22 Moving a Column
Note: When you close the screen the columns will return to their default order.

7.4.4 How to Change Column Width

To change column width place the cursor over the right boundary of the header of the column
to be changed and wait until the cursor converts to atwoheaded arrow. Click and drag the
boundary to the desired width.
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& PC201: Location (LDI) Data Entry
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Figure 7-23 Resizing a Column

Note: When you close the screen the columns will return to their default width.

7.4.5 How to Change Row Height

To change row height place the cursor over the bottom boundary of the record selector to be
changed and wait until the cursor converts to atwo-headed arrow. Click and drag the

boundary to the desired height. Unlike columns, row height is the same for al rows. Making
the height of one row larger or smaller changes al the rows.

=% PC201: Location (LDI) Data Entry o =] B3
RECNO[LOCID LTCCODE LPRCODE NCODRD! ECOORI«
71 WT 1 7 7
7222 W 1 7
73| haA Wil 1 3
3 5| hhAk A N H
T 7 m =
03| AkkA2 &Y N 34321
104|843 A N 34211
5[ BAARESD A N El]
100[£AA8LSDS A N 23|
98|£4AAD00 &Y N 312 fi
74 4BC W 1 9333393 3333333
75[£BD WT T z
95(BEB B
Al

I4] 4|Record 4of 18

hd|
M
|

Figure 7-24 Changing Row Height

7.5 EDITING FUNCTIONS

Editing functions are found in the Edit menu and the Toolbar.

7.5.1 How to Create a New Record

Select the Record-> Goto> New option to create a new row in the datasheet where a record
can be added. You can aso create a new record by clicking the Add New Record toolbar

button, or by Tabbing out of the last editable field in the last record of a datasheet. The new
data row is marked with an asterisk in the record selector.

Figure 7-25 New Data Row
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7.5.2 How to Save a Record

The Record-> Save Record option and the Save Current Record toolbar button writes the
values in the current record to the database. Y ou aso save a record whenever you leave it and
select another record.

Note: Once you save a record you cannot Undo the editsin the record.

7.5.3 How to Cut, Copy, and Paste

The Cut option removes the selected item, while copying it to the Clipboard. The Copy option
copies the selected item to the Clipboard, but does not remove it. The paste option inserts the
item stored in the Clipboard into a record at the insertion point.

You can cut or copy al or part of the value in any editable cell, or a complete record. If you
copy from a cell the value can be pasted into acell. If you copy arecord and paste, the
record will be added as a new record at the end of the current worksheet. Y ou can only paste
records into the same table they were cut or copied from.

7.5.4 How to Undo

The Undo option reverses unsaved edits in the current record and returns it to a pre edit state.

7.5.5 Entering Data

The current existing record will be identified by atriangle in the row’s header. A new record
will have an asterisk in the record selector.

When arecord is in the process of being edited the triangle will change to a pencil.

RECNO[LOCID LTCCODE
7 102[a8ad] A
103]aAAA2 A

Figure 7-26 Typical Record Being Edited

Enter records by typing the correct value into eachfield or selecting a value from a drop down
list. Usethe TAB key to advance to the next field.

7.5.5.1 HOW TO EDIT DATA FIELDS

I Tarmm 0

Figure 7-27 Typical Data Entry Cell

When you click on acell or Tab into it any textin the cell will be selected. Use your keyboard
to enter the new value. Pressthe Tab key to move to the next cell.
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7.5.5.2 HOW TO EDIT DROP DOWN LISTS

T - 01-JAN-1998|HCS )

Code Mame |«]
= | Tk Fix Loc Aeceptacle Including Tanks, Containers and'¥a = —
; TF Test Fit -
W WASTE WATER TREATMEMT FACILITY |

Wil Wwell

Wetlands/Swamp
WS Waste Water j

Figure 7-28 Typical Drop Down List

To select avalue for a drop down list click on the arrow on the right of the cell, then click on
the value to be entered. If you type the first several letters of the value the drop down list will
scroll down to the first value that matches what has been typed. Y ou can also use the Alt-
Down Arrow key to display the drop down list.

7.5.6 How to Delete Records

The Delete option removes one or more selected records from the table.  The Delete All
option removes al displayed records from the table.

Warning: Unlike most Windows programs, database programs like ERPT ools/PC have
no Undo procedure for restoring deleted records.

7.5.6.1 HOW TO DELETE SELECTED RECORDS

Note: You must select one or more completerecords. Selecting a cell, or entering the
record by tabbing, etc. will not select the record. Attempting to delete records without
selecting at least one will open a message stating that no records ar e selected for
deletion.

First, select the row or rows to be deleted. Select the Record-> Delete Selected menu
command or click the Delete Selected Records toolbar button. This opens the Delete
Confirmation warning telling you how many rows are about to be deleted, and asking if you
want to continue.

ERPTaals B

@ 1 10w will be deleted! Continue?
G o

Figure 7-29 Delete Confirmation Warning

Click the Y es button to delete the records, or No to cancel the deletion. If the table is a parent
then an additional message will be shown asking you if you want to delete all the child records.
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The application does not check if any child records actually exist but if the table is a parent
table in a parent-child relationship.

ERPTools/PC =]
@ Would you lice to delets all childien associated with the racords being deleted?
] o b

Figure 7-30 Delete Children Warning

Clicking “Yes’ deletes the selected records and al child records in linked tables A message box
will open confirming the number of rows deleted. Click OK to closeit.

7.5.6.2 HOW TO DELETE ALL RECORDS

Warning: Unlike most Windows programs, database programs like ERPTools/PC have
no Undo procedure for restoring deleted records.

If you want to delete al records in a table, make sure al records are visible and the table is not
filtered.

When the records in a table have been filtered, the Delete All command deletes only the
records visible, leaving in the table the records that were filtered out. To delete a portion of
the records in atable, first use the filtering procedure to filter out the records that should
remain.

The Record-> Delete All menu command or toolbar button opens the Delete All Confirmation
Dialog Box.

ERPTools

All 5 records in the Location table wil be deleted if this operation is continued. ‘Would you
lie to delete all records?

Figure 7-31 Delete All Warning
Clicking “Yes’ deletes al records currently shown in the table unless there arechild records in
linked tables. If there are, the Delete Children warning will appear.

ERPTools/PC

@ “wiould you like to delete all children associated with the records being deleted?

= 7

Figure 7-32 Delete Children Warning

Click OK to delete al the records. A warning will open telling you how many rows were
deleted.

Note: The Optimize Database procedure compresses ERPTools/PC databases to their
smallest physical sizein the hard disk. ERPTools/PC project databases should be
optimized any time a number of records are deleted.
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7.6 PREVIEWING, SAVING, AND PRINTING REPORTS

All the reports in ERPTools/PC, except for one report from the Data Entry screen, are
displayed or previewed using the Report Preview screen.

&. Report Preview
Eile

B &t @@l |G al”

List of VVL Changes for NEW PROJECT Projec

VWL NAME: ANPARXREF DESCRIPTION: Analytical MethodiAnalyte Cross Reference

AHMCODE | MATRIX PARLABEL UPUSER UPDATE

625 W YR RICK 24-5ep-1958 =

== W poEInie RICK 24-5ep-1999

Ee= W ooz RICK 24-5ep-1938

Ee= W poBizez RICK 24-Sen-1958

Ee= W poeti2es RICK 24-5ep-1999

= W popizsd RICK 24 Sen-1958

Ee= W [poBizEd RICK 24-5ep-1993

= N RICK 24-5ep-1958

= W PHZAGER RICK 24 Sen-1958

e W pHaF RICK 24-5ep-1999

o= e ) & T S a9a =
] .

Figure 7-33 Typical Report Preview Screen

7.6.1 How to Preview a System Statistics Report

Open the Tools—> View System Statistics menu and select the report you want. The menu
contains the List Local Methods report, the Changed Local Methods report, the Submission
Status report, and the Changed VVLs Report. The Report Preview screen for that report will
open.

7.6.2 How to Preview an Error Report

With an Error Editor screen open, select the File=> Preview Error Report option or click the
Preview Error Report button. A Report Preview screen will open showing the errors for that
table.

7.6.3 Using the Report Preview Screen

The Report Preview screen opens over the ERPTools/PC screen, and has its own menu.

7.6.3.1 HOW TO PREVIEW A REPORT

Use the toolbar buttons to zoom in and out, navigate to the next or previous page, or select the
last page viewed. The zoom drop down list lets you select a specific resolution.

The Contents button opens a Contents area on the left side of the Report Preview screen.
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. Report Preview

File
B & aafn: =gl « Bl > roned
Cantents 4|
L04-FLD - C!
- LO7-FLD -DR
- L11-FLD -EL
& L15-FLD-E5
T L19-FLD -Ex
- L22-FLD - L o
[ L2g-FLD - LTI LDI Validation Ert
L38-FLD - DE ) - )
S| L45-REC-E The following LDI recards have failed Field and Recard validation
= L55-FLD - LPI BUEID EELD SEVERITY MESSAGE |
LE3-FLD -CR
LE2 - FLD - ELI Lo4 CMCCODE ERR CMCCODE is not & valid code.
L72-FLD-5T k Key Fields |
- L73-FLD - 5T) RECHO  LOCID CMCCODE
B L74-FLD-UT 40 ceee
- L8e-REC-O
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E L93-REC-EL RULE ID FIELD SEVERITY MESSAGE
T L9%-RECEL L7 DRLCODE ERR DRLCODE is not & valid code
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RECNO LocID DRLCODE
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BULE D FIELD SEVERITY MESSAGE -
i ok | O

Figure 7-34 Report Preview Screen Showing Contents

The Contents area lists the sections of the report. Click on a heading © scroll to that part of
the report. Y ou can make the contents area wider or narrower by moving the border with
your cursor. If you point the cursor at the icon to the left of an item, the program will show
you a Screen Tip with the complete title of that item.

o %LM-FLD-E I

LO7 - FLD - DRLCODE i not a valid code. |
= L1 -FLD -ELC

Figure 7-35 Typical Screen Tip
Some reports may not have a contents table.

7.6.3.2 HOW TO SAVE A REPORT

You can save areports in two formats, Acrobat *.PDF files or Rich Text Format *.RTF files.
Select the type of output on the Report Preview File Menu. A file dialog screen will open so
you can select the destination and name of the export file. Click Save to export the report.

7.6.3.3 HOW TO PRINT A REPORT

To set print options without printing, select the File= Printer Setup option to open your Print
Setup screen. Set page layout options and select the printer to send the report to. To print the
report, select the File-> Print option to open your Print screen. In many cases the two screens
will be almost identical.
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Print [2]x]
~Finter
Hame 2 Propeties

Status:  Default printer; Ready

Tope:  HP Laserlet 55i

where:  WMILLENNIUMHP_Ssi

Comment I Pint ta fils

P rang Capi

a4 pages Number of copiss 1 =
@ Pages pom[l [t
Cancel

Figure 7-36 Typical Print Dialog Screen

Click OK to print the report.

PAGE 104



FA41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

8. MENUSAND TOOLBARS

The ERPTools/PC toolbar is standard throughout the program, but some of the menus are only
visible under certain conditions. Toolbar buttons and menu options may be grayed, and
unavailable, under some circumstances. Some options are disabled unless an Admin user is
logged on.

8.1 MAINMENU
The Main Menu is available on the ERPTools/PC Main screen.

8.1.1 Main Menu Toolbar

Once the username and password are validated the ERPTools/PC Main Window opens.

¥ ERPTools <ADMIN> - (O] x|
File Tool: Window Help

R EEE T E R EEREENECINEE
Figure 8-1 Main Menu

If no project is open the screen displays the username of the current user in the title bar. The
menu bar contains the Application menu, File menu, Tools menu, Window menu, and Help
menu. Only the EXit toolbar button is active.

8.1.1.1 MENU BAR WITH OPEN PROJECT

When you open a project the project information appears on the title bar.

B ERPTools <¢ADMIN> <New.MDB> <NEW PROJECT> <ACADM> <F12345-00-A-6789-01> [H[=] E3

File Data Took Window Help

RO R E R EEEEEEETERE
Figure 8-2 Menu With Open Project

When a project is open the Data menu is included on the menu bar.

8.1.1.2 MENU BAR WITH OPEN SCREEN

When you open a data entry screen toolbar buttons become active.

H ERPTools <ADMIN> <New MDB> <NEW PROJECT> <ACADM> <F12345-00-A-6783-01> [Hi[m] E3

File Data Edt HBecord Tools ‘Window Help

W s Bl a3 w1l fx[X] #<] slB] By
Figure 8-3 Menu With Open Screen

When a data entry screen is open the Edit and Record menus are included.
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8.1.1.3 TOOLBAR BUTTONS

il i [ 2

:D_q
=
=]

REEmwm 5 ¢ XlkB B | k=

Close closes ERPTools/PC or the currently active screen.

Find opens a Find dialog to search for values.

Replace opens a Find and Replace dialog to replace one value with another.

Edit Filter opens a Filter dialog to select criteria for filtering or sorting the current dataset.
Show All Records removes all applied filters and sorts for the current dataset.

Sort Ascending sorts the current dataset in ascending order by the seleced field.

Sort Descending sorts the current dataset in descending order by the selected field.

Copy Cell/Record Copies the contents of the currently selected cell or record to the
Windows Clipboard.

Paste Cell/Record Replaces the contents of the aurrent cell or record with the contents of
the clipboard.

Save Current Record Writes the current record to the file.
Add New Record adds a new, empty record at the end of the dataset.

Delete Selected Records removes all visible, selected records, and their child records,
from the dataset. This process cannot be undone.

Delete All Records removes all visible records, and their child records, from the dataset.
This process cannot be undone.

Deselect All Records returns all records in the current dataset to unselected status.

Undo Current Edit/Add returns the contents of the current record to the values presently
in the database.

Print Current View prints the records in the active data screen as filtered and sorted.
Preview Error Report prints the errors shown in an Error Editor screen.
Vdidate Current View

Export Current View
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8.1.2 Application Menu

B ERPTools <ADMIN>

Restore d
Move B
Size

Minimize
M aximize

Cloze  Alt+F4

Figure 8-4 Application Menu

The Application Menu, opened by clicking on the application icon in the upper left corner of
the window, provides commands for manipulating the Program Window, and duplicates the
actions of the Screen Control buttons. The shortcut key to open the Control Menu is[ALT +
SPACEBAR].

Restore - Restores the window to its last intermediate size after it has been minimized or
maximized.

Move - Moves the window on the computer screen. This option can be used to move a
window down with keystrokes if it opens too high to drag it using the title bar. Open the
menu using the shortcut [ALT-SPACEBAR]. Pressthe M key to select the Move option,
then use the keyboard [DOWN ARROW] to move the window down. Press ENTER to
place the window.

Size - Resizes the window by moving the right or bottom edge. Open the menu using the
shortcut [ALT-SPACEBAR]. Pressthe S key to select the Size option, then use the
keyboard arrow keys to move the window edges. Press ENTER to place the window.

Minimize - Minimizes the window into an icon at the lower edge of the screen.
Maximize - Expands the window to fill the monitor screen.
Close- Closes ERPTools/PC.
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8.1.3 FileMenu

B ERPTools <ADMIN>

AR Tool: wWindow  Help
LCreate Project
Open Project
Edit Project

Cloze Project

Delete Project

Print Current YWiew
Preview Enar Report

1 - C:A\Program FilesPC4%ProjectsiLab_FRY alidation DB
2 - C:MProgram Files\PC44\Projects\Success. MDE

3 - C:\Program FilesPC4\ProjectziLabSubmizzion. MDE

4 - C:\Program FilesPC4\Projectzi\MNew DB

E xit

Figure 8-5 File Menu, Startup Screen

The File Menu displays the following options:
Create Project - Creates a hew project.
Open Project - Opens a selection screen where you can select a roject to open.

Edit Project - Opens the Edit ERPTools Project Information dialog so you can change a
project’s identifying information.

Close Project - Closes the open project.

Delete Project - Opens the Project Delete file dialog screen so you can choose a project to
delete.

Print Current View - Allows you to print the data from the current screen, as filtered and
sorted.

Preview Error Report - Allows you to print an error report of the data from the current
screen, as filtered and sorted.

A list of recent Projects- A shortcut list of the last four projects accessed. Click one of
them to open that project.

Exit - Logs you off, and allows ERPTools/PC to exit gracefully to Windows. As with
most programs, quitting without using the Exit procedure will corrupt the program and
files.
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8.1.4 Data Menu
The Data menu is only available when a project is loaded.

B ERPTools <ADMIN:

Drata Entry
Error Editar

Setup Default D ata
Jze Default Data
Create Defaulk Besulkz

Impaort Data
Export [ata
Load AFCEE Supplied D ata

Field & Record W alidation
LCreate Submizsion

Figure 8-6 Data Menu

The Data Menu displays the following options:

Data Entry - Opens the Project Tables selection screen so you can select and open a data
table.

Error Editor - Opens the Error Editor screen.
Setup Default Data - Opens the Setup Default Data screen.

Use Default Data- When this option is checked default values will be loaded into new
records. Uncheck it to create new records without default data.

Create Default Results - Opens the Create Default Results screen so you can create default
results for records that have local methods.

Import Data - Allows you to open a data table and select data which you can then import to
the table.

Export Data - Allows you to create a text file and export the data from atable to it.

Load AFCEE Supplied Data- Allows you to select a file of AFCEE supplied data and load it
into a project.

Fiedld & Record Validation — Allows you to perform Field and Record validation on one or
more data tables.

Create Submission - Allows you to validate data and export it into four secure files for
AFCEE submission.
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8.1.5 Edit Menu

The Edit menu is only available when a worksheet is open.

APTool: <ADMIN:

Data WX Record Toolz Window Help
Cuit

Copy
Paste
Undo

Find
Replace
Filter
S Al

Walidate Current Yiew
Export Current iew
Calzulate Percent Recovery

Figure 8-7 Edit Menu

The Edit Menu displays the following options:
Cut - removes the selected text from the record, while copying it to the Clipboard.
Copy - copies the selected text to the Clipboard, but does not remove it.
Paste - inserts the text in the Clipboard at the insertion point.
Undo - reverses the last action taken.
Find - searches for records with data that matches the search criteria.
Replace - substitutes a new value for the one found.
Filter - limits the display of records in atable to those records meeting the filter's criteria.
Show All - Removes all filters and displays all the records in the table.

Validate Current View - Applies cdll, record, and table validation criteria to the records
displayed in the current record and lists errors.

Export Current View - Allows you to create a text file and export the data in the current
window to it.

Calculate Percent Recovery - Automatically calculates percent recovery for records on the
Result table in Lab projects. Y ou can select whether to calculate all records, or only those
with Null values in percent recovery.

PAGE 110



FA41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

8.1.6 Record Menu

The Record menu is only available when a worksheet is open.

bl <ADMIN>
Edit Wafzhla@ Toolz:  Window

Select Record
Select Al
Dezelect Al

Delete Selected

Delete Al

Save Record

Goto k
Cluick Sort k

Figure 8-8 Record Menu

The Record Menu displays the following options:
Select Record - Selects all fields in the current record.
Select All - Selects al records displayed in the current table.
Desdect All - Removes selection from all records in the current table.
Delete Selected - Ddetes the selected records in the current table.
Deete All - Deletes all records, as filtered, in the current table.

Save Record - Writes the current values shown in the cells of the current record to the
database.

Goto> - Opens the Goto menu.
Quick Sort> - Opens the Quick Sort menu.
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8.1.6.1 GOTO MENU

The Goto menu is only available when a worksheet is open.

Iz <ADMIN> <New MDB> <NEW PROJEC

Edit PRGN Tool: *Window Help

Select Record
Select Al
Deselect Al

Delete Selected

Delete Al
Save Record
BT
Cluick Sort r Previouz
Mext
Last
e

Figure 8-9 Goto Menu

The Goto Menu displays the following options:
First - Selects the first record shown in the table, as sorted.
Previous - Selects the record shown before the current record in the table, as sorted.
Next - Selects the record shown after the current record in the table, as sorted.
Last - Selects the last record shown in the table, as sorted.

New - Adds a new row at the end of the table where values for a new record can be
entered.
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8.1.6.2 QUICK SORT MENU
The Quick Sort menu is only available when a worksheet is open.

hls <ADMIN>
Edit QRN Tool: ‘wWindow Help

Select Record
Select Al
Dezelect Al

Delete Selected
Dielete &l

Save Record

Goto r
Cluick Sort Sort Azcending
Sort Diescending

Figure 8-10 Quick Sort Menu

The Quick Sort Menu displays the following options:
Sort Ascending - Sorts the records visible in a table by the values in the current column,
with the lowest value first.

Sort Descending - Sorts the records visible in atable by the values in the current column,
with the highest value first.

8.1.7 Tools Menu

Record MEEER Window Help
Uszer b aint 4
WL b aint »
Local Methods Maint — #

YWiew System Stahzticz #

Optimize D atabaze

Figure 8-11 Tools Menu

The Tools Menu displays the following options:
User Maint> - Opens the User Maint menu.
VVL Mant> - Opensthe VVL Maint menu.
Local Methods Maint> - Opens the Local Methods Maint menu.
View System Statistics> - Opens the View System Statistics menu.
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Optimize Database- Allows you to select a database and optimize it.

8.1.7.1 USER MAINT MENU

BDMIN >

Record K Window Help
Aaint Edit Uzer Azcounts r

WL b aint k Change Paszword
Local Methods Maint — »

Yigw System Statistice  »

Dptimize D atabaze

Figure 8-12 User Maint Menu

The User Maint Menu displays the following options:

Edit User Accounts - Allows an Admin user to edit the information in user accounts.

Change Password - Allows you to change your own password.

8.1.7.2 VVL MAINT MENU

iPTool: <ADMIN: <Mew.MDB> <NEW PROJECT:> <KNGSHN

Data WENER window Help

zer Maint k I

WL M aint Wiew WL Data

Local Methods Maint — # Edit WL Data

Impart AFCEE %L Data
Create WL List

Wiew System Statiztice »

Optimize D atabase |

Figure 8-13 VVL Maint Menu

The VVL Maint Menu displays the following options:

7 JuLy 200

View VVL Data- Opens a selection screen where a user can open a VVL table and view

the records.

Edit VVL Data- Opens a selection screen where an Admin user can open aVVL talde and

edit the values.

Import AFCEE VVL Data- Opens a selection screen where an Admin user can select

AFCEE datato add to a VVL table.

Create VVL List - Opens afile dialog screen where an Admin user can aeate a text file and

export the valuesin a VVL table. This data cannot be imported to the VVL table.
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8.1.7.3 LOCAL METHODS MAINT MENU
Admin users only. The Local Methods Maint menu is only available when a project is |oaded.

MO MMz

Becord MKl "indow Help

Uzer kaint r
WL b aint 3
Local Methods Maint — » Edit Local Methods
Import Local Methods
Export Local Methods

Wiew System Statisticz »

Dptimize Database |

Figure 8-14 L ocal Methods Maint Menu

The Local Methods Maint Menu displays the following options:
Edit Local Methods - Opens a data screen where you can edit local methods values.

Import Local Methods - Opens a file dialog screen where you can select afile to add to
local methods.

Export Local Methods - Opens afile dialog screen where you can create a text file and
export the values in local methods.

8.1.7.4 VIEW SYSTEM STATISTICS MENU
The View System Statistics menu is only available when a project is loaded.

ADMIN> <New.MDB> <NEW PROJECT> <KNGSN> <F12345-00-A-678

Becord EGIER '
Lzer b aint 4
WL M aint k
Local Methods Maint — »

Wiew Systern Statiztics Ligt Local b ethods Report
Changed Local Methods Repaort
Submizzion Status Report
Changed Lz Repart

Y alidation Hiztory Screen

Dptimize Databaze

Figure 8-15 View System Statistics Menu

The Menu displays the following options:
List Local Methods Report - Opens a report screen showing alist of local methods.

Changed Local Methods Report - Opens a report screen showing changesin loca
methods.

Submission Status Report - Opens a report screen showing the submission status of tables.
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Changed VVLs Report - Opens a report screen showing changesin VVLs.
Validation History Screen - Opens a screen showing the project’s validation history.

8.1.8 Window Menu

<New MDB> <NEW PROJEC

Toolz REEGEIIR Help

Tile Wertical
Tile Horizonkal
Cazcade

Cloze Al

Open Screens  k

Figure 8-16 Window Menu

The Window Menu displays the following options:
Tile Vertical - Displays al open screens in a vertical arrangement.
Tile Horizontal - Displays all open screens in a horizontal arrangement.

Cascade - Displays all open screens in a diagonal arrangement showing the screen’ s title
bars.

Close All - Closes @l open screens.
Open Screens> - Opens the Open Screens menu.

8.1.8.1 OPEN SCREENS MENU

<New MDB> <NEW PROJECT> <ACADM:> <F12345-00-A-6789-01>

Toolz REEGLEE Help

Tile Vertical
Tile Harizontal
LCazcade

Cloze All

Open Screens  k 1 PC201: Location [LDI) Data Entry
v 2 PC206: Zone [£01] Data Entry

Figure 8-17 Open Screens Menu

The Open Screens Menu displays the titles of al open screens. Click on a screen title to
activate its screen and bring it to the top. The active screen is the one checked.
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8.1.9 Help Menu

PMIN> <Mew MDB> <NEW PROJEC

PNy Help
PCHelp
Tech Support

About ERPT ools/FPC

Figure 8-18 Help Menu

The Help Menu displays the following options:
PCHep - Opens the online Help file.

Tech Support - To report a bug or suggest afix for ERPTools/PC. See 1.2 AFCEE
Support.

About ERPToo0ls/PC - Opens the About ERPTo0ls/PC screen, which displays information
about ERPTools/PC and system resources.

The Help screen provides access to Windows standard help. Help can also be displayed by
clicking the [F1] key.
8.2 REPORT PREVIEW M ENU

A report opens in a new window, and has its own menu bar. There are two types of online
reports, System Statistics reports and Error reports.

8.2.1 Report Preview Menu Bar

X Submission Status Report M= E3|

||]E | & Piint | @, @ 100 'I | PN alwz | 4 Back = Fowad

Figure 8-19 Report Menu Bar

8.2.1.1 REPORT PREVIEW MENU BUTTONS

15 Contents toggles the Contents area of the report screen.

& Eiint.. Print opens the Print dialog so you can print or preview the report.

= Zoom Out allows you to see more of the report by showing it smaller.

®, Zoom In allows you to see more of the report’s detail by showing it larger.

[100% =] The Zoom drop down list allows you to set the report’s display size.
P Previous Page shows the previous page of the report.

(& Next Page shows the next page of the report.
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172 The Page counter gives the current page number and the number of pages.

4+ Back Back shows the last page you visited.

= Foward  FOrward shows the last page you moved back from.

8.2.2 Report Preview File Menu

. Report Preview

File
FDF Expart
RBTF Expart

Prirt
Printer Setup

Exit

Figure 8-20 Report Preview File Menu

The Report Preview File Menu displays the following options:
PDF Export — Creates an Acrobat file of the preview.
RTF Export - Creates a Rich Text Format file of the preview.
Print - Prints the current preview.

Printer Setup - Opens your standard printer interface dialog so you can set printing options
and select a printer.

Exit - Closes the Report Preview screen.

8.3 PRINT PrEVIEW M ENU

A print preview opens in a new window, and has its own menu bar.

8.3.1 Print Preview Menu Bar

[#. Print Preview of LDI - Location

File  Wiew
g QB =k ¢ P dlpgeids |

Figure 8-21 Print Preview Menu Bar

8.3.1.1 PRINT PREVIEW MENU BUTTONS

& Print prints the report.

) Zoom In alows you to see more of the report’s detail by showing it larger.
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=} Zoom Out alows you to see more of the report by showing it smaller.
Fit In Window zooms the report page to fit in the displayed window.
37H | The Zoom drop down list allows you to set the report’s display size.

[ < = =1 The Navigation controls allow you to select the first, previous, next, or last page.

Page 1 of 6 The Page counter gives the current page number and the number of pages.
(%) Stop Pagination alows you to escape from the pagination process for large tables.

8.3.2 Print Preview File Menu

% Print Preview of LDI - Loca

F[=8 iew
Frint Chil+P
Frint gome pages  Chil+5
Print current page  Chl+C

Exit Ale+F4

Figure 8-22 Print Preview File Menu

The Print Preview File Menu displays the following options:
Print - Prints the current preview.
Print Some Pages - Allows you to select arange of pages in the current preview toprint.
Print Current Page - Prints the current page in the current preview.
Exit - Closes the Print Preview screen.

8.3.3 Print Preview View Menu

/2. Print Preview of LDI - Locatio

Zoom |n [aray +
Zoom Dut Gray -
Fit in *indow  Enter

First Page Home
Previous Page Pglp
Mext Page Paln
Last Page End

Figure 8-23 Print Preview View Menu

The Print Preview View Menu displays the following options:

Zoom In - Allows you to see more of the report’s detail by showing it larger.
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Zoom Out - Allows you to see more of the report by showing it smaller.
Fit In Window Zooms the report page to fit in the displayed window.
First Page - Shows the first page of the current print preview.

Previous Page - Shows the previous page of the current print preview.
Next Page - Shows the next page of the current print preview.

Last Page - Shows the last page of the current print preview.

8.4 BrRowSsE M ENU

The Browse screen opens in the ERPTools/PC Main screen, and adds a limited Browser
toolbar.

20| m| o

Address
|http:.-"x'www.afu:ee.I:uru:u:uks.af.miI.-"rnsfmsu:_irp.htm j

=

Figure 8-24 Browse Menu

8.4.1 Browse Menu Buttons

&= Back jumps to the screen used to jump to the present screen.

= Forward jumps to the screen where you used the Back button to navigate to the
present screen.

6 Stop halts any downloads or jumps that are still in progress.

Refresh reloads and updates the information shown on the current screen.

@ Home jumps to the home page set in your normal browser.

8.4.2 Address Field

Address:
Ihttp:a";"www.afcee.bruoks.af.mila"ms;"msc_irp.htm j

Figure 8-25 Browse Menu Address Field

The Browse menu Address field shows you the uniform resource locator (URL) for the
current web page. The drop down list shows recently visited addresses, and allowsyou to
enter a URL you want to visit.
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9. ERROR MESSAGES
Validation Rules Version 4.0.0.

A

AQ2

Appliesto: CALCPARCODE is not a valid code.

Severity: Error

Cause: The CALCPARCODE code you have entered was not found in the valid valuelist CPC

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

AO3

Appliesto: LOGDATE can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot ke empty.
Action: Enter a correct value for the indicated field.

A04

Appliesto: LOGDATE isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an all-numeric date vaue, ERPTool PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

A05

Appliesto: LOGDATE can not be later than validation date.

Severity: Error

Cause: The value in the LOGDATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the LOGDATE field to reflect the actual date the analysis was performed.

A06

Appliesto: LOGTIME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

PaGE 121



F41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

AQ7

Appliesto: LOGTIME isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as avalid time.
Action: Enter afour digit number between 0000 and 2359.

A08

Appliesto: PARVAL can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

AQ09

Appliesto: PARVAL isnot a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

A10

Applies to: Numeric value too large. Max value is 9999999999.9999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
9999999999.9999

Action: Verify the accuracy of your entry and correct the data

All

Appliesto: LOCID can not be null.
Severity: Error

Cause: LOCID isarequired fidd
Action: Enter avdid LOCID

Al12

Appliesto: UNITSisnot a valid code.

Severity: Error

Cause: The UNITS code you have entered was not found in the valid value list UTM

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct vaid value code

Al13

Appliesto: PARVAL must be greater than zero when CALCPARCODE is'K" or 'T".

Severity: Error

Cause: The value of the PARVAL field must be a positive number in records where the value
of the CALCPARCODE fiddissettoK or T.

Action: Verify the value of the PARVAL and CALCPARCODE fields. Correct as appropriate.
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Al4

Appliesto: PARVAL must be between 0 and 1 when CALCPARCODE is'NE'.

Severity: Error

Cause: The value of the PARVAL field must fall between 0 and 1 (inclusive) in records where
the value of the CALCPARCODE field is set to NE.

Action: Verify the value of the PARVAL and CALCPARCODE fields. Correct as appropriate.

A15

Appliesto: PARVAL must be between 0 and 1 when CALCPARCODE is'S.

Severity: Error

Cause: The value of the PARVAL field must fall between 0 and 1 (inclusive) in records where
the value of the CALCPARCODE fidldissetto S.

Action: Verify the value of the PARVAL and CALCPARCODE fields. Correct as appropriate.

A18

Appliesto: CALCMETH isnot avalid code.

Severity: Error

Cause: The CALCMETH code you have entered was not found in the valid vdue liss CMT

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

A19

Appliesto: TESTMETH isnot a valid code.

Severity: Error

Cause: The TESTMETH code you have entered was not found in the valid value liss TMT

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

A20

Applies to: AQBASEDEPT is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

A2l

Applies to: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric vaue entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

A22

Appliesto: LOGCODE isnot a valid code.

Severity: Error

Cause: The LOGCODE code you have entered was not found in the valid value list LOG

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code
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A23

Appliesto: WELLDIST isnot a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

A24

Applies to: Numeric value too large. Max value is 9999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 9999.99
Action: Verify the accuracy of your entry and correct the data

A25

Appliesto: AQTHICK isnot a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

A26

Applies to: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

A27

Appliesto: SUPPDATA isnot a valid code.

Severity: Error

Cause: The SUPPDATA code you have entered was not found in the valid value list SPD

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

A28

Appliesto: WTDEPTH is nhot a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action; Enter a numeric value in the indicated field.

A29

Appliesto: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data
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A30

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

ATO2

Appliesto: AFII D does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

ATO3

Appliesto: LOCID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

AT

Appliesto: LOGDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

ATO05

Appliesto: LOGDATE isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you till experience problems, use a non-numeric date value (i.e. 4
May-95).

ATO06

Appliesto: LOGDATE should not normally be later than validation date.

Severity: Warning

Cause: The value in the LOGDATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the LOGDATE field to reflect the actual date the analysis was performed.
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ATO7

Appliesto: LOGTIME can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

ATO08

Appliesto: LOGTIME isnot in required format.
Severity: Error

Cause: The LOGTIME entered is not in the format HHMM
Action: Enter LOGTIME in the correct format, e.g., 1215

ATO09

Appliesto: HEADDIR isnot a valid code.

Severity: Error

Cause: The HEADDIR code you have entered was not found in the valid value liss CHD

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

AT10

Appliesto: LOGCODE is not a valid code.

Severity: Error

Cause: The LOGCODE code you have entered was not found in the valid value list LOG

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

AT11

Appliesto: UNITSis not a valid code.

Severity: Error

Cause: The UNITS code you have entered was not found in the valid value list UTM

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

AT12

Appliesto: SLUGVOL isnot a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

AT13

Appliesto: Numeric value too large. Max value is 9999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 9999.99
Action: Verify the accuracy of your entry and correct the data
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B
C

coz

Applies to: Invalid value.

Severity: Error

Cause: The AFIID code you have entered was not found in the valid value list AFI

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assisance in
finding the correct valid value code

Cco3

Appliesto: Field cannot be blank.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

co4

Appliesto: Field cannot be blank.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

C05

Appliesto: DO_ID must be between 0 and 9999 if numeric.

Severity: Error

Cause: The vaue entered in the DO _ID field must be between 0 and 9999 if using a numeric
DO naming convention.

Action: Correct the value entered in the DO _ID field.

C13

Appliesto: DO_ID contains embedded or leading spaces.

Severity: Error

Cause: The DO_ID field must not contain embedded or leading spaces.
Action: Enter a correct value for the DO_ID field.

Cl4

Applies to: Field cannot be blank.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

D

D02

Applies to: ASTM can not be 'NAUM'.
Severity: Error

Cause: The ASTMCODE field is set to NAUM.
Action: Enter a correct value for this field.
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D03

Appliesto: ASTMCODE is not a valid code.

Severity: Error

Cause: The ASTMCODE code you have entered was not foundin the valid vadue list AST

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

D04

Appliesto: BEGDEPTH can not be null.

Severity: Error

Cause: Theindicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

D05

Appliesto: BEGDEPTH isnot a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

D06

Applies to: BEGDEPTH can not be greater than DEPTH in LDI.

Severity: Error

Cause: The valuein the BEGDEPTH field is greater than the value in the DEPTH field of the
parent record.

Action: Verify that the value in the LOCID field is correct. If it is, enter a beginning depth.

DO7

Applies to: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric vaue entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

D08

Appliesto: ENDDEPTH can not be blank.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

D09

Appliesto: ENDDEPTH is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.
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D10

Appliesto: ENDDEPTH is greater than DEPTH in LDI.

Severity: Error

Cause: The value of the ENDDEPTH field is greater than the value of the DEPTH field inthe
parent record.

Action: Verify the values of the ENDDEPTH and DEPTH fields. Correct as appropriate.

D11

Appliesto: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry alowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

D119

Appliesto: LOCID can not be null.
Severity: Error

Cause: LOCID is arequired field
Action: Enter avaid LOCID

D13

Appliesto: LITHCODE can not be 'NACM' or 'NAUM'.

Severity: Error

Cause: The values NACM and NAUM are not appropriate for the LITHCODE field.
Action: Enter a correct value for the LITHCODE field.

D14

Appliesto: LITHCODE isnot a valid code.

Severity: Error

Cause: The LITHCODE code you have entered was not found in the valid value list LTH

Action: Enter avaue provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

D16

Appliesto: LOGCODE isnhot a valid code.

Severity: Error

Cause: The LOGCODE code you have entered was not found in the valid value list LOG

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

D17

Appliesto: LOGDATE should not normally be null.
Severity: Warning

Cause: The LOGDATE field is empty.

Action: Enter a correct value for the LOGDATE field
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D18

Appliesto: LOGDATE isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an dl-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

D19

Appliesto: LOGDATE should not normally be later than validation date.

Severity: Warning

Cause: The value in the LOGDATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the LOGDATE field to reflect the actua date the analysis was performed.

D23

Applies to: Field cannot be blank.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

D24

Applies to: Beginning depth is greater than ending depth.

Severity: Error

Cause: The value in the BEGDEPTH field is greater than the value in the ENDDEPTH field.
Action: Verify the values of both fields and correct as necessary.

D29

Appliesto: Invalid value.

Severity: Error

Cause: The ST_UNIT code you have entered was not found in the valid value list ()

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

D30

Appliesto: HS UNIT isnot avalid code.

Severity: Error

Cause: The HS UNIT code you have entered was not found in the valid value list ()

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct vaid value code
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D31

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

DUP

Appliesto: Duplicate within this submission.

Severity: Error

Cause: The key fields of the indicated record match those of an already existing record.
Action: Verify the value of the key fields in the indicated record.

E

EMO1

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

EMO2

Appliesto: LOCID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

EMO3

Appliesto: LOGDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

EMO4

Appliesto: LOGDATE isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control parel. For
example, if the international date setting is DMY, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you till experience problems, use a non-numeric date value (i.e. 4
May-95).
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EMO5

Appliesto: LOGDATE can not be later than validation date.

Severity: Error

Cause: Thevalueinthe LOGDATE field is greater than your system'’s date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the LOGDATE field to reflect the actual date the analysis was performed.

EMO06

Appliesto: LOGTIME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

EMO7

Appliesto: LOGTIME isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

EMO08

Appliesto: MATRIX isnot a valid code.

Severity: Error

Cause: The MATRIX code you have entered was not found in the valid value liss MTX

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

EMO09

Applies to: SBD can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

EM10

Appliesto: SBD is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

EM11

Appliesto: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data
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EM12

Appliesto: SED can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

EM13

Appliesto: SED is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric vaue in the indicated field.

EM14

Appliesto: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

EM15

Applies to: ANADATE can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

EM16

Appliesto: ANADATE isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windowd(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

EM17

Appliesto: ANADATE can not be later than validation date.

Severity: Error

Cause: The vaue in the ANADATE field is greater than your system'’s date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the ANADATE field to reflect the actual date the analysis was performed.
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EM18

Appliesto: ANATIME can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

EM19

Appliesto: ANATIME isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

EM20

Appliesto: ANATYPE is not a valid code.

Severity: Error

Cause: The ANATY PE code you have entered was not found in the valid value list ANT

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

EM21

Appliesto: PARVAL isnot a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter anumeric value in the indicated field.

EM22

Appliesto: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

EM23

Appliesto: UNITSisnot a valid code.

Severity: Error

Cause: The UNITS code you have entered was not found in the valid value list UTM

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct vaid value code

EM24

Appliesto: QUALIFIER isnot a valid code.

Severity: Error

Cause: The QUALIFIER code you have entered was not found in the valid value list EDQ

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code
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F
G

Go4

Appliesto: LOGCODE is not a valid code.

Severity: Error

Cause: The LOGCODE code you have entered was not found in the valid value list LOG

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

GO05

Appliesto: LOGDATE can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

G06

Appliesto: LOGDATE isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

GO7

Appliesto: LOGDATE can not be later than validation date.

Severity: Error

Cause: The value in the LOGDATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the LOGDATE field to reflect the actual date the analysis was performed.

G08

Appliesto: LOGTIME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

G09

Appliesto: LOGTIME isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.
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G127

Appliesto: LOCID can not be null.
Severity: Error

Cause: LOCID isarequired fied
Action: Enter avdid LOCID

G18

Appliesto: SOUNDING is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

G19

Appliesto: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

G20

Appliesto: STATDEP is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

G21

Appliesto: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for thisfield; 99999.99
Action: Verify the accuracy of your entry and correct the data

G26

Appliesto: STATDEP can not be greater than SOUNDING.

Severity: Error

Cause: The value of the STATDEP field is greater than the value of the SOUNDING field.
Action: Verify the value of both fields. Correct as appropriate.

G27

Appliesto: STATDEP must be null when well isdry.

Severity: Error

Cause: The STATDEP field is not empty. Thisisincorrect for groundwater records where
the value of the DRY field is set to D.

Action: Verify the value of both fields. Correct as appropriate.

G39

Appliesto: IBDEPTH can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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G40

Appliesto: IBDEPTH isnot a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

G41

Appliesto: Numeric value too large. Max value is 9999999.99

Severity: Error

Cause: The numeric vdue entered exceeds the maximum entry allowed for this field;
9999999.99

Action: Verify the accuracy of your entry and correct the data

G42

Appliesto: IEDEPTH can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

G43

Appliesto: IEDEPTH is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

G44

Appliesto: Numeric value too large. Max value is 9999999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
9999999.99

Action: Verify the accuracy of your entry and correct the data

G46

Appliesto: DRY must be'D' or ‘W',

Severity: Error

Cause: The only allowed values for the DRY field are D and W.
Action: Enter a correct value for the DRY fidld.

G48

Appliesto: FTCODE is not a valid code.

Severity: Error

Cause: The FTCODE code you have entered was not found in the valid valuelist FTC

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code
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G50

Appliesto. MEASMETH isnot a valid code.

Severity: Error

Cause: The MEASMETH code you have entered was not foundin the valid value lis MMT

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

G51

Appliesto: AFII D does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

H

HS02

Appliesto: HS UNIT can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

HS03

Appliesto: AFIID does not match AFIID in project information.
Severity: Error

Cause: The AFIID entered does not match the AFIID for the current project.
Action: Correct the AFIID entered.

HS04

Appliesto: HSTYPE is not a valid code.

Severity: Error

Cause: The HSTY PE code you have entered was not found in the valid value list LTH

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

102

Applies to: GFCCODE isnot a valid code.

Severity: Error

Cause: The GFCCODE code you have entered was not found in the valid value list GFC

Action: Enter avalue provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code
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105

Appliesto: SITEID isnot a valid code.

Severity: Error

Cause: The SITEID code you have entered was not found in the valid value list

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

110

Appliesto: SITEID is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in theindicated field.

1109

Appliesto: LOCID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

111

Appliesto: Numeric value too large. Max value is 999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for thisfield; 999
Action: Verify the accuracy of your entry and correct the data

112

Appliesto: SPCODE is not a valid code.

Severity: Error

Cause: The SPCODE code you have entered was not found in the valid value list SPR

Action: Enter avaue provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

113

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

INV

Appliesto: Invalid valuein LOCID field.

Severity: Error

Cause: The LOCID code you have entered was not found in the valid value list

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct vaid value code
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V2

Appliesto: Invalid valuein OBS LOCATION field.

Severity: Error

Cause: The OBS LOCATION code you have entered was not found in the valid value list

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

J
K
L

LO1

Appliesto: BHDIAM is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

L02

Appliesto: BHDIAM should not normally be greater than 50 inches.
Severity: Warning

Cause: The vaue in the BHDIAM field is greater than 50 inches.

Action: Enter a correct value for BHDIAM.

LO3

Appliesto: Numeric value too large. Max value is 99.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed fa this field; 99.99
Action: Verify the accuracy of your entry and correct the data

LO4

Appliesto: CMCCODE is not a valid code.

Severity: Error

Cause: The CMCCODE code you have entered was not found in the valid value list CMC

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

LO5

Appliesto: DEPTH is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

L06

Appliesto: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data
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LO7

Applies to: DRLCODE isnot a valid code.

Severity: Error

Cause: The DRLCODE code you have entered was not found in the valid value list DRL

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid vaue code

LO8

Appliesto: ECOORD must be greater than zero.

Severity: Error

Cause: The value supplied for the ECOORD field is not a positive number.
Action: Enter a positive value for this field.

L09

Appliesto: ECOORD is not a number.

Severity: Error

Cause A norrnumeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

L10

Applies to: Numeric value too large. Max value is 99999999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry alowedfor this field;
99999999.99

Action: Verify the accuracy of your entry and correct the data

L11

Appliesto: ELEV should not normally be null.
Severity: Warning

Cause: The ELEV field is empty.

Action: Enter a correct value for this field.

L12

Appliesto: ELEV is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

L13

Appliesto: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data
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L134

Appliesto: LOCID can not be 'FIELDQC' or 'LABQC'.

Severity: Error

Cause: By default, the LOCID FIELDQC or LABQC was entered for you at the time of project
creation. It should not be entered again.

Action: By default, the LOCID FIELDQC or LABQC was entered for you at the time of project
creation. It should not be entered again.

L15

Appliesto: ESCCODE is not a valid code.

Severity: Error

Cause: The ESCCODE code you have entered was not found in the valid value list ESC

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

L16

Appliesto: ESTDATE can nat be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

L17

Appliesto: ESTDATE isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 4-5-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct forma to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

L18

Appliesto: ESTDATE can not be later than validation date.

Severity: Error

Cause: The value of the ESTDATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the ESTDATE field.

L19

Appliesto: EXCCODE is not a valid code.

Severity: Error

Cause: The EXCCODE code you have entered was not found in thevalid value list EXC

Action: Enter avaue provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code
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L22

Appliesto: LOCDESC can not be null.

Severity: Error

Cause: Theindicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

L23

Appliesto: LOCID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

L24

Appliesto: LOCID can not contain spaces.

Severity: Error

Cause: The LOCID field cannot contain embedded or leading spaces.
Action: Enter a correct value for the LOCID field.

L28

Appliesto: LTCCODE is not a valid code.

Severity: Error

Cause: The LTCCODE code you have entered was not found in the valid value list LTC

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

L29

Appliesto: NCOORD is not a number.

Severity: Error

Cause A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

L30

Appliesto: NCOORD must be greater than zero.

Severity: Error

Cause: The value of the NCOORD field must be a positive number.
Action: Enter a carrect value for the NCOORD field.

L31

Appliesto: Numeric value too large. Max value is 99999999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
99999999.99

Action: Verify the accuracy of your entry and correct the data
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L32

Appliesto: BHDIAM cannot be null for this LTCCODE

Severity: Error

Cause: The BHDIAM field isempty. Thisis an error for LDI records where the LTCCODE is
set to BH, WL, PR or PH.

Action: Verify the value of the BHDIAM and LTCCODE fields. Correct as appropriate.

L33

Appliesto: LTCCODE requiresthat BHDIAM must be greater than zero.

Severity: Error

Cause: The vaue entered in the BHDIAM field is not a positive number. Thisis an error when
the LTCCODE is set to BH, WL, PR or PH.

Action: Verify the value of the BHDIAM and LTCCODE fields. Correct as appropriate.

L34

Appliesto: LTCCODE requiresthat CMCCODE can not be 'NA'.

Severity: Error

Cause: The value NA is not appropriate for the CMCCODE field at locations where the
LTCCODE fidd is set to BH, TE, TP, PH, WL or PR.

Action: Verify the value of the CMCCODE and LTCCODE fields. Correct as appropriate.

L 36

Appliesto: DEPTH cannot be null for thisLTCCODE.

Severity: Error

Cause: The DEPTH field is may not be blank when the LTCCODE isset to BH, TP, WL, PH
or PR.

Action: Verify the value of the DEPTH and LTCCODE fields. Correct as appropriate.

L38

Appliesto: DEPTH must be greater than zero.

Severity: Error

Cause: The vaue entered in the DEPTH field is not a positive number.
Action: Verify the value of the DEPTH field.

L39

Appliesto: LTCCODE requiresthat DRLCODE can not be 'UNK' or 'NA'.

Severity: Error

Cause: The values UNK and NA are not appropriate for the DRLCODE field at |ocations where
the LTCCODE fidld is set to BH, WL, PR or PH.

Action: Verify the value of the DRLCODE and LTCCODE fields. Correct as appropriate.

L42

Appliesto: ECOORD can not be null when LTCCODE is'WL".

Severity: Error

Cause: The ECOORD field is empty. Thisis incorrect for locations where LTCCODE is set D
WL.

Action: Verify the value of the ECOORD and LTCCODE fields. Correct as appropriate.

PAGE 144



FA41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

L43

Appliesto: LTCCODE requires NCOORD data.

Severity: Error

Cause: The NCOORD field is empty. Thisisincorrect for locations where the value of the
LTCCODE is setto WL.

Action: Enter a correct value for the NCOORD field.

L44

Applies to;: EXCCODE can not be UNK or NA when LTCCODE is'TE' or 'TP'.

Severity: Error

Cause: The values UNK and NA are not appropriate for the EXCCODE field at locations where
the LTCCODE isset to TE or TP.

Action: Verify the value of the EXCCODE and LTCCODE fields. Correct as appropriate.

L45

Appliesto: EXCCODESs should usually be 'UNK' or 'NA' for LTCCODES other than
"TE','"TP or 'CH'.

Severity: Warning

Cause: The value NA should be used at locations where excavations have not occurred, i.e;
LTCCODE not equal to TE, CH or TP.

Action: Verify the value of the EXCCODE and LTCCODE fields. Correct as appropriate.

L51

Applies to;: ESCCODE should not normally be 'NA' or "UNK".

Severity: Warning

Cause: The values NA and UNK are not appropriate for the ESCCODE field.
Action: Enter a correct value for the ESCCODE field.

L52

Appliesto: CMCCODE can not be 'UN'.

Severity: Error

Cause: The value UN is not appropriate for the CMCCODE field.
Action: Enter a correct value for CMCCODE.

L53

Appliesto: Location description must be provided if drilling company code is UNK.
Severity: Error

Cause: The LOCDESC field isempty. Thisisincorrect if the DRLCODE is set to UNK.
Action: Verify the value of both fields. Correct as appropriate.

L54

Applies to;: EXCCODE can not be'UNK".

Severity: Error

Cause: The value UNK is not appropriate for the EXCCODE field.
Action: Enter a correct value for the EXCCODE field.
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L55

Appliesto: LPRCODE must be'l' or 'O'.

Severity: Error

Cause: The only alowed vaues for LPRCODE in AFCEE contracts are | and O.
Action: Enter a correct value for the LPRCODE field.

L56

Appliesto: LTCCODE can not be'UN', '"PZ' or 'NQ'.

Severity: Error

Cause: The values UN, NQ and PZ are not appropriate for the LTCCODE field.
Action: Enter a correct value for the LTCCODE field.

L59

Applies to: BHANGLE is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

L 60

Applies to: BHANGLE can not be greater than 90.

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 90
Action: Verify the accuracy of your entry and correct the data

L61

Appliesto: BHAZIM isnot a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

L62

Appliesto: BHAZIM can not be greater than 359.99.

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 359.99
Action: Verify the accuracy of your entry and correct the data

L63

Appliesto: CRDMETH isnot a valid code.

Severity: Error

Cause: The CRDMETH code you have entered was not found in the valid value list CRD

Action: Enter avalue provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

L65

Applies to: CRDUN is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.
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L 66

Appliesto: CRDUN can not be greater than 100.

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 100
Action: Verify the accuracy of your entry and correct the data

L68

Appliesto: ELEVMETH isnot a valid code.

Severity: Error

Cause: The ELEVMETH code you have entered was not found in the valid value list ELM

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

L 69

Appliesto: ELEVUN isnot a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

L70

Appliesto: ELEVUN can not be greater than 100.

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 100
Action: Verify the accuracy of your entry and correct the data

L72

Appliesto: STPPROJ is not a valid code.

Severity: Error

Cause: The STPPROJ code you have entered was not found in the \alid value list STP

Action: Enter avaue provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

L73

Appliesto: STPZONE is not a valid code.

Severity: Error

Cause: The STPZONE code you have entered wasnot found in the valid value list STZ

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

L74

Appliesto: UTMZONE isnot a valid code.

Severity: Error

Cause: The UTMZONE code you have entered was not found in the valid value list UTZ

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct vaid value code
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L75

Appliesto: Coordinate type must be NA if coordinates are not provided.
Severity: Error

Cause: Coordinate type must be NA if coordinates are not provided.

Action: Coordinate type must be NA if coordinates are not provided.

L 76A

Appliesto: CRDUNITS must be'FT' when coordinates are provided.

Severity: Error

Cause: The only alowed vaue for the CRDUNITS field in AFCEE contractsis FT.
Action: Enter FT in the CRDUNITS field.

L76B

Appliesto: CRDUNITS must be 'FT' when coordinates are provided.

Severity: Error

Cause: The only allowed value for the CRDUNITS field in AFCEE cantracts is FT.
Action: Enter FT in the CRDUNITS field.

L77

Appliesto: ELEVUNITS must be'FT' when ELEV is provided.

Severity: Error

Cause: The only alowed value for the ELEVUNITS field in AFCEE contractsis FT.
Action: Enter FT in the ELEVUNITS.

L79

Applies to: CMCCODE must be 'NA' when LTCCODE is'SL" or 'SS.

Severity: Error

Cause: The CMCCODE field must be set to NA for locations where the LTCCODE field is set
to SL or SS.

Action: Verify the value of the CMCCODE and LTCCODE fields. Correct as approprete.

L80

Appliesto: DRLCODE must be 'NA' when LTCCODE is'SL", 'SS, 'TE' or 'TP'.

Severity: Error

Cause: The value UNK is not appropriate for the DRLCODE field at locations where the
LTCCODE fieldissetto SL, SS, TE or TP.
Action: Verify the value of the DRLCODE and LTCCODE fields. Correct as appropriate.

L83

Appliesto: ELEV can not be null when LTCCODE is'WL".

Severity: Error

Cause: The ELEV field isempty. Thisisincorrect for locations where LTCCODE is set to

WL.
Action: Verify the value of the ELEV and LTCCODE fields. Correct as appropriate.
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L85

Appliesto: ELFLAG isnot a valid code.

Severity: Error

Cause: The value of the indicated field did not match one of the valid values specified in that
fidd's VVL.

Action: Correct the value so it matches one of the entries in the VVL or ask an ERPTOOL S/PC
administrative user to add the new value to the VVL.

L 86A

Appliesto: Coordinate type must be N27 or N83 when coor dinates ar e provided.
Severity: Error

Cause: Coordinate type must be N27 or N83 when cardinates are provided.

Action: Coordinate type must be N27 or N83 when coordinates are provided.

L86B

Appliesto: Coordinate type must be N27 or N83 when coor dinates ar e provided.
Severity: Error

Cause: Coordinate type must be N27 or N83 when coordinatesare provided.

Action: Coordinate type must be N27 or N83 when coordinates are provided.

L90

Applies to: CRDMETH must be NA when coor dinates are not provided.
Severity: Error

Cause: CRDMETH must be NA when coordinates are not provided
Action: CRDMETH must be NA when coordinates are not provided

LI91A

Appliesto: CRDMETH can not be NA when coordinates are provided.
Severity: Error

Cause: CRDMETH must not be NA when coordinates are provided

Action: Match the method of coordinate collection with a code from theVVL.

L91B

Appliesto: CRDMETH can not be NA when coordinates are provided.
Severity: Error

Cause: CRDMETH must not be NA when coordinates are provided

Action: Match the method of coordinate collection with a code from the VVL.

L92

Appliesto: CRDUNITS must be 'NONE' when coordinates are not provided.
Severity: Error

Cause: CRDUNITS must be 'NONE' when coordinates are not provided.
Action: Enter NONE in the CRDUNITS field.
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L93

Appliesto: ELEVUNITS must be 'NONE' when ELEV is not provided.
Severity: Error

Cause: ELEVUNITS must be 'NONE' when ELEV is not provided.
Action: Enter NONE in the ELEVUNITS field.

L94

Appliesto: ELEVMETH must be NA when ELEV is not provided.
Severity: Error

Cause: ELEVMETH must be NA when ELEV is not provided
Action: Enter NA in the ELEVMETH field.

L95

Appliesto: ELEVMETH can not be NA when ELEV is provided.
Severity: Error

Cause: ELEVMETH must not be NA when ELEV is provided

Action: Enter a code reflecting the method of elevation determination.

L96

Appliesto: AFI1D does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

L97

Applies to: STPZONE can not be Q

Severity: Error

Cause: The value Q is not appropriate for the STPZONE field.
Action: Select the correct value from the AFCEE provided VVL.

L98

Applies to: STPPROJ can not be Q

Severity: Error

Cause: The value Q is not appropriate for the STPPROJ field.
Action: Select the correct value from the AFCEE provided VVL.

L99

Appliesto: UTMZONE can not be Q

Severity: Error

Cause: The value Q is not appropriate for the UTMZONE field.
Action: Select the correct value from the AFCEE provided VVL.
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LOO01

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

LO02

Appliesto: LOCID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

LO04

Applies to: OUCODE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

L S01

Appliesto: AFI1D does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

L S02

Appliesto: LOCID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

L S03

Appliesto: RSID can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

LS04

Appliesto: RSSTAGE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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LTO1

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

LTO2

Appliesto: LOCID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

LTO3

Appliesto: RSID can not be null.

Severity: Error

Cause: Theindicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

LTO4

Applies to: RSSTAGE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

LTO5

Appliesto: RTID can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

LTO6

Appliesto: RTTYPE can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

M

MRO1

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project ARID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.
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MRO02

Appliesto: MAPRID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

MRO3

Appliesto: BMEAST isnot a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

MRO0O4
Applies to: Numeric value too large. Max value is 99999999.99
Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;

99999999.99
Action: Verify the accuracy of your entry and correct the data

MRO05

Appliesto: BMELEYV is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

MR06
Appliesto: Numeric value too large. Max value is 99999.99
Severity: Error

7 JuLy 200

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99

Action: Verify the accuracy of your entry and correct the data

MRO7

Appliesto: BMNORTH isnot a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

MRO08
Appliesto: Numeric value too large. Max value is 99999999.99
Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;

99999999.99
Action: Verify the accuracy of your entry and correct the data
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MRO09

Appliesto: LLEAST isnot a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

MR10

Appliesto: Numeric value too large. Max value is 99999999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry alowed for this field; 99999999
Action: Verify the accuracy of your entry and correct the data

MR11

Appliesto: LLNORTH is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

MR12

Appliesto: Numeric value too large. Max value is 99999999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999999
Action: Verify the accuracy of your entry and correct the data

MR13

Appliesto: MCCCODE is not a valid code.

Severity: Error

Cause: The MCCCODE code you have entered was not found in the valid value list MCC

Action: Enter avalue provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

MR14

Appliesto: MAPSCALE is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

MR15

Applies to: Numeric value too large. Max value is 9999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 9999
Action: Verify the accuracy of your entry and correct the data
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MR16

Appliesto: MTCCODE is not a valid code.

Severity: Error

Cause: The MTCCODE code you have entered was not found in the valid value list MTC

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

MR17

Appliesto: MAPCODE is not a valid code.

Severity: Error

Cause: The MAPCODE code you have entered was not found in the valid value liss MAP

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct vaid value code

MR18

Appliesto: UREAST isnot a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

MR19

Applies to: Numeric value too large. Max value is 99999999

Severity: Error

Cause The numeric value entered exceeds the maximum entry allowed for this field; 99999999
Action: Verify the accuracy of your entry and correct the data

MR20

Applies to: URNORTH isnot a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

MR21

Appliesto: Numeric value too large. Max value is 99999999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999999
Action: Verify the accuracy of your entry and correct the data

MR22

Appliesto: MAPCODE can not be Q

Severity: Error

Cause: The value Q is not appropriate for the MAPCODE field.
Action: Select the correct value from the AFCEE provided VVL.
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MR23

Appliesto: MTCCODE can not be Q

Severity: Error

Cause: The value Q is not appropriate for the MTCCODE field.
Action: Select the correct value from the AFCEE provided VVL.

MR24

Appliesto: MCCCODE can not be Q

Severity: Error

Cause: The value Q is not appropriate for the MCCCODE field.
Action: Select the correct value from the AFCEE provided VVL.

N

NOP

Appliesto: No parent record found.

Severity: Error

Cause: The parent of the current record could not be found.

Action: Examine the parent key fields in the child table and determine what parent record
should be used. Either make sure the key fields match those of an aready existing
parent record or create a new parent record.

O

oco1

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

0co02

Appliesto: GROUPCODE isnat a valid code.

Severity: Error

Cause: The GROUPCODE code you have entered was not found in the valid value list ANG

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

0OCo03

Appliesto: MATRI X is not a valid code.

Severity: Error

Cause: The MATRIX code you have entered was not found in the valid value liss MTY

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code
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OoCco4

Applies to: OUCODE can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

ouo1

Appliesto: AFII D does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current recard does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

ou02

Applies to: OUCODE can not be null.

Severity: Error

Cause: Theindicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

ouos

Applies to: OUNAME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

Ou05

Applies to: OUDESC can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

Ou06

Appliesto: OUDESC must contain at least 25 characters.

Severity: Error

Cause: The value of the OUDESC field is less than 25 characters long.

Action: Enter a meaningful description for the OUDESC field that is at least 25 characters long.

owo1

Appliesto: AFII D does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.
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owoz2

Appliesto: LOCID can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

Oowo03

Appliesto: OBS LOCATION can not be null.

Severity: Error

Cause: Theindicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

owo4

Appliesto: LOGDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

OWO05

Appliesto: LOGDATE isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you till experience problems, use a non-numeric date value (i.e. 4
May-95).

owo7

Appliesto: LOGTIME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

owo8

Appliesto: LOGTIME isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

Oowo09

Applies to: MEASDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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OowW10

Appliesto: MEASDATE isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTo0ls/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

ow1l

Appliesto: MEASDATE can not be later than validation date.

Severity: Error

Cause: The value in the MEASDATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the MEASDATE field to reflect the actual date the analysis was
performed.

ow12

Appliesto: MEASTIME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

Oow13

Appliesto: MEASTIME isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

Oow14

Appliesto: TIDEPTH can not be greater than 9,999,999.99.
Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

ow1s

Appliesto: Numeric value too large. Max value is 9999999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
9999999.99

Action: Verify the accuracy of your entry and correct the data
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OwW16

Appliesto: FTCODE is not a valid value.

Severity: Error

Cause: The FTCODE code you have entered was not found in the vaid vaue list FTC

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

ow17

Appliesto: WTCCODE is not a valid code.

Severity: Error

Cause: The WTCCODE code you have entered was rot found in the valid value liss WTC

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct vaid value code

p

P102

Appliesto: LOCID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

P104

Appliesto: BEGDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

P105

Appliesto: BEGDATE isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTo0ls/PC attempts to interpret it accading to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

P106

Appliesto: ENDDATE can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.
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P107

Appliesto: ENDDATE isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as avalid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY/, the string 4-5-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

P108

Appliesto: BEGDEPTH can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

P109

Applies to: BEGDEPTH is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

PI10

Applies to: Numeric value too large. Max value is 9999999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
9999999.99

Action: Verify the accuracy of your entry and correct the data

PI11

Appliesto;: ENDDEPTH can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

P12

Appliesto: ENDDEPTH is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.
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PI13

Appliesto: Numeric value too large. Max value is 9999999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
9999999.99

Action: Verify the accuracy of your entry and correct the data

P114

Appliesto: LOGCODE is ot a valid code.

Severity: Error

Cause: The LOGCODE code you have entered was not found in the valid value list LOG

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk fa assistance in
finding the correct vaid value code

PI15

Applies to: PUMPDEPTH can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

P16

Applies to: PUMPDEPTH is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

PI17

Appliesto: Numeric value too large. Max value is 9999999.99

Severity: Error

Cause: The numeric vadue entered exceeds the maximum entry allowed for this field;
9999999.99

Action: Verify the accuracy of your entry and correct the data

P118

Applies to: PUMPINGRATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

PI19

Appliesto: PUMPINGRATE is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.
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P120

Appliesto: Numeric value too large. Max value is 99999.9

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.9
Action: Verify the accuracy of your entry and correct the data

PI21

Appliesto: UNITSisnot a valid amde.

Severity: Error

Cause: The UNITS code you have entered was not found in the valid value list UTM

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

P122

Appliesto: WTCCODE is not a valid code.

Severity: Error

Cause: The WTCCODE code you have entered was not found in the valid value liss WTC

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

P125

Appliesto: AFI 1D does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

P126

Appliesto: BEGTIME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

P127

Appliesto: BEGTIME isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

P128

Appliesto: ENDTIME can not be null.

Severity: Error

Cause: Theindicated field is areguired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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P129

Appliesto: ENDTIME isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as avalid time.
Action: Enter afour digit number between 0000 and 2359.

PRO1

Appliesto: AFII D does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

PRO2

Appliesto: LOCID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

PR0O3

Appliesto: LOGDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

PR0O4

Appliesto: LOGDATE isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you till experience problems, use a non-numeric date value (i.e. 4
May-95).

PRO6

Appliesto: LOGTIME can not be null.

Severity: Error

Cause: Theindicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.
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PRO7

Appliesto: LOGTIME isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as avalid time.
Action: Enter afour digit number between 0000 and 2359.

PR0O8

Appliesto: STARTDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

PR09

Appliesto: STARTDATE isnot in required for mat.

Severity: Error

Cause: The vaue entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

PR10

Appliesto: STARTDATE can not be later than validation date.

Severity: Error

Cause: The value in the STARTDATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the STARTDATE field to reflect the actua date the analysis was
performed.

PR11

Appliesto: STARTTIME can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

PR12

Appliesto: STARTTIME isnot in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.
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PR13

Appliesto: ENDDATE can not be null.

Severity: Error

Cause: Theindicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

PR14

Appliesto: ENDDATE isnot in required format.

Severity: Error

Cause: The vaue entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

PR15

Appliesto: ENDDATE can not be later than validation date.

Severity: Error

Cause: The value of the ENDDATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
vaue of the ENDDATE field.

PR16

Appliesto: ENDTIME can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

PR17

Appliesto: ENDTIME is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

PR18

Appliesto: PUMPRATE can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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PR19

Appliesto: PUMPRATE is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

PR20

Appliesto: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

PR21

Appliesto: UNITSisnot a valid code.

Severity: Error

Cause: The UNITS code you have entered was not found in the valid value list UTM

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

Q
R

RO1

Appliesto: EXPECTED is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

R02

Applies to: Numeric value too large. Max value is 9999999999.9999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for thisfield;
9999999999.9999

Action: Verify the accuracy of your entry and correct the data

RO3

Appliesto: MDL is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

R04

Appliesto: Numeric value too large. Max value is 9999999999.9999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry alowedfor this field;
9999999999.9999

Action: Verify the accuracy of your entry and correct the data
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R06

Appliesto: PARLABEL isnot a valid code.

Severity: Error

Cause: The PARLABEL code you have entered was not found in the vaid value list PAR

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

RO7

Appliesto: PARUN is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric vaue in the indicated field.

RO8

Appliesto: Numeric value too large. Max value is 99999999.9999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
99999999.9999

Action: Verify the accuracy of your entry and correct the data

R10

Appliesto: PARVQ is not a valid code.

Severity: Error

Cause: The PARVQ code you have entered was not found in the valid value list PVQ

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

R11

Appliesto: PARVAL can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

R12

Appliesto: PARVAL isnot a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

R13

Appliesto: Numeric value too large. Max value is 9999999999.9999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
9999999999.9999

Action: Verify the accuracy of your entry and correct the data
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R133
Appliesto: LOCID can not be null.
Severity: Error

Cause: The indicated field is a required field and cannot be empty.

Action; Enter a correct value for the indicated field.

R135
Appliesto: MATRIX can not be null.
Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.

Action; Enter a correct value for the indicated field.

R138
Applies to: SACODE can not be null.
Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.

Action: Enter a correct value for the indicated field.

R142

Appliesto: LOGDATE can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

R145
Appliesto: LOGTIME can not be null.
Severity: Error

Cause: The indicated field is a required field and cannot be empty.

Action; Enter a correct value for the indicated field.

R147
Applies to: SBD can not be null.
Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.

Action; Enter a correct value for the indicated field.

R15
Appliesto: UNITSisnot a valid code.
Severity: Error

Cause: The UNITS code you have entered was not found in the valid value list UTM

7 JuLy 200

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in

finding the correct valid value code

R152

Applies to: SED can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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R158

Applies to: ANM CODE can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

R16

Appliesto: PARUN must be null when PRCCODE isnot 'RN'.

Severity: Error

Cause: The PARUN field is not empty. Thisisincorrect for all result records except those
where the value of the PRCCODE field is set to RN indicating radionuclide data.

Action: Verify the value of the PARUN and PRCCODE fields. Correct as appropriate.

R161

Applies to: EXM CODE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct vaue for the indicated field.

R164

Applies to: LABCODE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

R167

Appliesto: RUN_NUMBER can not be null.
Severity: Error

Cause: RUN_NUMBER is arequired field.

Action: Enter a RUN_NUMBER between 1 and 99

R171

Appliesto: VQ_1C isnot a valid code.

Severity: Error

Cause: The VQ_1C code you have entered was not found in the valid value list PV Q()

Action: Enter avalue provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct vaid value code

R172

Appliesto: VQ_CONFIRM isnot a valid code.

Severity: Error

Cause: The VQ_CONFIRM code you have entered was not found in the valid valuelist PVQ()

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code
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R173

Appliesto: PRCCODE is not a valid code.

Severity: Error

Cause: The PRCCODE code you have entered was not found in the vaid value list PRC

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

R17A

Appliesto: MDL must be null for surrogate analytes.

Severity: Error

Cause: The MDL field is not empty. Thisisincorrect for surrogate result records.
Action: Verify the value of the MDL and PRCCODE fields. Correct as appropriate.

R17B

Appliesto: RL must be null for surrogate analytes.

Severity: Error

Cause: The RL field is not empty. Thisisincorrect for surrogate result records.
Action: Verify the values of the RL and PRCCODE fields. Correct as appropriate.

R17C

Applies to: EXPECTED can not be null for surrogate analytes.

Severity: Error

Cause: The EXPECTED field is empty. Thisisincorrect for surrogate result records.
Action: Verify the value of the EXPECTED and PRCCODE fields. Correct as appropriate.

R18A

Appliesto: EXPECTED and PARVAL must be zero for surrogate records.

Severity: Error

Cause: Surrogate analytes reported with an expected value of 0 should be coded and none
detected, i.e: PARVAL = 0 and PARVQ = ND. The vdue of the PARVAL field is
not 0.

Action: Verify the value of the PARVAL, PRCCODE and EXPECTED fields. Correct as
appropriate.

R18B

Applies to: EXPECTED must be zero and PARVQ must be 'ND' for surrogate records.

Severity: Error

Cause: Surrogate analytes reported with an expected value of 0 should be coded and none
detected, i.e.: parval = 0 and parvg = ND.The value of the PARVAL field is not O.

Action: Verify the value of the PARVQ, PRCCODE and EXPECTED fields. Correct as

appropriate.
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R19

Appliesto: PRCCODE is'STD' and UNITSis'PERCENT' and EXPECTED must be'0' or
'100'.

Severity: Error

Cause: The value of the EXPECTED field is not appropriate for result recads where
PRCCODE is set to STD and UNITS is set to PERCENT.

Action: Verify the value of the EXPECTED, PRCCODE and UNITSfields. Correct as
appropriate.

R20

Applies to: EXPECTED must be null for non-surrogates when SACODE is 'N'.

Severity: Error

Cause: The EXPECTED field is not empty. Thisisincorrect for result records where
PRCCODE is not STD and the SACODE is N.

Action: Verify the value of the EXPECTED and PRCCODE fields. Also verify the value of the
SACODE field in the parent record. Correct as appropriate.

R21

Applies to: EXPECTED can not be null for SACODE other than 'N'.

Severity: Error

Cause: The EXPECTED field is empty. Thisisincorrect for result records where the
SACODE isnot N.

Action: Verify the value of the EXPECTED field. Also verify the value of the SACODE field in
the parent record. Correct as appropriate.

R22

Applies to: EXPECTED must be 0 for non-surrogate analytes when the SACODE
represents a blank.

Severity: Error

Cause: The value in the EXPECTED field is not appropriate for result records where the value
of the PRCCODE field is set to anything but STD and the value of the SACODE
represents a blank, *B.

Action: Verify the value of the EXPECTED and PRCCODE fields. Also verify the value of the
SACODE field in the parent sample record. Correct as appropriate.

R23A

Appliesto: MDL must be null for this PRCCODE.

Severity: Error

Cause: The MDL field is not empty. Thisis incorrect for result records where the value of the
PRCCODE field is set to MI, PM, BAC or STD.

Action: Verify the value of the MDL and PRCCODE fields. Correct as appropriate.
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R23B

Appliesto: RL must be null for this PRCCODE.

Severity: Error

Cause: The RL field isnot empty. Thisis incorrect for result records where the value of the
PRCCODE is set to MI, PM, BAC or STD.

Action: Verify the value of the RL and PRCCODE fields. Correct as appropriate.

R24A

Appliesto: MDL must be null when UNITSis'PERCENT' or 'NONE'.

Severity: Error

Cause: The MDL field is not empty. Thisisincorrect for result records where the value of the
UNITSfield is set to PERCENT or NONE.

Action: Verify the value of the MDL and UNITS fields. Correct as appropriate.

R24B

Appliesto: RL must be null when UNITSis'PERCENT' or 'NONE'.

Severity: Error

Cause: The RL field is not empty. Thisisincorrect for result records where the UNITS field
is set to PERCENT or NONE.

Action: Verify the value of the RL and UNITS fields. Correct as appropriate.

R25A

Appliesto: MDL can not be null for tentatively identified compounds with this
PRCCODE

Severity: Error

Cause: The MDL field isempty. Thisisincorrect for result records where the PRCCODE is
set to anything but STD, MI, PM or BAC.

Action: Verify the value of the MDL and PRCCODE fields. Correct as appropriate.

R25B

Appliesto: RL can not be null for tentatively identified compounds with this PRCCODE

Severity: Error

Cause: The RL field isempty. Thisisincorrect for result records where the PRCCODE is set
to anything but STD, M1, PM or BAC.

Action: Verify the value of the RL and PRCCODE fields. Correct as appropriate.

R26

Appliesto: UNITS are 'PERCENT' the EXPECTED must be '0" or '100' when PRCCODE is
not 'MI', 'PM', 'BAC', or 'STD".

Severity: Error

Cause: The vaue of the EXPECTED field is not appropriate for result records where UNITS is
set to PERCENT and the PRCCODE is not MI, PM, BAC or STD. EXPECTED
should be 0 or 100.

Action: Verify the value of the UNITS and EXPECTED fields. Also, verify the value of the
SACODE field in the parent sample record. Correct as appropriate.
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R27A

Appliesto: MDL must be null when PARVQ is 'TI".

Severity: Error

Cause: The MDL field is not empty. Thisis incorrect for result records where the value of the
PARVQ field is set to TI.

Action: Verify the value of the MDL and PARVQ fields. Correct as appropriate.

R27B

Appliesto: RL must be null when PARVQ is'TI'.

Severity: Error

Cause: The RL field isnot empty. Thisis incorrect for result records where the value of the
PARVQ fieldisset to Tl.

Action: Verify the value of the RL and PARVQ fields. Correct asappropriate.

R27C

Applies to: PRCCODE must be 'HC' or 'ORG' when PARVQ is'TI'.

Severity: Error

Cause: The anayte in this record should not have the value Tl in the PARVQ field. Only
analytes with the PRCCODE HC or ORG may be reported as TICs.

Action: Verify that the values of the PARLABEL and PARVQ fields are correct. If they are,
contact the Help Desk for an appropriate PARVQ.

R28

Appliesto: Normal analytes may not be reported in the units 'PERCENT for this SACCODE.

Severity: Error

Cause: The value PERCENT is not appropriate for the UNITS field in result records where
PRCCODE is not M1, PM, BAC or STD and SACODE is not MS, SD, BS, BD,
RM or KD.

Action: Verify that the values of the PRCCODE, UNITS and SACODE fields. Correct as
appropriate.

R29A

Applies to: PARVAL and PARVQ must be provided for confirmatory resuilts.
Severity: Error

Cause: The VAL_I1C field is not empty. Thisisan error if the VQ_1C field is empty.
Action: Verify the value of both fields. Correct as appropriate.

R29B

Appliesto: PARVAL and PARVQ must be provided for confirmatory results.

Severity: Error

Cause: The VAL_1C field isempty. Thisisincorrect if the VQ_1C column is not empty.
Action: Verify the value of both fields. Correct as appropriate.
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R30A

Appliesto: PARVAL and PARVQ must be provided for confirmatory results.

Severity: Error

Cause: Thereisavaueinthe VAL_CONFIRM column, but the VQ_CONFIRM column is
empty.

Action: Verify the value of the VQ_CONFIRM and VAL_CONFIRM columns. Correct as
appropriate.

R30B

Appliesto: PARVAL and PARVQ must be provided for confirmatory results.

Severity: Error

Cause: Thereisavaueinthe VQ_CONFIRM column, but the VAL_CONFIRM column is
empty.

Action: Verify the value of the VQ_CONFIRM and VAL_CONFIRM columns. Correct as
appropriate.

R31

Appliesto: VAL_CONFIRM invalid when VAL_1C not provided.

Severity: Error

Cause: Thereisavauein the VAL_CONFRM column, but the VAL_1C column is empty.
Action: Verify the value of the VAL_1C and VAL_CONFIRM columns. Correct as

appropriate.

R32

Appliesto: PARVAL must be 0 and PARVQ must be 'ND' when analytes were not detected.

Severity: Error

Cause: The value of the PARVQ must be set to ND if the value of the PARVAL fieldissetto 0
and vice versa.

Action: Verify the value of both fields. Correct as appropriate.

R33

Applies to: PARVAL must be 0 and PARVQ must be 'ND' when analytes were not detected.

Severity: Error

Cause: The value of the PARVQ must be set to ND if the value of the PARVAL fidd isset to 0
and vice versa.

Action: Verify the value of both fields. Correct as appropriate.

R34

Appliesto: PARVALS reported between the MDL and RL must be flagged with the PARVQ
TR'.

Severity: Error

Cause: The value of the PARVAL field must fall between the values of the MDL and RL fields
for al result records reported where the value of the PARVQ field is set to TR.

Action: Verify the value of the PARVAL, MDL, RL and PARVQ fidds.
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R35

Appliesto: PARVAL can not be less than MDL.

Severity: Error

Cause: The vaue of the PARVAL field is less than the value of the MDL field. Results may
not be reported at levels less than the MDL.

Action: Verify the value of both fields. Correct as appropriate.

R38

Appliesto: UNITS must be 'PERCENT' when PARLABEL is'MOIST' or 'SOLID'.

Severity: Error

Cause: The value of the UNITS field must be set to PERCENT for result records where the
value of the PARLABEL field is set to MOIST or SOLID.

Action: Verify the value of the UNITS and PARLABEL fields. Correct as appropriate.

R42

Applies to: PRECISION can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

R43

Applies to: PRECISION is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

R44

Applies to: PRECISION must be between 0 and 4.

Severity: Error

Cause: The value entered in the PRECISION field must be an integer between 0 and 4.
Action: Correct the value entered in the PRECISION fidld.

R45

Applies to: SAMPNO can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

R46

Appliesto: LCHMETH can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

R47

Applies to: EVPREC is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.
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R48

Applies to: EVPREC must be between 0 and 4.

Severity: Error

Cause: The value entered in the EVPREC field must be an integer between 0 and 4.
Action: Correct the value entered in the EVPREC field.

R49

Appliesto: RL is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

R50

Applies to: Numeric value too large. Max value is 9999999999.9999

Severity: Error

Cause: The numeric value entered exceedsthe maximum entry allowed for this field;
9999999999.9999

Action: Verify the accuracy of your entry and correct the data

R51

Appliesto: FCVALPREC is hot a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

R52

Appliesto: FCVALPREC must be between 0 and 4.

Severity: Error

Cause: The value entered in the FCVALPREC field must be an integer between 0 and 4.
Action: Correct the value entered in the FCVALPREC field.

R53

Applies to: CNFVALPREC is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

R54

Appliesto: CNFVALPREC must be between 0 and 4.

Severity: Error

Cause: The vaue entered in the CNFVALPREC column must be an integer between 0 and 4.
Action: Correct the value entered in the CNFVALPREC field.

R55

Appliesto: DILUTION is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.
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R56

Applies to: Numeric value too large. Max value is 99999999.9999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
99999999.9999

Action: Verify the accuracy of your entry and correct the data

R57

Appliesto: DQTYPE is not avalid code.

Severity: Error

Cause: The DQTY PE code you have entered was not found in the valid value list DQT()

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistancein
finding the correct valid value code

R58

Appliesto: QAPPFLAGS is not a valid code.

Severity: Error

Cause: The QAPPFLAGS code you have entered was not found in the valid value list QAP()

Action: Enter a value provided in this VVL or contact the ERPIMSHelp Desk for assistance in
finding the correct valid value code

R59

Appliesto: The PARVQ '%' may not be used for this version of the DLH.

Severity: Error

Cause: The value of the PARVQ field is %. Thisisincorrect for result records where the
value of the PRCCODE is set to STD.

Action: Verify the value of the PARVQ and PRCCODE fields. Correct as appropriate.

R63

Appliesto: MDL can not be zero.

Severity: Error

Cause: The value of the MDL field is set to 0.
Action: Enter a correct value for the MDL field.

R64

Appliesto: RL can not be zero.

Severity: Error

Cause: The vaue of the PQL fidld is set to 0.
Action: Enter a correct value for the PQL field.

R65

Appliesto: MDL must be less than or equal to RL.

Severity: Error

Cause: The value of the MDL field is greater than the vaue of the RL field.
Action: Verify the value of both fields. Correct as appropriate.
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R66

Appliesto: QAPP flag can not be 'J when PARVAL islessthan RL.

Severity: Error

Cause: The value Jis not appropriate for the QAPPFLAGS field when the value of the
PARVAL field isless than the value of the RL field.

Action: Verify the value of the QAPPFLAGS, PARVAL and RL fidds. Correct as appropriate.

R67

Applies to: PARVQ must equa ‘TI' when QAPPFLAGS is equal to 'T'.

Severity: Error

Cause Thevaue T is not appropriate for the QAPPFLAGS field unless the value of the
PARVQ fieldisset to Tl.

Action: Verify the value of the QAPPFLAGS and PARVQ fields. Correct as appropriate.

R68A

Applies to: QAPP flag can not be 'F' if PARVAL islessthanor equa to MDL.

Severity: Error

Cause: The value F is not appropriate for the QAPPFLAGS field when the value of the
PARVAL field isless than or equd to the value of the MDL field.

Action: Verify the value of the QAPPFLAGS, PARVAL and MDL fidlds. Corret as

appropriate.

R68B

Appliesto: QAPP flag can not be 'F' if PARVAL is greater than or equal to RL.

Severity: Error

Cause: The value F is not appropriate for the QAPPFLAGS field when the value of the
PARVAL field is greater than or equa to the value of the RL field.

Action: Verify the value of the QAPPFLAGS, PARVAL and RL fields. Correct as appropriate.

R69

Appliesto: PARVQ must be 'ND' when QAPP flag is'U'.

Severity: Error

Cause: The value U is not appropriate for the QAPPFLAGS field unless the value of the
PARVQ field is set to ND.

Action: Verify the vaue of the QAPPFLAGS and PARVQ fields. Correct as appropriate.

R70

Appliesto: VAL_1C can not be zero when VQ_1C is other than 'ND".

Severity: Error

Cause: The VQ_1C field isnot set to ND. Thisisincorrect for result records where the
VAL _1Cfieldissetto 0.

Action: Verify the value of the VQ_1C and VAL _1C fields. Correct as appropriate.
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R71

Appliesto: VAL_1C must be zero when VQ_1C is'ND".

Severity: Error

Cause: The VAL _1Cfieldisnot set to 0. Thisisincorrect when the VQ 1C column is set to
ND.

Action: Verify the value of both fields. Correct as appropriate.

R72

Appliesto: VAL_CONFIRM can not be zero when VQ_CONFIRM is other than 'ND'.

Severity: Error

Cause: The VQ_CONFIRM column must ke set to ND if the VAL_CONFIRM column is 0.
Action: Verify the value of the VQ_CONFIRM and VAL_CONFIRM columns. Correct as

appropriate.

R73

Appliesto: VAL_CONFIRM must be zero when VQ_CONFIRM is'ND'.

Severity: Error

Cause: The VAL_CONFIRM must be set to 0 if the VQ_CONFIRM column is ND.
Action: Verify the value of the VQ_CONFIRM and VAL_CONFIRM columns. Correct as

appropriate.

R74A

Appliesto: VAL _1C can not be provided for this PRCCODE.

Severity: Error

Cause: The VAL _1Cfield is not empty. Thisis incorrect for result records where the
PRCCODE is not HC, STD or ORG.

Action: Verify the value of the VAL_1C and PRCCODE fields. Correct as appropriate.

R74B

Appliesto: VQ_1C can not be provided for this PRCCODE.

Severity: Error

Cause: The VQ _1C field is nat empty. Thisisincorrect for result records where the
PRCCODE is not HC, STD or ORG.

Action: Verify the value of the VQ_1C and PRCCODE fields. Correct as appropriate.

R75

Appliesto: VAL_1C is not a number.

Severity: Error

Cause: A norn-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

R76

Appliesto: VAL_1C can not be greater than 9,999,999,999.9999.

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
9999999999.9999

Action: Verify the accuracy of your entry and correct the data
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R77

Appliesto: VAL_CONFIRM is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

R78

Appliesto: VAL_CONFIRM can not be greater than 9,999,999,999.9999.

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
9999999999.9999

Action: Verify the accuracy of your entry and correct the data

R79

Appliesto: DQTY PE must be entered when EPA_FLAGS are supplied.

Severity: Error

Cause: The DQTY PE field defines the specific literature reference of the flagging schema used
to qualify analytical data. Only AFCEE, EPA, or State recognized flagging schema
may be used to flag these data.

Action: Enter avalid DQTY PE code. If an appropriate code is not available, contact the
ERPIMS Help Desk for assistance.

R80

Applies to: DQTY PE cannot be set to Q if EPA_FLAGS are supplied.

Severity: Error

Cause: The DQTY PE field defines the specific literature reference of the flagging schema used
to qualify analytical data. Only AFCEE, EPA, or State recognized flagging schema
may be used to flag these data.

Action: Enter avalid DQTY PE code. If an appropriate code is not available, antact the
ERPIMS Help Desk for assistance.

R81

Applies to: The analyte entered is not appropriate for this Analytical Method.

Severity: Error

Cause: The analyte reported cannot normally be analyzed by this method.

Action: Enter the correct PARLABEL. If this does not correct the problem verify that the
PRCCODE for this analyte is correct.

R82

Applies to: Water samples should be reported on a per unit Volume basis
Severity: Error

Cause: The units for the specified record are not appropriate for a water samde.
Action: Enter the correct value in the units field.
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R83

Applies to: Soil samples should be reported on a per unit Weight basis
Severity: Error

Cause: The units for the specified record are not appropriate for a soil sample.
Action: Enter the correct vaue in the units field.

R84

Appliesto: Leachate samples should be reported on a per unit Volume basis

Severity: Error

Cause: The units for the specified record are not appropriate for samples that have been
subjected to a leaching procedure.

Action: Enter the correct value in the units field.

R85

Applies to: Numeric value too large. Max value is 9999999999.9999

Severity: Error

Cause: The numeric value you have entered exceeds the maximum allowed for this field:
9999999999.9999

Action: Verify the accuracy o your entry and correct the data

R86

Applies to: Spike Added precision must be between 0 and 4.
Severity: Error

Cause: Spike Added precision must be between 0 and 4.
Action: Enter a value between 0 and 4.

R87

Applies to: Spike Added cannot be null for surrogates.
Severity: Error

Cause: Spike Added cannot be null for Surrogates.
Action: Enter the amount spiked for this surrogate.

R88

Applies to: % Recovery cannot be null unless Spike Added is O (zero) or Spike Added is Null

Severity: Error

Cause: Percent Recovery must be supplied if an analyte is spiked.

Action: Enter a Percent Recovery result. If the Anayte was not spiked and the SACODE is
that of a spiked sample (MS, SD, FS, BS, BD, RM, or KD) enter zero for the Spike
Added. If the sampleisan FD or LR, leave Spike Added and Percent Recovery
null.

R89

Applies to: Units cannot be PERCENT for this Analyte type.

Severity: Error

Cause: Analytes with the PRCCODE HC, ORG, MET, or STD may not be reported in the units
PERCENT.

Action: Report the Analytes on a per unit volume or mass basis.
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R90

Appliesto: LABSAMPID can not be null

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

R91

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

RO01

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

RO02

Applies to: OUCODE can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

ROO03

Appliesto: RSID can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

RO04

Applies to: RSSTAGE can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

RPO1

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

PAGE 183

7 JuLy 200



F41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

RP02

Appliesto: RSID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

RPO3

Applies to: RSSTAGE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

RP0O4

Applies to: BEGDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

RP05

Appliesto: BEGDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as avalid dde. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

RP06

Applies to: BEGDATE can not be later than validation date.

Severity: Error

Cause: The vaue of the BEGDATE field is earlier than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the BEGDATE field to reflect the actual date the performance period
began.

RPO7

Appliesto: ENDDATE can not be null.

Severity: Error

Cause: Theindicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.
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RP08

Appliesto: ENDDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

RP09

Applies to: ENDDATE can not be later than vaidation date.

Severity: Error

Cause: The value of the ENDDATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to dae. If they are, correct the
vaue of the ENDDATE field.

RP10

Appliesto: PARAMETER is not a valid code.

Severity: Error

Cause: The PARAMETER code you have entered was not found in the valid value list PRF

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

RP11

Appliesto: PARVAL is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

RP12

Applies to: Numeric value too large. Max value is 99999999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
99999999.99

Action: Verify the accuracy of your entry and correct the data

RP13

Appliesto: PARUN is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

PAGE 185



F41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

RP14

Applies to: Numeric value too large. Max value is 99999999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
99999999.99

Action: Verify the accuracy of your entry and correct the data

RP15

Appliesto: UNITS is not avalid code.

Severity: Error

Cause: The UNITS code you have entered was not found in the vdid value list UTR

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

RP18

Applies to: BEGDATE can not be greater than ENDDATE.

Severity: Error

Cause: The value of the BEGDATE fidd is earlier than the value of the ENDDATE fidd.
Action: Enter correct values for both fields.

RP19

Appliesto: PARVAL can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

RP20

Appliesto: UNITS can not be Q

Severity: Error

Cause: The value Q is not appropriate for the UNITS field.
Action: Select the correct value from the AFCEE provided VVL.

RS01

Applies to: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

RS02

Appliesto: RSID can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.
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RSO3

Applies to: RSNAME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

RS04

Appliesto: RSSTAGE is not avalid code.

Severity: Error

Cause: The RSSTAGE cade you have entered was not found in the valid value list RSS

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

RS06

Applies to: RSDESC can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

RS07

Applies to: RSDESC must contain at least 25 characters.

Severity: Error

Cause: The value of the RSDESC field is less than 25 characters long.

Action: Enter a meaningful description for the RSDESC field that is at least 25 characters bng.

RTO1

Applies to: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

RTO2

Applies to: ESTDATE can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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RTO3

Appliesto: ESTDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

RTM4

Applies to: GROUPCODE is not avalid code.

Severity: Error

Cause: The GROUPCODE code you have entered was not found in the valid value list ANG

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

RTO05

Appliesto: MEDIA is not avaid code.

Severity: Error

Cause: The MEDIA code you have entered was not found in the valid value liss MED

Action: Enter avalue provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

RTO06

Appliesto: RSID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

RTO7

Applies to: RSSTAGE can not be null.

Severity: Error

Cause: Theindicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

RTO8

Appliesto: RTCLASS is not avalid code.

Severity: Error

Cause: The RTCLASS code you have entered was not found in the valid value list RTC

Action: Enter avaue provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code
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RTO09

Appliesto: RTID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

RT10

Applies to: RTNAME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

RT11

Appliesto: RTTYPE is not a valid code.

Severity: Error

Cause: The RTTY PE code you have entered was not found in the valid value list RTT

Action: Enter avaue provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

RT12

Appliesto: STARTDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

RT13

Appliesto: STARTDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field canna be interpreted as avalid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY/, the string 4-5-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

RT23

Appliesto: ESTDATE can not be later than STARTDATE.

Severity: Error

Cause: The value of the ESTDATE field is greater than the value of the STARTDATE field.
Action: Verify the value of both fields. Correct as appropriate.
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RT24

Appliesto: RTDESC can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

RT25

Appliesto: RTDESC must contain at least 25 characters.

Severity: Error

Cause: The value of the RTDESC field is less than 25 characters long.

Action: Enter a meaningful description for the RTDESC field that is at least 25 characters long.

RX01

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

RX02

Appliesto: RSID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

RX03

Applies to: RSSTAGE can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

RX04

Appliesto: SITEID isnot avdid code.

Severity: Error

Cause: The SITEID code you have entered was not found in the valid value lig

Action: Enter avaue provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

RX05

Appliesto: SITEID is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

RX06

Appliesto: Numeric value too large. Max value is 999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 999
Action: Verify the accuracy of your entry and correct the data
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S

S06

Applies to: Matrix is not valid for QC samples

Severity: Error

Cause: For prime projects, the value of the MATRIX field is not valid for sample records
where LOCID is set to FIELDQC or LABQC. For Lab projects the value of the
MATRIX field is not valid for samples with a SACODE of AB, EB, TB, LB, BS,
BD, RM, KD.

Action: Enter aMATRIX that is appropriate for this type of sample.

S07

Appliesto: MATRIX is not vaid for non-QC samples

Severity: Error

Cause: For prime projects, the value of the MATRIX field is only valid for sample records
where LOCID is set to FIELDQC or LABQC. For Lab projects the value of the
MATRIX field isonly valid for samples with a SACODE of AB, EB, TB, LB, BS,

BD, RM, KD.
Action: Enter a MATRIX that is appropriate for this type of sample.
S09
Applies to: SACODE must be 'AB', 'EB' or 'TB' when LOCID is'FIELDQC..
Severity: Error
Cause: The only alowed values for the SACODE field in FIELDQC samples are AB, EB and
TB.
Action: Verify the value of the LOCID and SACODE fields. Correct as appropriate.
S10
Applies to: SACODE can not be 'AB', 'EB' or 'TB' when LOCID is not 'FIELDQC'.
Severity: Error

Cause: The values AB, EB and TB are only valid in the SACODE field for FIELDQC samples.
Action: Verify the value of the LOCID and SACODE fields. Correct as appropriate.

S113

Appliesto: LOCID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

S115

Appliesto: MATRIX isnat avalid code.

Severity: Error

Cause: The MATRIX code you have entered was not found in the valid value liss MTX

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code
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S117

Applies to: SACODE is not avdid code.

Severity: Error

Cause: The SACODE code you have entered was not found in the valid value list SA

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

S12

Appliesto: LOGCODE is not a valid code.

Severity: Error

Cause: The LOGCODE code you have entered was not found in the valid value list LOG

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

S121

Applies to: Ambient blank is not associated with a norma sample.

Severity: Error

Cause: No field sample records seem to reference this ambient blank.

Action: Locate the field samples for the sampling event that the ambient blank was used for.
Correct the ABLOT field in these samples to reference the ambient blank.

S122

Applies to: Equipment blank is not associated with a normal sample.

Severity: Error

Cause: No field sample records seem to reference this equipment blank.

Action: Locate the field samples for the sampling event that the equipment blank was used for.
Correct the EBLOT field in these samples to reference the equipment blank.

S123

Appliesto: Trip blank is not associated with a normal sample.

Severity: Error

Cause: No field sample records seem to reference this trip blank.

Action: Locate the field samples for the sampling event that the trip blank was used for.
Correct the TBLOT field in these samples to reference the trip blank.

S125

Applies to: Corresponding TEST records were not found.
Severity: Error

Cause: There are no test records for this sample.

Action: Enter the test records.
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S126

Applies to: Parent Field Sample ID does not point to an existing Field Sample ID

Severity: Error

Cause: The Parent Field Sample ID of the current record does not match the Field Sample ID
entry of any records currently residing in the database.

Action: Enter avalid Field Sample ID, i.e., the Field Sample ID of arecord with the sacode N
that currently exists in the database or that will be entered before a transfer fileis
produced.

S127

Applies to: Parent Lab Sample ID does not point to an existing Lab Sample ID

Severity: Error

Cause: The Parent Lab Sample ID of the current record does not match the Lab Sample ID
entry of any records currently residing in the database.

Action: Enter avalid Lab Sample ID, |.e., the Lab Sample ID of arecord with the sacode LB,
BS, BD, RM, or KD that currently exists in the database or that will be entered
before a transfer file is produced.

S128

Applies to: The Parent Sample for this record does not have a Sample Type of N

Severity: Error

Cause: The Parent Sample for this record, referred to by the entry in the field Parent Field
Sample ID, does not have the Sample Type of N. This sample must be fed to a
valid parent sample with the Sample Type code of N.

Action: Enter the correct Field Sample ID of the parent normal sample in the field Parent Field
Sample ID.

S129

Applies to: The Parent Sample for this record does not have a Sample Type of BS (fa BD
Samples) or RM (for KD Samples)

Severity: Error

Cause: The Parent Sample for this record, referred to by the entry in the field Parent Lab
Sample ID, does not have the Sample Type of BS or RM. This sample must be
tied to avalid parent sample with the Sample Type code of BD or KD respectively.

Action: Enter the correct Lab Sample ID of the parent BS or RM sample in the field Parent Lab
Sample ID.

S13

Appliesto: LOGDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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S14

Appliesto: LOGDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

S15

Applies to: LOGDATE can not be later than vaidation date.

Severity: Error

Cause: The value in the LOGDATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to dae. If they are, correct the
value of the LOGDATE field to reflect the actual date the analysis was performed.

S16

Appliesto: LOGTIME can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

S17

Appliesto: LOGTIME is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

S18

Applies to: SBD can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

S19

Appliesto: SBD is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.
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S20

Applies to: SBD must be zero when LOCID is'FIELDQC..

Severity: Error

Cause: The value of the SBD field isnot 0. Thisisincorrect for sample records where the
value of the LOCID field is set to FIELDQC.

Action: For sample records which do not have a LOCID of FIELDQC, enter a beginning depth
which is greater than 0.

S21

Applies to: Numeric value too large. Max vaue is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

S22

Applies to: SED can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

S23

Appliesto: SED is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

S24

Applies to: SED must be zero when LOCID is'FIELDQC..

Severity: Error

Cause: The value of the SED field isnot 0. Thisisincorrect for sample records where the
value of the LOCID field is set to FIELDQC.

Action: Verify the value of the LOCID and SED fields. Correct as appropriate.

S25

Applies to: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

S27

Applies to: SMCODE is not a valid code.

Severity: Error

Cause: The SMCODE code you have entered was not found in the valid value list SM

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code
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S28

Appliesto: SBD can not be greater than SED.

Severity: Error

Cause: The value of the SBD field is greater than the value of the SED field.
Action: Verify the value of both fields. Correct as appropriate.

S34

Applies to: LOGCODE cannot be set to 'NA' unless thisis a Lab Quality Control sample.

Severity: Error

Cause: The value NA is not appropriate in the LOGCODE field for LABQC sample records.
For prime projects these are records where LOCID is LABQC. For Lab projects
these are records where the SACODE is LB, BS, BD , RM or KD.

Action: Verify the value of both fields. Correct as appropriate.

S35

Applies to: LOGCODE must be set to 'NA' for Lab Quality Control samples.

Severity: Error

Cause: The LOGCODE field must be set to 'NA' for LABQC sample records. For prime
projects these are records where LOCID is LABQC. For Lab projects these are
records where the SACODE isLB, BS, BD , RM or KD.

Action: Verify the value of both fields. Correct as appropriate.

S36

Applies to: SACODE is not appropriate for Lab Quality Control sarrples.

Severity: Error

Cause: The only alowed values for the SACODE fidd in LABQC samples are LB, BS, BD, RM
and KD. For prime projects these are records where LOCID is LABQC. For Lab
projects these are records where the FLDSAMPID is null.

Action: Verify the value of both fields. Correct as appropriate.

S37

Applies to: SACODE is only appropriate for Lab Quality Control samples.

Severity: Error

Cause: The SACODE vaues LB, BS, BD, RM and KD are only appropriate for LABQC
samples. For prime projects these are records where LOCID is LABQC. For Lab
projects these are records where the FLDSAMPID is null.

Action: Verify the value of both fields. Correct as appropriate.

$40

Applies to: SAMPNO can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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A1

Appliesto: SAMPNO is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric vaue in the indicated field.

42

Applies to: Sample humber must be between 1 and 99.

Severity: Error

Cause: The value entered in the SAMPNO field must be an integer between 1 and 99.
Action: Correct the value entered in the SAMPNO field.

S44

Appliesto: ABLOT is not in the required DDMMY Y NN format.

Severity: Error

Cause: The indicated field must have the following format: Date of the related blank in
DDMMYY format plus SAMPNO of the related blank. For example, a sample
related to the third ambient blank taken on 25 Apr 97 should have 25049703 in the
ABLOT fidd.

Action: Enter the ABLOT, TBLOT or EBLOT in the DDMMY Y NN format.

$46

Appliesto: EBLOT isnot in the required DDMMYY NN format.

Severity: Error

Cause: The indicated field must have the following format: Date of the related blank in
DDMMYY format plus SAMPNO of the related blank. For example, a sample
related to the third ambient blank taken on 25 Apr 97 should have 25049703 in the
ABLOT fidd.

Action: Enter the ABLOT, TBLOT or EBLOT in the DDMMY Y NN format.

$48

Appliesto: TBLOT is not in the required DDMMY Y NN format.

Severity: Error

Cause: The indicated field must have the following format: Date of the related blank in
DDMMYY format plus SAMPNO of the related blank. For example, a sample
related to the third ambient blank taken on 25 Apr 97 should have 25049703 in the
ABLOT fidd.

Action: Enter the ABLOT, TBLOT or EBLOT in the DDMMY Y NN format.

$49

Appliesto: FLDSAMPID can not be null when LOCID is not ‘LABQC.

Severity: Error

Cause: The FLDSAMPID field isempty. Thisisincorect for all sample records except those
where the LOCID is set to LABQC.

Action: For sample records which do not have a LOCID of LABQC, enter avalid field sample
ID.
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S50

Applies to: COOLER can not be null when LOCID is not 'LABQC' and TBLOT is not null ad
SACODE isnot 'TB'.

Severity: Error

Cause: The COOLER field isempty. Thisis not correct for samples that are not Trip Blanks,
with a TBLOT entry and LOCID is not set to LABQC.

Action: Verify the vaue of the SACODE, COOLER and LOCID fields. Correct as appropriate.

Sh1

Appliesto: COOLER can not be null when SACODE is TB'.
Severity: Error

Cause: Trip Blanks must be assigned a COOLER ID.
Action: Enter a COOLER ID for this record.

S55

Appliesto: ABLOT must be null when LOCID is'FIELDQC' or 'LABQC..
Severity: Error

Cause: The ABLOT field is not empty. It should be left empty for QC samples.
Action: Clear the ABLOT field.

S56

Appliesto: EBLOT must be null when LOCID is'FIELDQC' or ‘LABQC.
Severity: Error

Cause: The EBLOT field is not empty. It shoud be left empty for QC samples.
Action: Clear the EBLOT field.

S57

Appliesto: TBLOT must be null when LOCID is'FIELDQC' or 'LABQC'.

Severity: Error

Cause: The TBLOT field isempty. Thisisincorrect for sample records where the LOCID is
set to FIELDQC or LABQC.

Action: Verify the value of both fields. Correct as appropriate.

S61

Appliesto: MATRIX "WH' cannot be used for QC samples.

Severity: Error

Cause: The value WH is not appropriate for the MATRIX field in QC sample records. For
prime projects these are records where LOCID is set to FIELDQC or LABQC. For
lab projects these are records where SACODE is AB, EB, TB, LB, BS, BD, RM,
KD.

Action: Verify the value of both fields. Correct as appropriate.
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S63

Appliesto: SMCODE can not be 'NA' when SACODE is'EB'.

Severity: Error

Cause: The value of the SMCODE field is set to NA. Thisisincorrect for sample records
where the value of the SACODE field is set to EB. The SMCODE should reflect
the equipment type on which the rinse was performed.

Action: Verify the value of both fields. Correct as appropriate.

S64

Appliesto: Sample LOGDATE is earlier than Ambient blank LOGDATE.

Severity: Error

Cause: The value in the LOGDATE field for the ambient blank record that is referenced in the
ABLOT field is greater than the LOGDATE of the current record.

Action: Verify that the ABLOT field references the correct ambient blank, and that the
LOGDATE field in both records is correct. Ambient blanks cannot be created after
the sampling event.

S65

Appliesto: Sample LOGDATE is earlier than Equipment blank LOGDATE.

Severity: Error

Cause: The value in the LOGDATE field for the equipment blank record that is referenced in
the EBLOT field is greater than the LOGDATE of the current record.

Action: Verify that the EBLOT field references the correct equipment blank, and that the
LOGDATE field in both records is correct. Equipment blanks cannot be created
after the sampling event.

S67

Appliesto: Parent Lab Sample Id field and Parent Field Sample Id field cannot both be filled in
for this Sample Type

Severity: Error

Cause: Parent Lab Sample Id field and Parent Field Sample Id field cannot both be filled in for
records with the Sample Type code SD, MS, FD, LR, FR, FS, BD or KD.

Action: If the Sample Type code is SD, MS, FD, LR, FR or FS delete the Parent Lab Sample
ID entry. If the Sample Type codeis BD or KD, delete the Parent Field Sample
ID entry..

S68

Applies to: Parent Field Sample Id field cannot be null for this Sample Type

Severity: Error

Cause: The Parent Field Sample ID for this Sample Type code must contain a valid Field
Sample ID that refers to the parent for this record.

Action: Enter avalid Field Sample ID for this record, in the field Parent Field Sample ID.
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S69

Appliesto: Parent Lab Sample Id field cannot be null for this Sample Type

Severity: Error

Cause: The Parent Lab Sample ID for this Sample Type code must contain avalid Lab Sample
ID that refers to the parent for this record.

Action: Enter avalid Lab Sample ID for this record, in the field Parent Lab Sample ID.

S70

Appliesto: Parent Field Sample Id field should be null for this Sample Type

Severity: Error

Cause: Samples with the Sample Type code AB, EB, MB, RB, TB, N, BS, BD, LB, RM or KD
should not contain an entry in the field Parent Field Sample ID.

Action: Delete the entry in the field Parent Field Sample ID.

S71

Applies to: Parent Lab Sample Id field should be null for this Sample Type

Severity: Error

Cause: Samples with the Sample Type code AB, EB, FD, FR, FS, MB, RB, TB, N, RD, BS,
LB, MS, SD, LR or RM should not contain an entry in the field Parent Lab Sample
ID.

Action: Delete the entry in the field Parent Lab Sample ID.

S72

Appliesto: LABSAMPID can not be null

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

S73

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

SCco1

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

SC02

Applies to: GROUPCODE is not avalid code.

Severity: Error

Cause: The GROUPCODE code you have entered was not found in the valid value liss ANG

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code
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SC03

Appliesto: SITEID isnot avaid code.

Severity: Error

Cause: The SITEID code you have entered was not foundin the valid value list

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct vaid value code

SC04

Appliesto: SITEID is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

SC05

Applies to: Numeric value too large. Max value is 999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 999
Action: Verify the accurecy of your entry and correct the data

SO01

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

SO02

Applies to: OUCODE can not be null.
Severity: Error

Cause: OUCODE is arequired field
Action: Enter avalid OUCODE

SO05

Appliesto: SITEID isnot avalid code.

Severity: Error

Cause The SITEID code you have entered was not found in the valid value list

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

SO06

Appliesto: SITEID is not a number.

Severity: Eror

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.
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SO07

Applies to: Numeric value too large. Max value is 999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 999
Action: Verify the accuracy of your entry and correct the data

ST02

Appliesto: ST_UNIT field can not be blank.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

ST03

Appliesto: STRATORDER is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

ST04

Applies to: Numeric value too large. Max value is 999

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 999
Action: Verify the accuracy of your entry and correct the data

ST05

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

ST06

Applies to: STRATORDER can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

T

TO1

Applies to: ANADATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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TO2

Appliesto: ANADATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4-
May-95).

TO3

Applies to: ANADATE can not be later than validation date.

Severity: Error

Cause: The value in the ANADATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correctthe
value of the ANADATE field to reflect the actual date the analysis was performed.

T4

Appliesto: ANADATE can not be earlier than LOGDATE.

Severity: Error

Cause: The vaue in the ANADATE fidd is earlier than the LOGDATE of the parent record.

Action: Verify that the test record is linked to the correct parent. If it is, correct the value of
the ANADATE field to reflect the actual date the analysis was performed.

TO5

Appliesto: ANATIME is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as avalid time.
Action: Enter afour digit number between 0000 and 2359.

TO7

Applies to: ANMCODE is not avalid code.

Severity: Error

Cause: The ANMCODE code you have entered was not found in the valid value ist ANM

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

TO8

Applies to: ANMCODE can not be 'UNK'".

Severity: Error

Causes The ANMCODE field is set to UNK.

Action: Enter a correct value for the ANMCODE field.
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T10

Appliesto: BASISis not avalid code.

Severity: Error

Cause: The BASIS code you have entered was not found in the valid value list BAS

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assstance in
finding the correct vaid value code

T12

Appliesto: EXMCODE is not avalid code.

Severity: Error

Cause: The EXMCODE code you have entered was not found in the valid value list EXM

Action: Enter a value provided in this VVL or contact the ERPIMSHelp Desk for assistance in
finding the correct valid value code

T120

Appliesto: LOCID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

T122

Applies to: MATRIX can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

T125

Applies to: SACODE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

T129

Applies to: LOGDATE can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

T13

Applies to: EXMCODE can not be 'UNK'.

Severity: Error

Cause: The value UNK is not appropriate for the EXMCODE field.
Action: Enter a correct value for the EXMCODE field.
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T130

Appliesto: LOGDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control parel. For
example, if the international date setting is DMY,, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

T132

Appliesto: LOGTIME can not be null.

Severity: Error

Cause: Theindicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

T133

Appliesto: LOGTIME is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

T134

Appliesto: SBD can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

T139

Applies to: SED can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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T14

Appliesto: EXTDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as avalid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 4-5-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeic date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

T148

Applies to: Corresponding RESULT records were not found.
Severity: Error

Cause: There are no result records for this test.

Action: Enter the result recards.

T15

Appliesto: EXTDATE can not be later than validation date.

Severity: Error

Cause: The value in the EXTDATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the EXTDATE field to reflect the actual date the analysis was performed.

T16

Appliesto: EXTDATE can not be earlier than LOGDATE.

Severity: Error

Cause: The vaue of the EXTDATE field is less than the value of the LOGDATE field in the
parent sample record.

Action: Verify the value of the EXTDATE and LOGDATE fields. Correct as appropriate.

T17

Appliesto: EXTTIME is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter a four digit number between 0000 and 2359.

T19

Appliesto: LABCODE is not avaid code.

Severity: Error

Cause: The LABCODE code you have entered was not found in the valid value list LAB

Action: Enter a value provided in this VVL or contact the ERPIMSHelp Desk for assistance in
finding the correct valid value code
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T20

Appliesto: RUN_NUMBER must be between 1 and 99.

Severity: Error

Cause: The value entered in the RUN_NUMBER field must be an integer between 1 and 99.
Action: Correct the value entered in the RUN_NUMBER fidld.

T21

Applies to: ANADATE can not be earlier than EXTDATE.

Severity: Error

Cause: The value in the ANADATE field is earlier than the value in the EXTDATE field.
Action: Verify the values of both fields and enter the correct dates.

T22

Appliesto: EXTDATE can not be null when EXMCODE is not 'NONE'.

Severity: Error

Cause: The EXTDATE field is empty. Thisisincorrect for test records where EXMCODE is
anything but NONE.

Action: Verify the value of the EXTDATE and EXMCODE fields. Correct as appropriate.

T23

Appliesto: LABLOTCTL can not be null when LABCODE is not 'FLD'.

Severity: Error

Cause: The LABLOTCTL field is empty. Thisisincorrect unless the LABCODE field is set to
FLD.

Action: Verify the value of both fields. Correct as approfriate.

T24

Appliesto: LABSAMPID can not be null when LABCODE isnot 'FLD'.

Severity: Error

Cause: The LABSAMPID field isempty. Thisisincorrect unless the LABCODE field is set to
FLD.

Action: Verify the value of both fields. Correct as appropriate.

T26

Appliesto: BASISisinvalid for the MATRIX 'S or 'T".

Severity: Error

Cause: Soil or tissue samples that are not material blanks, that are not subjected to a leaching
procedure and that are not moisture/solids determinations may only be reported
with the matrix W or D.

Action: Verify that the values entered in the BASIS, LCHMETH, ANMCODE and MATRIX
fields are correct.
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T27

Appliesto: BASISisinvdid for the MATRIX 'W', A" or 'G.

Severity: Error

Cause: The value entered in the BASIS field is not apprapriate for the MATRIX values A*, G*
or W* unless the ANMCODE is D2216, E160.1, E160.2, E160.3, E160.4 or
E160.5.

Action: Verify that the values entered in the BASIS, MATRIX and ANMCODE fields are
correct.

T28

Appliesto: MATRIX requires that BASIS equal 'X.

Severity: Error

Cause: The BASIS fidd is not X.

Action: Verify that the rest of the information in the test record and the sampling matrix of the
parent record has been entered correctly. If they are, enter the value X in the
BASIS field.

T30

Appliesto: BASIS isinvalid for leachate method.

Severity: Error

Cause: The value of the BASIS field must be set to X for samples subjected to a leaching
procedure.

Action: Verify the value of both fields. Correct as appropriate.

T31

Applies to: RUN_NUMBER can rot be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

T32

Appliesto: RUN_NUMBER is not a number.

Severity: Error

Cause: A non-numeric value was entered in a rumeric field.
Action: Enter a numeric value in the indicated field.

T33

Applies to: SAMPNO can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

T34

Appliesto: LCHMETH is not avaid code.

Severity: Error

Cause: The LCHMETH code you have entered was not found in the valid value list LCH

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid vdue code
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T35

Appliesto: LCHDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

T36

Appliesto: LCHDATE can not be later than validation date.

Severity: Error

Cause: The valuein the LCHDATE field is greater than your system'’s date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the LCHDATE field to reflect the actual date the analysis was performed.

T37

Appliesto: LCHTIME is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359,

T38

Appliesto: RTTYPE is not a valid code.

Severity: Error

Cause: The RTTY PE code you have entered was not found in the valid value list RTT

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid vaue code

T39

Applies to: ANADATE can not be earlier than LCHDATE.

Severity: Error

Cause; The value in the ANADATE field is earlier than the value in the LCHDATE field.
Action: Verify the values of both fields and enter the correct dates.

T40

Applies to: EXTDATE can not be earlier than LCHDATE.

Severity: Error

Cause: The value of the EXTDATE field is less than the value of the LCHDATE field.
Action: Verify the value of the EXTDATE and LCHDATE fields. Correct as appropriate.
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T41

Appliesto: EXTDATE must be null when EXMCODE is 'NONE'.

Severity: Error

Cause: The EXTDATE is not empty. Thisisincorrect for test records where the value of the
EXMCODE is set to NONE.

Action: Verify the value of the EXTDATE and EXMCODE fields. Correct as appropriate.

T42

Appliesto: LCHDATE must be null when LCHMETH is 'NONE'.

Severity: Error

Cause: The LCHDATE field is not empty. Thisisincorrect if the LCHMETH field is set to
NONE.

Action: Verify the value of both fields. Correct as appropriate.

T43

Appliesto: LCHDATE can not be null when LCHMETH is not 'NONE'.

Severity: Error

Cause: The LCHDATE fied isempty. Thisisincorrect unless the LCHMETH field is set to
NONE.

Action: Verify the value of both fields. Correct as appropriate.

T44

Applies to: Preparation method is invaid for this Analytical method, Matrix and Leachate

Severity: Error

Cause: The preparation method entered is not appropriate for samples that have been subjected
to a leaching procedure.

Action: Enter the correct preparation method

T45

Applies to: Preparation method is invalid for this Analytical method and(or) Matrix.

Severity: Error

Cause: The preparation method entered is not appropriate for this Analytical method and
matrix.

Action: Enter the correct preparation method

T46

Applies to: Preparaion method entered is invalid for this Analytical method when applied to
water quality control samples.

Severity: Error

Cause: The preparation method entered is not appropriate for this Analytical method and
matrix.

Action: Enter the correct preparation method

T47

Applies to: These Preparatory Methods are not allowed

Severity: Error

Cause: Leaching procedures should be reported in the field Leachate Method.
Action: Select a Leachate method code from the valid value list VVVLLCH.
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T48

Appliesto: LABSAMPID can not be null

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

T49

Applies to: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

TOO01

Applies to: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

TOO02

Appliesto: LOCID can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

TOO03

Appliesto: STARTDATE can not be null.

Severity: Error

Cause: Theindicated field is a required field and canna be empty.
Action: Enter a correct value for the indicated field.

TOM
Appliesto: STARTDATE is not in required format.
Severity: Error

7 JuLy 200

Cause: The value entered in the indicated field cannot be interpreted as avalid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For

example, if the international date setting is DMY, the string 45-95 will be

interpreted as 4May-95. (NOTE: Dueto a bug in the Microsoft Access date

conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4

May-95).
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TO06

Appliesto: STARTTIME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

TOO07

Appliesto: STARTTIME is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

TOO08

Appliesto: ENDTIME can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

TO09

Appliesto: ENDTIME is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

TO10

Appliesto: OBS_LOCATION can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

TO11

Applies to: MEASDATE can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

TO12

Appliesto: MEASDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).
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TO13

Applies to: MEASDATE can not be later than vaidation date.

Severity: Error

Cause: The value in the MEASDATE fidd is greater than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the MEASDATE field to reflect the actual date the analysis was
performed.

TO14

Appliesto: MEASTIME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

TO15

Appliesto: MEASTIME is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

TO16

Appliesto: Invalid number.

Severity: Error

Cause: Invalid number.

Action: Enter a valid number for thisfield.

TO17

Applies to: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

TO18

Appliesto: Invaid value.

Severity: Error

Cause: The TRCUNITS code you have entered was not found in the valid value liss UTM

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

TPO2

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.
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TPO3
Applies to: RSID can ot be null.
Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.

Action; Enter a correct value for the indicated field.

TPO4
Applies to: RSSTAGE can not be null.
Severity: Error

Cause: Theindicated field is a required field and cannot be empty.

Action: Enter a correct value for the indicated field.

TPO5
Appliesto: RTID can not be blank.
Severity: Error

Cause: The indicated field is arequired field and cannot be empty.

Action; Enter a correct value for the indicated field.

TPO6
Appliesto: RTTYPE can not be blank.
Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.

Action; Enter a correct value for the indicated field.

TPO7
Appliesto: BEGDATE can not be null.
Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.

Action: Enter a correct value for the indicated field.

TPO8
Appliesto: BEGDATE is not in required format.
Severity: Error

7 JuLy 200

Cause: The value entered in the indicated field cannot be interpreted as avalid dde. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For

example, if the international date setting is DMY, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4

May-95).
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TPO9

Applies to: BEGDATE can not be later than validation date.

Severity: Error

Cause: The value of the BEGDATE field is earlier than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the BEGDATE field to reflect the actual date the performance period
began.

TP10

Appliesto: ENDDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

TP11

Appliesto: ENDDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTo0ls/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY, the string 45-95 will be
interpreted as 4-May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

TP12

Appliesto: ENDDATE can not be later than vaidation date.

Severity: Error

Cause: The value of the ENDDATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to dae. If they are, correct the
value of the ENDDATE field.

TP13

Appliesto: PARAMETER is not avalid code.

Severity: Error

Cause: The PARAMETER code you have entered was not found in the valid vaue list PRF

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

TP14

Appliesto: PARVAL is hot a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.
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TP15

Applies to: Numeric value too large. Max value is 99999999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
99999999.99

Action: Verify the accuracy of your entry and correct the data

TP16

Appliesto: PARVAL is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

TP17

Applies to: Numeric value too large. Max value is 99999999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry alowed for this field;
99999999.99

Action: Verify the accuracy of your entry and correct the data

TP18

Appliesto: UNITS is not avalid code.

Severity: Error

Cause: The UNITS code you have entered was not found in the \alid value list UTR

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

TP21

Appliesto: BEGDATE can not be later than ENDDATE.

Severity: Error

Cause: The value of the BEGDATE field is earlier than the vaue of the ENDDATE field.
Action: Enter correct values for both fields.

TP22

Appliesto: PARVAL can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

TP23

Appliesto: UNITS can not be Q

Severity: Error

Cause: The value Q is not appropriate for the UNITS field.
Action: Select the correct value from the AFCEE provided VVL.
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TRO1

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

TRO2

Appliesto: LOCID can nat be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

TRO3

Appliesto: STARTDATE can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

TRO4

Appliesto: STARTDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, usea non-numeric date value (i.e. 4
May-95).

TRO05

Appliesto: STARTDATE can not be later than validation date.

Severity: Error

Cause: The value in the STARTDATE field is greater than your system's date.

Action: Verify that the date settings in your system ae up to date. If they are, correct the
value of the STARTDATE field to reflect the actua date the analysis was
performed.

TRO06

Appliesto: STARTTIME can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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TRO7

Appliesto: STARTTIME is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

TRO8

Appliesto: ENDTIME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

TRO9

Appliesto: ENDTIME is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

TR10

Appliesto: TRC_CONC is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

TR11

Applies to: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

TR12

Appliesto: TRCUNITS is not a valid code.

Severity: Error

Cause: The TRCUNITS code you have entered was not found in the valid value list UTM

Action: Enter avalue provided in this VVL or contact the ERPIMS Hep Desk for assistance in
finding the correct valid value code

TR13

Appliesto: TRCTYPE is hot avalid code.

Severity: Error

Cause: The TRCTY PE code you have entered was not found in the valid value list TRT

Action: Enter a value provided in this VVL or cantact the ERPIMS Help Desk for assistance in
finding the correct valid value code

TR14

Appliesto: TRCVOL is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.
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TR15

Applies to: Numeric value too large. Max vaue is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

TR18

Appliesto: TRCVOLUNITS is not a valid code.

Severity: Error

Cause: The TRCVOLUNITS code you have entered was not found in the valid value list UTM

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

TWO01

Applies to: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

TWO02

Appliesto: LOCID can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

TWO03

Appliesto: LOGDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

TW04

Appliesto: LOGDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY, the string 4-5-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you till experience problems, use a non-numeric date value (i.e. 4
May-95).

PAGE 219



F41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

TWO06

Appliesto: LOGTIME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

TWO07

Appliesto: LOGTIME is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid time.
Action: Enter afour digit number between 0000 and 2359.

TwWO08

Appliesto: BIDEPTH is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

TWO09

Applies to: Numeric value too large. Max value is 9999999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
9999999.99

Action: Verify the accuracy of your entry and correct the data

TW10

Appliesto: DEPWAT is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

TW11

Applies to: Numeric value too large. Max value is 9999999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
9999999.99

Action: Verify the accuracy of your entry and correct the data

TWI12

Appliesto: FTCODE is not avaid code.

Severity: Error

Cause: The FTCODE code you have entered was not found in the valid value list FTC

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct vaid value code
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TW13

Appliesto: TIDEPTH is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

TW14

Applies to: Numeric value too large. Max value is 9999999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field;
9999999.99

Action: Verify the accuracy of your entry and correct the data

U
\%
W

w1l

Appliesto: GZCCODE is not avalid code.

Severity: Error

Cause: The GZCCODE code you have entered was not found in the valid value list GZC

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

w12

Appliesto: INSDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

W13

Appliesto: INSDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 4-5-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).
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w14

Appliesto: INSDATE can not be later than vaidation date.

Severity: Error

Cause: The value of the INSDATE field is greater than your system's date.

Action: Verify that the date settings in your system are up to date. If they are, correct the
value of the INSDATE field.

W143

Appliesto: LOCID can not be null.
Severity: Error

Cause: LOCID is arequired field
Action: Enter avaid LOCID

W15

Appliesto: MPELEV can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

W16

Appliesto: MPELEYV is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

w17

Appliesto: Numeric value too large. Max vaue is 15000

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 15000
Action: Verify the accuracy of your entry and correct the data

W18

Appliesto: MPELEV can not equal ELEV in LDI.

Severity: Error

Cause: The value in the MPELEV fidd is equal to the value in the ELEV field of the parent
location record. It should be greater or less than ground surface elevation.

Action: Verify the value of both fields. Correct as appropriate.

W24

Applies to;: SAQCODE is not avalid code.

Severity: Error

Cause: The SAQCODE code you have entered was not found in the valid value list SAQ

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct vaid value code
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W45

Appliesto: TOTDEPTH can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

W46

Appliesto: TOTDEPTH is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

W47

Appliesto: TOTDEPTH can not exceed DEPTH in LDI.

Severity: Error

Cause: Total casing depth cannot exceed bore hole depth.

Action: Either the total casing depth (TOTDEPTH) or the borehole depth (DEPTH) is entered
incorrectly. Insure the entries for the fields in question are correct.

w48

Applies to: Numeric value too large. Max value is 9999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 9999.99
Action: Verify the accuracy of your entry and correct the data

W50

Appliesto: WCMCODE is not a valid code.

Severity: Error

Cause: The WCMCODE code you have entered was not found in the valid value list WCM

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

W52

Applies to: WELCODE is not avalid code.

Severity: Error

Cause: The WELCODE code you have entered was not found in the valid value list WEL

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

W54

Applies to: WTCCODE is not avalid code.

Severity: Error

Cause: The WTCCODE code you have entered was not found in the valid value liss WTC

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code
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W69

Applies to: WDPROC is not avaid code.

Severity: Error

Cause: The WDPROC code you have entered was not found in the valid value liss WDP

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assigance in
finding the correct vaid value code

W70

Appliesto: MPFLAG is not avalid code.

Severity: Error

Cause: The vaue of the indicated field did not match one of the valid values specified in that
fieldsVVL.

Action: Correct the value so it matches ane of the entriesin the VVL or ask an ERPTOOLS/PC
administrative user to add the new vaue to the VVL.

w71

Applies to: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

w101

Applies to: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

W102

Appliesto: LOCID can not be null.

Severity: Error

Cause: The indicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

WI106

Appliesto: IBDEPTH can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

WI107

Appliesto: IBDEPTH is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.
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W108

Applies to: Numeric value too large. Max vaue is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

WI109

Appliesto: IEDEPTH can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

WI10

Appliesto: IEDEPTH is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

wWi11

Applies to: Numeric value too large. Max vaue is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

Wi112

Appliesto: CLASS is hot avdid code.

Severity: Error

Cause: The CLASS code you have entered was not found in the valid value list CLA

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

WI13

Appliesto: MATERIAL is not avalid code.

Severity: Error

Cause: The MATERIAL code you have entered was not found in the valid value list MAT

Action: Enter avaue provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct vaid value code

WI114

Appliesto: SDIAM is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

WI115

Appliesto: Numeric value too large. Max value is 99.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99.99
Action: Verify the accuracy of your entry and correct the data
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WI116

Appliesto: SOUA is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

WI17
Appliesto: Numeric value too large. Max value is .999
Severity: Error

7 JuLy 200

Cause: The numeric value entered exceeds the maximum entry allowed for this field; .999

Action: Verify the accuracy of your entry and correct the data

WI118

Applies to: PCTOPEN is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

w119
Applies to: Numeric value too large Max value is 99.99
Severity: Error

Cause: The numeric vaue entered exceeds the maximum entry allowed for this field; 999.99

Action: Verify the accuracy of your entry and correct the data

w122

Appliesto: PCTOPEN should not normally be greater than 55.
Severity: Warning

Cause: The value of the PCTOPEN field is greater than 55%.
Action: Enter a correct value for this field.

w123
Appliesto: IBDEPTH can not be zero when CLASS is 'SCRN'.
Severity: Error

Cause; The IBDEPTH field isset to 0. Thisisincorrect for records where CLASS is set to

SCRN.

Action: Verify the vaue of the IBDEPTH and CLASS fields. Correct as appropriate.

wi24

Applies to: IEDEPTH can not be less than zero.

Severity: Error

Cause: The vaue of the IEDEPTH field must be a positive number.
Action: Enter a correct value for IEDEPTH.

W125
Appliesto: IBDEPTH can not be less than zero.
Severity: Error

Cause: The vaue of the IBDEPTH field must be a positive number.

Action: Enter a correct value for IBDEPTH.
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W126

Applies to: PCTOPEN must be null when CLASS is not 'SCRN'.

Severity: Error

Cause: The PCTOPEN field is not empty. Thisisincorrect unless the value of the CLASS
field is set to SCRN.

Action: Verify the value of the PCTOPEN and CLASS fields. Correct as appropriate.

w127

Applies to: SOUA must be null when CLASS is not 'SCRN'.

Severity: Error

Cause: The SOUA field is not empty. Thisisincorrect for well interval records where the
vaue of the CLASS field is not SCRN.

Action: Verify the value of both fields. Correct as appropriate.

w128

Appliesto: CLASS requires that SDIAM must be null.

Severity: Error

Cause: The SDIAM field is not empty. Thisisincorrect for well interval records where the
value of the CLASSfield is set to SEAL, GROUT, FILPK or FOOT.

Action: Verify the value of both fields. Correct as appropriate.

w129

Applies to: SDIAM can not be null when CLASS is 'BLANK'.

Severity: Error

Cause: The SDIAM field isempty. Thisisincorrect for well interval records where the value
of the CLASSfidd is set to BLANK.

Action: Verify the value of both fields. Correct as appropriate.

W130

Appliesto: SOUA can not be null when CLASS is'SCRN'.

Severity: Error

Cause: The SOUA field isempty. Thisisincorrect for well interval records where the value of
the CLASS fidld is set to SCRN.

Action: Verify the value of both fields. Correct as appropriate.

Wi31

Applies to: PCTOPEN can not be null when CLASS is'SCRN'.

Severity: Error

Cause: The PCTOPEN field is empty. Thisisincorrect for well interval records where the
vaue of the CLASSfield is set to SCRN.

Action: Verify the value of the PCTOPEN and CLASS fields. Correct as appropriate.

W32

Appliesto: SDIAM can not be null when CLASS is'SCRN'.

Severity: Error

Cause: The SDIAM field isempty. Thisisincorrect for well interval recads where the value
of the CLASS field is set to SCRN.

Action: Verify the value of both fields. Correct as appropriate.
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WI133

Applies to: SCRNO can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

W134

Appliesto: SCRNO is not a number.

Severity: Error

Cause: A nor-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

WI135

Applies to: SCRNO must be between 1 and 9.

Severity: Error

Cause: The value entered in the SCRNO field must be an integer between 1 and 9.
Action: Correct the value entered in the SCRNO field.

W136

Appliesto: IBDEPTH can not be equal to IEDEPTH.

Severity: Error

Cause: The value of the IBDEPTH and IEDEPTH fields cannot be the same.

Action: Verify that the values entered in the IBDEPTH and IEDEPTH fields are correct.

W37

Applies to: SCRNO should not normally be greater than 4 for a standard single or double

screened well.
Severity: Warning
Cause: The SCRNO is greater than 4.
Action: Enter the correct value for SCRNO.

WMO01

Appliesto: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

WMO02

Appliesto: LOCID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

WMO4

Applies to: LOGDATE can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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WMO05

Appliesto: LOGDDATE is not in required format.

Severity: Error

Cause: The value entered in the indicated field cannot be interpreted as a valid date. When you
enter an al-numeric date value, ERPTools/PC attempts to interpret it according to
the international short date settings found in the Windows(r) control panel. For
example, if the international date setting is DMY,, the string 45-95 will be
interpreted as 4May-95. (NOTE: Due to a bug in the Microsoft Access date
conversion functions, the YMD format is not supported in this version).

Action: Check your Windows(r) date settings for the correct format to enter numeric date
values. If you still experience problems, use a non-numeric date value (i.e. 4
May-95).

WMO06

Appliesto: MTYPE is not avalid code.

Severity: Error

Cause: The MTY PE code you have entered was not found in the valid value liss WMT

Action: Enter a value provided in this VVL or contact the ERPIMS Help Desk for assistance in
finding the correct valid value code

WMO7

Appliesto: ELEV can not be null.

Severity: Error

Cause: Theindicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.

WMO08

Appliesto: ELEV is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric vaue in the indicated field.

WMO09

Applies to: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for this field; 99999.99
Action: Verify the accuracy of your entry and correct the data

WM10

Applies to: MPELEV can not be null.

Severity: Error

Cause: The indicated field is a required field and cannot be empty.
Action: Enter a correct value for the indicated field.
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WM11

Appliesto: MPELEYV is not a number.

Severity: Error

Cause: A non-numeric value was entered in a numeric field.
Action: Enter a numeric value in the indicated field.

WM12

Appliesto: Numeric value too large. Max value is 99999.99

Severity: Error

Cause: The numeric value entered exceeds the maximum entry allowed for thisfield; 99999.99
Action: Verify the accuracy of your entry and correct the data

X

X03

Applies to: BEGDEPTH should not normally be less than previous record's ENDDEPTH.

Severity: Warning

Cause: The value in the BEGDEPTH field is greater than the value of theENDDEPTH field in
the previous record.

Action: Verify the values of both fields and correct as necessary.

X05

Applies to: Ambient blank record was not found.

Severity: Error

Cause: The ambient blank sample referenced by the ABLOT field does not exist.
Action: Enter a correct value for the ABLOT fidld.

X06

Applies to: SAMPNO does not start with 1 or is not continuous.

Severity: Error

Cause: The SAMPNO assigned to this record is out of sequence or does not start at one.
Refer to the Data Loader's Handbook for the current AFCEE policy on SACODE
assignment.

Action: Modify the SACODEs of the affected records to comply with AFCEE policy.

X15

Applies to: Parent record with the SACODE 'N' is missing.

Severity: Error

Cause: A sample record where the value of the SACODE field is set to RD must have a related
sample record with the same key fields where the value of the SACODE field is set
to N. The regulatory duplicate record is derived from the normal record.

Action: Verify the value of the AFIID, LOCID, LOGDATE, LOGTIME, MATRIX, SBD, SED,
SACODE and SAMPNO fields in both records. Correct as appropriate.
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X16

Applies to: Parent record with the SACODE 'MS' is missing.

Severity: Error

Cause: A test record where the value of the SACODE field is set to SD must have a réated test
record with the same key fields where the value of the SACODE field is set to MS.
The spike duplicate record is derived from the matrix spike record.

Action: Verify the value of the AFIID, LOCID, LOGDATE, LOGTIME, MATRIX, SBD, SED,
SACODE, SAMPNO, ANMCODE, EXMCODE, LCHMETH, RUN_NUMBER and
LABCODE fields in both records. Correct as appropriate.

X17

Applies to: Parent record with the SACODE 'RM" is missing.

Severity: Error

Cause: A test record where the value of the SACODE field is set to KD must have a related
test record with the same key fields where the value of the SACODE field is set to
RM. The reference material duplicate record is derived from the reference material
record.

Action: Verify the value of the AFIID, LOCID, LOGDATE, LOGTIME, MATRIX, SBD, SED,
SACODE, SAMPNO, ANMCODE, EXMCODE, LCHMETH, RUN_NUMBER and
LABCODE fieldsin both records. Correct as appropriate.

X19

Applies to: Parent record with the SACODE 'BS' is missing.

Severity: Error

Cause: A test record where the value of the SACODE field is set to BD must have arelated test
record with the same key fields where the value of the SACODE field is set to BS.
The blank spike duplicate record is derived from the blank spike record.

Action: Verify the value of the AFIID, LOCID, LOGDATE, LOGTIME, MATRIX, SBD, SED,
SACODE, SAMPNO, ANMCODE, EXMCODE, LCHMETH, RUN_NUMBER and
LABCODE fields in both records. Correct as appropriate.

X20

Applies to: Equipment blank record was not found.

Severity: Error

Cause: The equipment blank sample referenced by the EBLOT field does not exist.
Action: Enter a correct value for the EBLOT field.

X21

Appliesto: Trip blank record was not found.

Severity: Error

Cause: The trip blank sample referenced by the TBLOT field does not exist.
Action: Enter a correct value for the TBLOT fidd.
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X22

Applies to: SAMPNO does not start with 1 or is not continuous for FIELDQC records.

Severity: Error

Cause: The SAMPNO assigned to this record is out of sequence or does not start at 1. Refer
to the Data Loader's Handbook for the current AFCEE policy on SACODE
assignment.

Action: Modify the SACODEsS of the affected records to comply with AFCEE policy.

X23

Applies to: FIELDQC records are duplicated on the same LOGDATE except for LOGTIME.

Severity: Error

Cause: There is more than one sample record where the value of LOCID is set to FIELDQC
with the same LOGDATE, MATRIX, SBD, SED, SACODE and SAMPNO (every
key field except for LOGTIME).

Action: Verify the value of the AFIID, LOCID, LOGDATE, MATRIX, SBD, SED, SACODE
and SAMPNO fields. Correct as appropriate.

X24

Applies to: Coordinate pairs indicate that these locations are more than 750 miles apart.

Severity: Error

Cause: The entries for the east and north coordinates may be incorrect.

Action: Verify the east and north coordinates and insure they are valid and correct entries.
Check to make sure that the coordinate type is the same for this pair of locations.

X25

Applies to: WCI information is usually supplied only for records with the LTCCODE WL, SV,
AV, IP, EP and AS.

Severity: Warning

Cause: Usualy, WCI records are supplied only for records with the LTCCODE AS, AV, EP,
IP, SV, WL.

Action: Ensure the LTCCODE of the LDI record is correct. If so, ignore this warning and
provide an explanation in your transmittal letter.

X26

Applies to: MPELEV can not change more than 15 feet from the original measurement.

Severity: Error

Cause: The difference between the MPELEV field in the WCI table and the one in the WMI
table is more than 15 feet.

Action: Verify the value of both fields. Correct as appropriate.

X27

Appliesto: ELFLAG is'Y' but WMI record with a different ELEV was not found.

Severity: Error

Cause: No related records were found in the WMI table. If the ELFLAG is set to True, the
new elevation must be entered in WMI for this record.

Action: Make sure there is an entry in the Well maintenance table with a modified value in the
ELEV field. If elevation has not changed for this record, set the flag to false.

PAGE 232



FA41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

X28

Appliesto: MPFLAG is'Y" but WMI record with a different MPELEV was rot found.

Severity: Error

Cause: No related records were found in the WM table. If the MPFLAG is set to True, the
new measuring point elevation must be entered in WMI for this record.

Action: Make sure there is an entry in the Well maintenance table witha modified value in the
MPELEV field. If measuring point elevation has not changed for this record, set
the flag to false.

X29

Appliesto: CASDIAM must be 4 inches smaller than BHDIAM.

Severity: Warning

Cause: The difference between the Casing diameter and borehole diameter is less than 4
inches.

Action: Verify the vaue of the SDIAM and BHDIAM fields (BHDIAM isin the LDI table).
Correct if appropriate.

X30

Appliesto: IEDEPTH can not be greater than DEPTH in LDI.

Severity: Error

Cause: The value of the IEDEPTH field is greater than the value of the DEPTH field in the
parent location record.

Action: Verify the value of both fields. Correct as appropriate.

X31

Appliesto: OBS_LOCATION isnot in LDI.

Severity: Error

Cause: A parent location record where the value of the LOCID equals the value of the
OBS _LOCATION field was not found.

Action: Enter a correct value in the OBS LOCATION field.

X32

Appliesto: OBS LOCATION isnot in LDI.

Severity: Error

Cause: A parent location record where the value of the LOCID equals the value of the
OBS LOCATION field was not found.

Action: Enter a correct value in the OBS LOCATION field.

X33

Applies to: Should normally have a parent record in WCI data.

Severity: Warning

Cause: A parent record with the same LOCID does not exist in the WCI table.

Action: Verify the value of the LOCID field. If correct, create the well record in WCI.
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X34

Applies to: Must have corresponding datain RTI when RTTY PE is not equal to 'NA'".

Severity: Error

Cause: A record with the same RTTY PE must exist in the RTI table when the value of the
value of the RTTY PE field is anything but NA.

Action: Verify the value of the RTTYPE field. If correct, create the technology record in RTI.

X35

Applies to: SDIAM should not normally be less than 2 inches when WTCCODE in WCI is
"MNW".

Severity: Warning

Cause: The value of the SDIAM field islessthan 2. Thisisincorrect for well records where
the value of the WTCCODE field is set to MNW.

Action: Verify the value of both fields. Correct if appropriate.

X36
Applies to: IBDEPTH can not be greater than IEDEPTH.
Severity: Error

Cause: The value of the IBDEPTH field is greater than the value of the IEDEPTH field.
Action: Verify the value of both fields. Correct as appropriate.

X37

Appliesto: IEDEPTH can not be greater than TOTDEPTH in WCI when CLASS is not
'FILPK".

Severity: Error

Cause: The value of the IEDEPTH field is greater than the value of the TOTDEPTH field in the
parent well record. Thisisinvalid for all classes except 'FILPK".

Action: Verify the value of both fields. Correct as appropriate.

X39

Applies to: Coordinate pairs indicate that these locations are less than 1 foot apart.

Severity: Warning

Cause: The distance between the two indicated locations is |ess than one foot..

Action: Verify the value of the NCOORD and ECOORD fields in both records. Correct as
appropriate. If the datais correct, ignore this warning.

X41

Applies to: Should normally have a parent record in WCI data.

Severity: Warning

Cause: A parent record with the same LOCID does not exist in the WCI table.

Action: Verify the value of the LOCID field. If correct, create the well record in WCI.

X42

Applies to: Should normally have a parent record in WCI data.

Severity: Warning

Cause: A parent record with the same LOCID does not exist inthe WCI table.

Action: Verify the value of the LOCID field. If correct, create the well record in WCI.
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X43

Applies to: Should normally have a parent record in WCI data.

Severity: Warning

Cause: A parent record with the same LOCID does not exist in the WCI table.

Action: Verify the value of the LOCID field. If correct, create the well record in WCI.

X44

Applies to: LTCCODE of parent record in LDI should normally be "WL'".

Severity: Warning

Cause: The value of the LTCCODE in the parent location record is not WL.

Action: Verify the value of the LOCID and LTCCODE fields in the parent location record.
Correct as appropriate.

X45

Appliesto: LTCCODE of parent record in LDI should normally be "WL".

Severity: Warning

Cause: The value of the LTCCODE in the parent location record is not WL.

Action: Verify the value of the LOCID and LTCCODE fields in the parent location record.
Correct as appropriate.

X46

Applies to: LTCCODE of parent record in LDI should normally be 'WL".

Severity: Warning

Cause: The vaue of the LTCCODE in the parent location record is not WL.

Action: Verify the value of the LOCID and LTCCODE fields in the parent location record.
Correct as appropriate.

X47

Applies to: LTCCODE of parent record in LDI should normally be 'WL".

Severity: Warning

Cause The value of the LTCCODE in the parent location record is not WL.

Action: Verify the value of the LOCID and LTCCODE fields in the parent location record.
Correct as appropriate.

X48

Appliesto: LTCCODE is'WL' but WCI record was not found.

Severity: Warning

Cause: The value of the LTCCODE field is set to WL and there are no child records in the
WCI table.

Action: Verify the value of the LOCID and LTCCODE fields. If correct, create the well
definition records in WCI and WINT.

X50

Appliesto: LCHDATE can not be earlier than LOGDATE.

Severity: Error

Cause: The value of the LCHDATE is earlier than the value in the LOGDATE field of the
parent sample record.

Action: Verify the value of both fields. Correct as appropriate.
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X51

Appliesto: RUN_NUMBER does not gart with 1 or is not continuous in TEST.

Severity: Error

Cause: Run numbers must start at 1 and increment in a continuous fashion (i.e. 2, 3,4 ..).

Action: Verify the value of the RUN_NUMBER field for the set of test records with the same
AFIID, LOCID, LOGDATE, LOGTIME, MATRIX, SBD, SED, SACODE,
SAMPNO, ANMCODE, EXMCODE, LCHMETH and LABCODE. Correct as

appropriate.

X52

Applies to: The associated BS or RM parent Test record is missing

Severity: Error

Cause: A parent Test Procedures record was not found for this sample with the same
Anaytical method, Prep Method, Leachate method, and Run_Number.

Action: Duplicates, replicates and(or) spikes must contain the same key field information in
order for them to be linked to each other for QC purposes. Correct éther the
parent or child records so that the key fields of the parent will match the child.
Duplicates, replicates and(or) spikes without parent records may not be submitted.

X53

Applies to: Must have a parent record with the SACODE 'N' in TEST.

Severity: Error

Cause: A test record where the value of the SACODE field is set to FD, FS, FR, LR or MS
must have a related test record with the same key fields where the value of the
SACODE field isset to N. The indicated record is derived from the normal record.

Action: Verify the value of the AFIID, LOCID, LOGDATE, LOGTIME, MATRIX, SBD, SED,
SACODE, SAMPNO, ANMCODE, EXMCODE, LCHMETH, RUN_NUMBER and
LABCODE fields in both records. Correct as appropriate.

X55

Applies to: Spike Added cannot be null for MS, SD, BS, BD, FS, RM, or KD samples
Severity: Error

Cause: Spike Added must be supplied for samples with this sacode.

Action: If the an Analyte was not spiked enter O, otherwise enter the amount spiked.

X56

Applies to: SOUNDING can not be greater than ABS (WCI.MPELEV - LDI.ELEV) +
WCI.TOTDEPTH.

Severity: Error

Cause: The value of the SOUNDING field is greater than the difference between the MPELEV
and the ELEV fields plus the value of the TOTDEPTH field in the parent well
record. (NOTE: If available, the most recent values for ELEV and MPELEV in the
WMI table are used for this calculation).

Action: Verify the value of the SOUNDING, MPELEV, ELEV, TOTDEPTH, MPFLAG and
ELFLAG fields. Correct as appropriate.
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X57

Applies to: BEGDATE can not be earlier than ESTDATE.

Severity: Error

Cause: The vaue of the BEGDATE fidd is earlier than the value of the ESTDATE in the parent
record.

Action: Enter correct values for both fields.

X58

Appliesto: BEGDATE can not be earlier than STARTDATE.

Severity: Error

Cause: The value of the BEGDATE fidld is earlier than the value of the STARTDATE in the
parent record.

Action: Enter correct values for both fields.

X59

Appliesto: Must have corresponding datain LTX.

Severity: Error

Cause: A record with the same LOCID must exist in the LTX table when the value of the
RTTYPE field is set to anything but NA.

Action: Verify the value of the LOCID and RTTYPE fields. If correct, create the cross
reference record in LTX.

X60

Applies to: SCRNO does not start at 1 or is not continuous for this locdion.

Severity: Error

Cause: Screen numbers must start at 1 and increment in a continuous fashion (i.e, 2, 3, 4 ...).

Action: Verify the value of the SCRNO field for the set of well interval records with the same
AFIID and LOCID. Correct as appropriate

X61

Applies to: IBDEPTH of blank casing is greater than IBDEPTH of screen or well foot.

Severity: Error

Cause: A blank casing segment cannot start below the screen or the well foot within the same
well interval.

Action: Verify the value of the IBDEPTH and SCRNO fields for the blank casing, screen and
well foot segments. Correct as appropriate.

X62

Appliesto: IEDEPTH of blank casing is greater than IEDEPTH of screen or well foot.

Severity: Error

Cause: A blank casing segment cannot end below the screen or the well foot within the same
well interva.

Action: Verify the value of the IBDEPTH, IEDEPTH and SCRNO fields for the blank casing,
screen and well foot segments. Correct as appropriate.
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X63

Appliesto: IBDEPTH of filter pack is less than IEDEPTH of seal or grout.

Severity: Error

Cause: A filter pack segment cannot start above the seal or grout.

Action: Verify the value of the IBDEPTH, IEDEPTH and SCRNO fields for the filter pack, seal
and grout segments. Correct as appropriate.

X64

Appliesto: IBDEPTH d filter pack is greater than IBDEPTH of screen.

Severity: Error

Cause: A filter pack segment cannot start below the screen within the same well interval.

Action: Verify the value of the IBDEPTH and SCRNO fields for the filter pack and screen
segments. Correct as appropriate.

X65

Appliesto: IEDEPTH of filter pack is greater than IEDEPTH of well foot.

Severity: Warning

Cause: A filter pack segment cannot end below the well foot.

Action: Verify the value of the IEDEPTH and SCRNO fields for the filter pack and well foot
segments. Correct as appropriate.

X66

Appliesto: IBDEPTH of well foot is less than IEDEPTH of screen or blank casing.

Severity: Error

Cause: A well foot segment cannot start above the screen or blank casing.

Action: Verify the value of the IBDEPTH, IEDEPTH and SCRNO fields for the well foot,
screen and blank casing segments. Correct as appropriate.

X67

Appliesto: IEDEPTH of grout is greater than IBDEPTH of sed or filter pack.

Severity: Error

Cause: A grout segment cannot end below the seal or the filter pack within the same well
interval.

Action: Verify the value of the IBDEPTH, IEDEPTH and SCRNO fields for the grout, seal and
filter pack segments. Correct as appropriate.

X68

Applies to: IBDEPTH of screen is less than IEDEPTH of seal or grout.

Severity: Error

Cause: A screen segment cannot start above the grout or the seal within the same well interval.

Action: Verify the value of the IBDEPTH, IEDEPTH and SCRNO fields for the screen, sed
and grout segments. Correct as appropriate.
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X69

Applies to: IEDEPTH of screen is greater than IEDEPTH of filter pack.

Severity: Error

Cause: A screen segment cannot end below the filter pack within the same well interval.

Action: Verify the value of the IEDEPTH and SCRNO fields for the screen and filter pack
segments. Correct as appropriate.

X70

Appliesto: IBDEPTH of sedl is less than IEDEPTH of grout or IBDEPTH of blank casing.

Severity: Error

Cause: A seal segment cannot start above the grout or blank casing within the same well
interval.

Action: Verify the value of the IBDEPTH, IEDEPTH and SCRNO fields for the seal, grout and
blank casing segments. Correct as appropriate.

X71

Appliesto: IEDEPTH of sea is greater than IEDEPTH of blank casing.

Severity: Error

Cause: A seal segment cannot end below the blank casing within the same well interval.

Action: Verify the value of the IEDEPTH and SCRNO fields for the seal and blank casing
segments. Correct as appropriate.

X72

Appliesto: IBDEPTH isless than IBDEPTH of preceding screened interval.

Severity: Error

Cause: Segments from different screened intervals cannot overlap.

Action: Verify the value of the IBDEPTH, IEDEPTH and SCRNO fields on the indicated
record. Correct as appropriate.

X73

Appliesto: IBDEPTH of blank casing is less than IEDEPTH of screenfor preceding screened
interval.

Severity: Error

Cause: A blank casing segment cannot start before the ending depth of a previous screen.

Action: Verify the value of the IBDEPTH, IEDEPTH and SCRNO fields for the blank casing
and screen segments. Correct a appropriate.

X74

Appliesto: SDIAM is greater than BHDIAM in LDI.

Severity: Error

Cause: The value of the SDIAM field is greater than the value of the BHDIAM field in the
parent location record.

Action: Verify the value of both fields. Correct as approfriate.
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X75

Applies to: Ground surface elevation cannot change more than 15 feet from original
measurement.

Severity: Error

Cause: The difference between the ELEV field in the LDI table and the one in the WINT table
is more than 15 feet.

Action: Verify the value of both fields and correct.

X76

Applies to: Derived sample records do not have the same cooler and FIEL DQC associations as
the parent normal.

Severity: Error

Cause: Derived samples must have vaues in the FIELDQC association fields (ABLOT,
EBLOT, TBLOT and COOLER) if the parent normal does.

Action: Make sure the derived sample has values in the same lot and cooler fields as the parent
normal does. These do not have to be the same va ues as the parent normal.

X77

Appliesto: SED is greater than DEPTH in LDI.

Severity: Error

Cause: The value of the SED field is greater than the value of the DEPTH field in the parent
location record.

Action: Verify the values of the SED and DEPTH fields. Correct as appropriate.

X78

Applies to: Spike Added must be null for non-surrogate AB, EB, TB, FD, FR, LR, MB, RB, N,
or RD samples.

Severity: Error

Cause: Spike Added must be null for Analytes except surrogates with the sacodes AB, EB,
TB, FD, FR, LR, MB, RB, N, or RD.

Action: Delete the Spike Added value.

Y
4

Z01

Applies to: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If it is, correct the AFIID of the
erroneous record to match the project AFIID.

202

Applies to: ZONEID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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Z03

Applies to: ZNAME can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.

ZL01

Applies to: AFIID does not match submission AFIID.

Severity: Error

Cause: The AFIID field in the current record does not match the project AFIID.

Action: Verify that the correct file is being imported. If itis, correct the AFIID of the
erroneous record to match the project AFIID.

ZL02

Appliesto: LOCID can not be null.

Severity: Error

Cause: The indicated field is areguired field and cannot be empty.
Action: Enter a correct value for the indicated field.

ZL04

Applies to: ZONEID can not be null.

Severity: Error

Cause: Theindicated field is arequired field and cannot be empty.
Action: Enter a correct value for the indicated field.
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Acronym Meaning
AFCEE Air Force Center for Environmental Excellence
CERCLA Public Law 96-510, the Comprehensive Environmental Response,
Compensation and Liability Act of 1980
DLH Data Loading Handbook
ERP Environmental Resources Program
ERPIMS Environmental Resources Program Information Management System
MAJCOM Major Commands
MHz Megahertz
MS Microsoft
MSC Mission Support Computer
NCP National Contingency Plan
PC Personal Computer
RAM Random Access Memory
SARA Public Law 99-499, Superfund Amendments and Reauthorization Act of
1986
SQL Structured Query Language
VGA Video Graphics Adapter
VWL Valid Values List
IRP Installation Restoration Program
IDEFO Integration Definition for Function Modeling
IDEF1X Integration Definition for Information Modeling
IRS Interface Requirements Specification
URL Uniform Resource Locator
Short Titles of ERPTools/PC Tables
(See Section 11 Table Descriptions)
ATI LSX PROJECT RSX STU WMI
CALC LTD PUMPINT RTI TEST ZDI
EMI LTX PUMPRATE | RTP TOW ZLX
GWD MRI RESULT SAMPLE TRI
HSU ou ROX SCC TWI
LDI oucC RSI SLX WCI
LOX OwWL RSP SOX WINT
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11. TABLE DESCRIPTIONS

NOTE: Fieldsin boldface are required key fields of the table.

11.1 CommMON TABLE FIELDS

All tableswill have the following five fields. These are system fields and are unavailable for

editing.

Field Name VVL Definition

RECNO Auto-generated number by the system.

VALSTATUS The validation status of the record.

SUBMDATE The date the record was submitted.

UPUSER The last user to insert or edit the record.

UPDATE The date and time the record was inserted or edited.

11.2 LABPROJECT TABLES
These are the tables and fields you will seein a Lab project.

11.2.1 SAMPLE (Sample Collection)

Reports information regarding a water, soil, or environmental sampling event.

FHeld Name VVL Definition

LABSAMPID Laboratory Sample Identification.

MATRIX VVLMTX Coded value identifying the sample medium actually being
analyzed, (e.g., soil, water, etc.).

LOGDATE The date the sample was taken.

LOGTIME The time the sample was taken.

SACODE VVLSA A coded value identifying whether the sample is QC or normal
and the type is QC.

SAMPNO This is the numeric portion of the Sample Type.

LOGCODE VVLLOG LOGGING COMPANY CODE: Coded value identifying the
company performing field tests.

FLDSAMPID Unique number assigned to the sample in the field.

COCID Unique identification reference to the chain of custody
describing the transport of the sample to the laboratory.

COOLER The unique number assigned to the cooler transporting the
sample.

PARENTFLDID FLDSAMPID of the parent record

PARENTLABID LABSAMPID of the parent record

REMARKS Comment about the sample.
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11.2.2 TEST (Test Procedure)

Information on test preparation and procedures for an environmental sample.

Field Name VVL Definition

LABSAMPID Laboratory Sample Identification.

MATRIX VVLMTX Coded value identifying the sample medium actually being
analyzed, (e.g., soil, water, etc.).

ANMCODE VVLANM | ANALYTICAL METHOD CODE: Coded value representing the
method of analysis of a given parameter.

EXMCODE VVLEXM EXTRACTION METHOD CODE: Coded value representing the
method used to extract or prepare a sample.

LCHMETH VVLLCH Coded value identifying the leachate method.

RUN_NUMBER This information is stored in the Test Procedure class and is
replaced by the use of Test Sequence.

LABCODE VVLLAB Analytical Laboratory Code. Coded value identifying the
analytical laboratory that performed the analysis of a sample.

EXTDATE Preparation date is a more general identifier to indicate
extractions or other preparation methods. For compatibility
with DESCIM.

EXTTIME Preparation time is a more general identifier to indicate
extractions or other preparation methods. For compatibility
with DESCIM.

LCHDATE Date the sample was leachated.

LCHTIME Time the sample was leachated.

LCHLOT The batch designator of an autonomous group of
environmental samples and associated QC samples leached
together.

ANADATE Date the sample or extraction is analyzed in the laboratory.

ANATIME Time the sample or extraction is analyzed in the laboratory.

ANALOT The batch designator of an autonomous group of
environmental samples and associated QC samples
analyzed together.

LABLOTCTL Preparation Lot is a more general identifier to indicate
extractions or other preparation methods. Was AFCEE
Analytical Batch in ERPTools/LAB.

CALREFID A coded value that establishes a reference link between
environmental and QC samples and their corresponding
calibration records. Was IMCID in ERPTools/LAB

BASIS VWWLBAS Basis. For tissue or solid samples enter whether results are
reported on a wet (W) or dry (D) basis.
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11.2.3 RESULT (Analytical Result)

Information on analytical results of an environmental sampling test procedure.

Field Name VVL Definition

LABSAMPID Laboratory Sample Identification.

MATRIX VVLMTX Coded value identifying the sample medium actually being
analyzed, (e.g., soil, water, etc.).

ANMCODE VVLANM | ANALYTICAL METHOD CODE: Coded value representing the
method of analysis of a given parameter.

EXMCODE VVLEXM EXTRACTION METHOD CODE: Coded value representing the
method used to extract or prepare a sample.

LCHMETH VVLLCH Coded value identifying the leachate method.

RUN_NUMBER This information is stored in the Test Procedure class and is
replaced by the use of Test Sequence.

PARLABEL VWLPAR PARAMETER LABEL CODE: An abbreviated, common
acronym representing a parameter/analyte.

PRCCODE VVLPRC PARAMETER CLASS CODE: Coded value identifying a class
or group that a parameter is associated with (e.g. ORG, MET,
STD, etc.).

PARVQ WLPVQ PARAMETER VALUE QUALIFIER: Coded value qualifying the
analytical results field (PARVAL).

PARVAL PARAMETER VALUE: value of calculated parameter reported
in units consistent with UNITMEAS.

PARUN A value that measures the uncertainty of the analytical test
(expressed as + or - some value.).

PRECISION Number indicating the precision (number of digits after the
decimal point) of the results.

SPIKEADDED Amount that the sample was spiked. Inthe UNITS field
specify the actual units of measure used.

EXPECTED The target result for a quality control sample or surrogate
spike.

SPIKEADDEDPREC Number indicating the precision (number of digits after the
decimal point) of the spike results.

MDL METHOD DETECTION LIMIT - The smallest quantity of an
analyte that can be detected from a prepared sample subject
to the applied analytical method.

RL REPORTING LIMIT - The applicable reporting limit for the
project. If the project is following the AFCEE QAPP, the QAPP
will give the AFCEE reporting limit or there will be an AFCEE
approved, project specific reporting limit.

UNITS VVLUTM UNITS OF MEASURE: Units of measure used for the
parameter value.

vVQ_1C WLPVQ FIRST COLUMN VALUE QUALIFIER: A coded value qualifying
the VAL_1C field.

VAL_1C Field that represents the primary or initial value for a analyte
generated from a Gas Chromatography or Gas
Chromatography / Mass Spectroscopy results.

FCVALPREC Number indicating the precision (number of digits after the
decimal point) of the results.
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Field Name VVL Definition

VQ_CONFIRM VVLPVQ Code value qualifying the confirming analytical result.

VAL_CONFIRM VAL _CONFIRM: The CONFIRMING VALUE of a
chromatographic analytical result that requires second
column confirmation.

CNFVALPREC Number indicating the precision (number of digits after the
decimal point) of the results.

DILUTION Numeric expression of the amount of dilution required to bring
the analyte concentration in the sample into analysis range.

DQTYPE VWLDQT A code identifying the type ofdata qualifier.

EPA FLAGS Codes that are assigned during chemistry data validation.

QAPPFLAGS VWWLQAP A coded value assigned to analytical results during laboratory

or validation review.

PERCENT_RECOVERY

Percent of the amount spiked that was recovered (Not
Submitted to AFCEE)

RPD

Relative percent difference (Not Submitted to AFCEE)

UPPER_ACCURACY

Upper accuracy established for this analyte (Not Submitted to
AFCEE)

LOWER_ACCURACY

Lower accuracy established for this analyte (Not Submitted to
AFCEE)

11.3 PRIMEPROJECT TABLES

These are the tables and fields you will see in a Prime project.

11.3.1 PROJECT (Contract)
A PC-only table with the contract information needed by ERPTools/PC.

Field VVL Definition

PROJECT_NAME User defined name for the project. This field is normally used
to differentiate between quarterly monitoring projects where
the AFIID, CONTRACT_ID and DO_ID are the same.

AFIID VVLAFI AIR FORCE INSTALLATION IDENTIFICATION: Unique code
used to representan Air Force installation, plant, or base.

CONTRACT Contract number, consisting of a fiscal year and contract
sequence number (i.e., F33615-84-D-4402).

DO Sequential identifier assigned to the Air Force form “Orders for

Supplies and Services.”
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Genera information about sampling locations.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

LTCCODE VVLLTC LOCATION CLASSIFICATION CODE: Coded value describing
location where measurements or samples are taken.

LPRCODE VVLLPR Location Proximity Code. Coded value indicating whether
sampling or measuring location is within or outside the Air
Force installation boundaries.

NCOORD NORTH STATE PLANE COORDINATE: The yvalue (North-
South) of the distance in feet of a sampling or measuring
location from the reference location of known state plane
coordinates.

ECOORD EAST STATE PLANE COORDINATE: The xvalue (EastWest)
of the distance in feet of a sampling or measuring location
from the reference location of known state plane coordinates.

CRDTYPE VVLCRT | The type of coordinate system used.

CRDMETH VVLCRD | Indicates the method used to determine the location (e.g.,
survey, GPS, estimated, digitized).

CRDUNITS VWLUTM Units of measure of the surveyed northing and easting values.

CRDUN The expression of the precision of the location coordinates.

ESTDATE DATE ESTABLISHED: The date that construction of a
sampling or measuring location was completed.

ESCCODE VVLESC ESTABLISHING COMPANY CODE: Coded value identifying the
organization that establishes a sampling or measuring
location, typically the prime contractor.

DRLCODE VVLDRL DRILLING COMPANY CODE: Coded value identifyingthe
organization that drilled a borehole at a sampling or
measuring location. This organization is typically the drilling
subcontractor.

EXCCODE VVLEXC EXCAVATING COMPANY CODE: Coded value identifying the
organization that excavated a test pit at a sampling or
measuring location.

CMCCODE VWLCMC [ CONSTRUCTION METHOD CODE: Coded value identifying
the method by which a borehole or test pit was constructed
(Drilling or Excavation Method).

ELEV SURFACE ELEVATION: Elevation of ground surface (for
groundwater, soil, or sediment sampling) or water surface (for
surface water sampling) at a sampling or measuring location.

ELEVMETH VVLELM Method used in to determine the location’s elevation.

ELEVUNITS VVLUTM The unit that the elevation was measured.

ELEVUN The expression of the precision of the location elevation.

ELFLAG Flag that indicates whether or not more current

measurements for the Ground Surface Elevation are available
in the Well Maintenance table.

PAGE 247




F41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

Field Name VVL Definition

DEPTH BOREHOLE DEPTH: The total depth of a borehole (including
boreholes drilled to install wells) measured in feet relative to
ground surface.

BHDIAM BOREHOLE DIAMETER: The diameter of a borehole in inches.

BHANGLE Angle at which borehole was drilled.

BHAZIM Azimuth (degrees on a compass) of which the borehole was
drilled.

DATUM Identifier representing the geodetic datum used in the survey

(e.g., State Plane Coordinate System NAD 1983, Florida
Western Zone).

STPZONE VVLSTZ The coordinate zone needed in order for the Geodetic Datum
attribute to make sense. For Compatibility with DESCIM.

STPPROJ VVLSTP Geographic projection used by the state planar system.

UTMZONE VWLUTZ The coordinate zone needed in order for the Geodetic Datum
attribute to make sense. For Compatibility with DESCIM.

GEOLOG Contains the reference to any/all geophysical logs created
during drilling operations.

LOCDESC LOCATION DESCRIPTION: Any additional information to

describe a sampling or measuring location in text format.

11.3.3 SLX (Location Site Cross Reference)
Information about a site and location that has been selected for ERP study.

Field Name VVL Definition
SITEID VVLGSI Number that uniquely identifies a site.
LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a

location within a USAF installation where measurements or
samples are taken.

GFCCODE VVLGFC GEOHYDROLOGIC FLOW CLASSIFICATION: The GFCCODE
is a single character that describes the hydrologic relationship
between a location and a site.

SPCODE VVLSPR A coded value indicating whether the locaion is in the site,
outside the site or background.

11.3.4 SCC (Site Contamination)

Definition of the type of contamination at asite. Thisis usually based on the preliminary
assessment.

Field Name VVL Definition

GROUPCODE VVLANG GROUP CODE: A unigue code that identifies a group of
environmental contaminants, (e.g., CHLOR, SOLVENT, PEST).

SITEID VVLGSI Number that uniquely identifies a site.
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11.3.5 ZDI (Zone)

User defined groupings of sampling locations.

Field Name VVL Definition

ZONEID Unique identifier for a group of individual locations maintained
for collective study and evaluation.

ZNAME Name of the zone.

ZONEDESC Textual description of the zone and its purpose.

11.3.6 ZL X (Location Zone Cross Reference)

Cross-reference table between sampling locations and zones.

Field Name VVL Definition

ZONEID Unique identifier for a group of individual locations maintained
for collective study and evaluation.

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a

location within a USAF installation where measurements or
samples are taken.

11.3.7 MRI (Map Reference)
Description of the physical map of an installation.

Field Name VVL Definition

MAPRID Unique identifier assigned to each map for an installation.

MAPCODE VWLMAP Coded value identifying the company responsible for
producing a map of a designated area.

MTCCODE VVLMTC Coded value identifying the type of map.

MCCCODE VVLMCC [ Coded value delineating the extent to which a reference map

covers specified features associated with a site, zone, or
entire installation.

MAPSCALE The drawing scale of a map expressed as inches of drawing
per feet of terrain.

LLNORTH The lower left y-value of a general area of interest.

LLEAST The lower left x-value of a general area of interest.

URNORTH The upper right y-value of a general area of interest.

UREAST The upper right x-value of a general area of interest.

BMDESIG Code, label, name, etc. of a benchmark.

BMNORTH The y-value of a map benchmark.

BMEAST The x-value of a map benchmark.

BMELEV The ground surface elevation of a map benchmark.

MAPDESC Textual description of the mapped area.
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Contains well placement and completion information.

Field Name

VVL

Definition

LOCID

LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

INSDATE

INSTALLATION DATE: Date that a well casing is installed.

WELCODE

VVLWEL

WELL OWNER CODE: Coded value identifying the owner of a
well that is monitored or tested.

WTCCODE

WLWTC

WELL TYPE CLASSIFICATION CODE: Coded value identifying
the type of well in which the measurements are being taken
(e.g., slugged, observation).

WCMCODE

VVLWCM

WELL COMPLETION METHOD CODE: Coded value identifying
the method used to complete the well or the nature of the
openings that allow water to enter the well.

GZCCODE

WLGZC

Geologic Completion Zone. General Zone hydrologic
description of well completion zone.

SAQCODE

VWLSAQ

SOLE SOURCE AQUIFER CODE: Coded value identifying the
sole source aquifer in which the well was completed.

WDPROC

VVLWDP

Indicates the type of well development procedures used.

MPELEV

MEASURING POINT ELEVATION: Elevation of the
measurement reference point used for groundwater deph
level measurements, expressed in feet above Mean Sea
Level.

MPFLAG

Flag that indicates whether or not more current Flag
measurements for the Point Elevation are available in the Well
Maintenance table.

TOTDEPTH

TOTAL CASING DEPTH: Total depth in feet(positive value)
below land surface of well casing including screen, blank
casing and well foot.

REMARKS

Textual description to provide any additional information
necessary to understand the characteristics of the well casing
interval.
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11.3.9 WINT (Well Construction Interval)

Definition of each well interval.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

CLASS VVLCLA Classification of the casing interval. May be seal, screen, well
foot, blank, or filter pack.

SCRNO Identifier used to group segments belonging to the same
screened interval.

IBDEPTH Depth in feet to the top of the described interval.

IEDEPTH Depth in feet to the bottom of the described interval.

MATERIAL VWLMAT The material being used for well casing or construction
includes grout, filter pack, screen, well seal, etc.

SDIAM The inside diameter of the well casing being described. For
screen intervals, itis the inside diameter of the screen.

SOUA SCREEN SLOT SIZE: Vertical size of slot opening in inches.

PCTOPEN PERCENT OPEN AREA: Percent of screened interval that is
open for water flow.

REMARKS Textual description to provide additional information
necessary to understand the characteristics of the well casing
interval.

11.3.10 WMI (Well Maintenance)

Historical log of maintenance activities at each well.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

LOGDATE LOG DATE: Starting date that a sample is collected, a field test
is performed, or a QC Sample is created.

MTYPE VWLWMT [ The type of maintenance performed on the well.

MPELEV MEASURING POINT ELEVATION: Elevation of the

measurement reference point used for groundwater depth
level measurements, expressed in feet above Mean Sea
Level.

ELEV SURFACE ELEVATION: Elevation of ground surface (for
groundwater, soil, or sediment sampling) or water surface (for
surface water sampling) at a sampling or measuring location.

REMARKS Textual description of the well maintenance.
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11.3.11 LTD (Lithologic Description)
Lithologic descriptions and classifications of cuttings and cores teken from boreholes and test

pits.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

BEGDEPTH BEGINNING DEPTH: Upper depth of a lithologic stratum,
measured below the ground surface in feet (reported as a
positive value).

ENDDEPTH END DEPTH: Lower depth of a lithologic stratum, measured
below the ground surface in feet (reported as a positive value).

LOGDATE LOG DATE: Starting date thata sample is collected, a field test
is performed, or a QC sample is created.

LOGCODE VVLLOG LOGGING COMPANY CODE: Coded value identifying the
company performing field tests.

LITHCODE VVLLTH LITHOLOGY CODE: 4-Character code indicating lithologic
description of layer.

ASTMCODE VVLAST ASTM Soil Classification Code. A 2 or 4 character code used
in ASTM classification of unconsolidated deposits. Deposits
possessing characteristics of two groups are designated by
combinations of groups.

HS UNIT HSU Working name given to the unit.

ST _UNIT STU Descriptive name given to the unit.

VISDESC VISUAL DESCRIPTION: Textural and mineralogical

description of the material comprising the layer, to augment or
qualify the lithologic codes.

11.3.12 STU (Stratigraphic Unit)

Definition of the units in the interpreted stratigraphic column for an installation.

Field Name VVL Definition

ST_UNIT Descriptive name given to the unit

STRATORDER Number assigned to the unit by the interpreting geologist; unit
1 is the oldest; the number decreases with age.

GRPNAME Name of the geological group of which the unit is a part.

FORMATION Name of the geological formation of which the unit is a part.

MBRNAME Name of the geological member of which the unit is a part.

BEDNAME Name of the geological bed of which the unit is a part.

SUDESC Textual description of the stratiographic unit.
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11.3.13 HSU (Hydrostratigraphic Unit)
Data for a body of rock with lateral extent that composes a geologic framework for a

hydrologic system.

Field Name VVL Definition

HS UNIT Working name given to the unit.

HSTYPE VVLLTH Soil or rock classification for the type of soil/rock that
comprises this hydrostratigraphic unit.

HSDESC Textual description of the hydrostratigraphic unit.

11.3.14 CALC (Calculated Hydrology)
Parameters that are calculated or obtained from aquifer and tracer tests, such as pump or slug

tests.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

LOGDATE The starting date of the aquifer test that is being taken.

LOGTIME The starting time of the aquifer test that is being taken.

TESTMETH WLTMT The type of test that is being performed on the well for which
the calculation is being made.

CALCMETH VWLCMT The type of method used to calculate the results (e.g., Theis,
Theim, Chow, Hantush-Jacob, etc.).

CALCPARCODE VVLCPC [ The type of result of the calculation (e.qg., transmissitivity,
hydraulic conductivity, storage coefficient, etc.).

LOGCODE VWLLOG LOGGING COMPANY CODE: Coded value identifying the
company performing field tests.

PARVAL The value of the calculation result.

UNITS VVLUTM The units used for the calculation result.

WELLDIST The distance from the pumping well to the observation well.
Leave this field blank for version 4.0 ERPTools submissions.

WTDEPTH The estimated depth of the water table used for the
calculation; this value would be the top of a confined aquifer.

AQTHICK The assumed saturated thickness of the aquifer used to
perform the calculation.

AQBASEDEPTH The estimated depth of the aquifer used to make the
calculation.

SUPPDATA VVLSPD Indicates that primary data (e.g., pump test or slug test data)
supporting the calculation are available.

REMARKS Comments concerning the calculation, including definitions or

explanations for constants, variables, or assumptions used to
derive the result.
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11.3.15 GWD (Groundwater Level)
Specific test data to determine the groundwater level over time at a location.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

LOGDATE LOG DATE: Starting date that a sample is collected, a field test
is performed, or a QC sample is created.

LOGTIME LOG Time: Starting time that a sample is collected, a field test
is performed, or a QC sample is created.

IBDEPTH The upper depth of the interval being tested (commonly
corresponds to screen interval).

IEDEPTH The lower depth of the interval that is being tested (commonly
corresponds to screen interval).

LOGCODE VVLLOG LOGGING COMPANY CODE: Coded value identifying the
company performing field tests.

STATDEP STATIC WATER DEPTH: Depthto water in feet measured from
the measuring point.

SOUNDING SOUNDING: Total depth to the bottom of well in feet at time of
test, measured from the reference point.

FTCODE VVLFTC Coded value indicating whether the liquid level in the well is
groundwater or some immissible nonaqueous liquid.

MEASMETH WLMMT Coded value representing the method used to make the
measurement.

DRY Y/N flag indicating whether the well is dry.

REMARKS Textual comment describing the groundwater measurement

level.

11.3.16 ATI (Aquifer Test)
Data describing an aguifer pump, slug or tracer test used to determine aquifer attributes.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurement or
samples are taken.

LOGDATE LOG DATE: Starting date that a sample is collected, a field test
is performed, or a QC sample is created.

LOGTIME LOG TIME: Starting time that a sample is collected, a field test
is performed, or a QC sample is created.

LOGCODE VVLLOG LOGGING COMPANY CODE: Coded value identifying the
company performing field tests.

HEADDIR VVLCHD [ The direction of the observed or expected well drawdown trend
during a slug or aquifer test. This may be expressed as rising
head, falling head, drawdown, residual, or recovery.

SLUGVOL SLUG VOLUME: The volume of a slug used to displace
groundwater during a slug test.

UNITS VVLUTM The units in which the volume of the slug was measured.
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M easurements of the change in pump rate over time.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

LOGDATE LOG DATE: Starting date that a sample is collected, a field test
is performed, or a QC sample is created.

LOGTIME LOG TIME: Starting time that a sample is collected, a field test
is performed, or a QC sample is created.

STARTDATE The initial date the pump rate was measured.

STARTTIME The initial time the pump rate was measured.

ENDDATE The ending date the pump rate was measured.

ENDTIME The ending time the pump rate was measured.

PUMPRATE The measured rate of the pump.

UNITS VWLUTM The units used to measure the pump rate.

REMARKS Comments describing the pump rate.

11.3.18 TWI (Test Well)
Specific data for pump test wells.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

LOGDATE LOG DATE: Starting date that a sample is collected, a field test
is performed, or a QC Sample is created.

LOGTIME LOG TIME: Starting time that a sample is collected, a field test
is performed, or a QC Sample is created.

TIDEPTH The upper depth of the interval being tested.

BIDEPTH The lower depth of the interval that is being tested.

DEPWAT Depth to fluid in feet measured from the measuring point.

FTCODE VWLFTC Coded value indicating whether the liquid level in the well is
groundwater or some immissible nonaqueous liquid.

REMARKS A textual description to aid in the understanding of the well
test.
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11.3.19 OWL (Observation Well Water Level)
Wil fluid measurements collected during timed intervals.

Field Name VVL Definition

LOCID Name of a location on an installation.

OBS LOCATION Name of a location on an installation.

LOGDATE LOG DATE: Starting date that a sample is collected, a field test
is performed, or a QC sample is created.

LOGTIME LOG TIME: Starting time that a sample is collected, a field test
is performed, or a QC sample is created.

MEASDATE Date the fluid level measurement was taken. Generally, the
fluid level will be groundwater.

MEASTIME Time the fluid level measurement was taken. Generally, the
fluid level will be groundwater.

DEPWAT The depth from the measuring point to the top of the fluid in
the well bore. These measurements will include the water
level at the beginning of the test (time=0). These
measurements are used to calculate drawdown.

FTCODE VVLFTC The type of fluid encountered in the well. This would normally
be groundwater. If another type of fluid is encountered in the
well bore during the test, then it should be noted here and
explained in the comments.

WTCCODE VWLWTC | WELL TYPE CLASSIFICATION CODE: Coded value identifying
the type of well in which the measurements are being taken
(e.g., slugged, observation).

REMARKS Comments concerning the drawdown measurements.

11.3.20 TRI (Tracer Injection)
Definition of the tracer fluids injected into a well during well tests.

Field Name VVL Definition

LOCID Name of a location on an installation.

STARTDATE Date that the tracer test was conducted.

STARTTIME The time that the tracer injection was started.

ENDTIME The time that the tracer injection was completed.

TRC_CONC The value of the concentration of the tracer that was injected
into the well.

TRCUNITS VWLUTM The units of measurement for the tracer concentration value.

TRCTYPE VVLTRT The type of tracer that was used for the tracer test.

TRCVOL The volume of the tracer that was used for the tracer test.

TRCVOLUNITS VWLUTM The units of measurement for the tracer volume.

REMARKS Textual annotation that aids the understanding of the tracer

test.
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11.3.21 TOW (Tracer Observation Well)

Information on observation wells sampled during a tracer test.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

STARTDATE Date that the tracer test was conducted.

STARTTIME The time that the tracer injection was started.

ENDTIME The time that the tracer injection was completed.

OBS LOCATION Location name for the observation well.

MEASDATE Date that the observation well was measured.

MEASTIME Time that the observation well was measured.

TRC_CONC The value of the concentration of the tracer that was injected
into the well.

TRCUNITS VWLUTM The units of measurement for the tracer concentration value.

11.3.22 PUMPINT (Pumping Interval)

Definition of the operation of an extraction or injection well over time.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

BEGDATE The starting date the pumping was performed.

BEGTIME The starting time the pumping was performed.

ENDDATE The ending date the pumping was performed.

ENDTIME The ending time the pumping was performed.

BEGDEPTH The upper depth of the interval being tested

ENDDEPTH The lower depth of the interval that is being tested.

LOGCODE VVLLOG LOGGING COMPANY CODE: Coded value identifying the
company performing field tests.

WTCCODE VWLWTC WELL TYPE CLASSIFICATION CODE: Coded value identifying

the type of well in which the measurements are being taken
(e.g., slugged, observation).

PUMPDEPTH The depth of the pump.

PUMPINGRATE The rate the well was pumped.

UNITS VVLUTM The units the discharge was measured in (e.g., gal/min).
REMARKS Comments describing the pumping.
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11.3.23 EMI (Environmental M easurement)
Result information for tests that fall outside the category of standard analytical testing.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

LOGDATE The date the sample was taken.

LOGTIME The time the sample was taken.

MATRIX VVLMTX SAMPLING MATRIX: Coded value identifying the sample
medium actually being analyzed (i.e., soil, water, etc.).

SBD The top of the interval from which the sample was collected or
recovered, expressed in feet relative to mean sea level.

SED If the sample is recovered from an interval, the bottom of the

interval the sample was recovered from. Intervals are
measured as elevation. Elevation uses mean sea level as
datum. Intervals below mean sea level are positive.

ANADATE The starting date of the sample test. This attribute is used if
the samples are related to an aquifer test or tracer test. A
series of samples taken at different times can be related
using the start date and times.

ANATIME The starting time of the sample test. This attribute is used if
the samples are related to an aquifer test or tracer test.

ANATYPE VVLANT The type of test being performed on the sample (e.g., air
sampling, water velocity, soil sample, well bore fluid sample,
etc.).

PARVAL The value of the test result.

UNITS VVLUTM The units of the result test.

QUALIFIER VVLEDQ | Data Qualifier.

REMARKS Comments to clarify the sample test.
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11.3.24 SAMPLE (Sample Collection)

Reports information regarding a water, soil, or environmental sampling event.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

LOGDATE The date the sample was taken.

LOGTIME The time the sample was taken.

MATRIX VVLMTX Coded value identifying the sample medium actually being
analyzed, (e.g., soil, water, etc.).

SBD SAMPLE BEGINNING DEPTH: The upper depth in feet from
the ground surface or the water surface at which a sample is
collected.

SED SAMPLE ENDING DEPTH: Lower depth in feet at which a soil
sample is collected for analysis, relative to the ground surface.

SACODE VVLSA A coded value identifying whether the sample is QC or normal
and the type is QC.

SAMPNO This is the numeric portion of the Sample Type.

LOGCODE VVLLOG LOGGING COMPANY CODE: Coded value identifying the
company performing field tests.

SMCODE VVLSM Coded value identifying the sampling method used to collect a
sample.

FLDSAMPID Unique number assigned to the sample in the field.

COCID Unique identification reference to the chain of custody
describing the transport of the sample to the laboratory.

COOLER The unique number assigned to the cooler transporting the
sample.

ABLOT Ambient Blank Field Lot Identifier.

EBLOT Equipment blank field lot identifier.

TBLOT Test Blank Field Lot Identifier.

REMARKS Comment about the sample.
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11.3.25 TEST (Test Procedure)

Information on test preparation and procedures for an environmental sample. The fieldsin
BOLD ITALICS are a secondary index on this table.

Field Name VVL Definition

RECNO (PK) This is a system generated number

SAMPLE_RECNO This is the RECNO from the parent Sample record

ANMCODE VVLANM ANALYTICAL METHOD CODE: Coded value representing the
method of analysis of a given parameter.

EXMCODE VWLEXM EXTRACTION METHOD CODE: Coded value representing the
method used to extract or prepare a sample.

LCHMETH VVLLCH Coded value identifying the leachate method.

LABCODE VVLLAB Analytical Laboratory Code. Coded value identifying the
analytical laboratory that performed the analysis of a sample.

RUN_NUMBER This information is stored in the Test Procedure class and is
replaced by the use of Test Sequence.

LABSAMPID Laboratory Sample Identification.

EXTDATE Preparation date is a more general identifier to indicate
extractions or other preparation methods. For compatibility
with DESCIM.

EXTTIME Preparation time is a more general identifier to indicate
extractions or other preparation methods. For compatibility
with DESCIM.

LCHDATE Date the sample was leachated.

LCHTIME Time the sample was leachated.

LCHLOT The batch designator of an autonomous group of
environmental samples and associated QC samples leached
together.

ANADATE Date the sample or extraction is analyzed in the laboratory.

ANATIME Time the sample or extraction is analyzed in the laboratory.

ANALOT The batch designator of an autonomous group of
environmental samples and associated QC samples
analyzed together.

LABLOTCTL Preparation Lot is a more general identifier to indicate
extractions or other preparation methods.

CALREFID A coded value that establishes a reference link between
environmental and QC samples and their corresponding
calibration records.

RTTYPE VWLRTT Type of remediation technology (e.g., slurry wall, in situ Type
vitrification, bio-reactor).

BASIS VVLBAS Basis. For tissue or solid samples enter whether results are
reported on a wet (W) or dry (D) basis.
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11.3.26 RESULT (Analytical Result)
Information on analytical results of an environmental sampling test procedure.

Field Name VVL Definition

TEST_RECNO This is the RECNO fromthe parent Test record

PARLABEL VWLPAR PARAMETER LABEL CODE: An abbreviated, common
acronym representing a parameter/analyte.

PRCCODE VVLPRC | PARAMETER CLASS CODE: Coded value identifying a class
or group that a parameter is associated with (e.g. ORG, MET,
STD, etc.).

PARVQ WLPVQ PARAMETER VALUE QUALIFIER: Coded value qualifying the
analytical results field (PARVAL).

PARVAL PARAMETER VALUE: value of calculated parameter reported
in units consistent with UNITMEAS.

PARUN A value that measures the uncertainty of the analytical test
(expressed as + or - some value.).

PRECISION Number indicating the precision (number of digits after the
decimal point) of the results.

EXPECTED The target result for a quality control sample or surrogate
spike.

EVPREC Number indicating the precision (number of digits after the
decimal point) of the results.

MDL METHOD DETECTION LIMIT - The smallest quantity of an
analyte that can be detected from a prepared sample subject
to the applied analytical method.

RL REPORTING LIMIT - The applicable reporting limit for the
project. If the project is following the AFCEE QAPP, the QAPP
will give the AFCEE reporting limit or there will be an AFCEE
approved, project specific reporting limit.

UNITS VVLUTM UNITS OF MEASURE: Units of measure used for the
parameter value.

vQ_1C WLPVQ FIRST COLUMN VALUE QUALIFIER: A coded value qualifying
the VAL _1C field.

VAL_1C Field that represents the primary or initial value for a analyte
generated from a Gas Chromatography or Gas
Chromatography / Mass Spectroscopy results.

FCVALPREC Number indicating the precision (number of digits after the
decimal point) of the results.

VQ_CONFIRM VWLPVQ Code value qualifying the confirming analytical result.

VAL_CONFIRM VAL_CONFIRM: The CONFIRMING VALUE of a
chromatographic analytical result that requires second
column confirmation.

CNFVALPREC Number indicating the precision (number of digits after the
decimal point) of the results.

DILUTION Numeric expression of the amount of dilution required tobring
the analyte concentration in the sample into analysis range.

DQTYPE VVLDQT A code identifying the type of data qualifier.

EPA FLAGS Codes that are assigned during chemistry data validation.
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Field Name VVL Definition

QAPPFLAGS VVLQAP A coded value assigned to analytical results during laboratory
or validation review.

PERCENT_RECOVERY Percent of the amount spiked that was recovered (Not
Submitted to AFCEE)

RPD Relative percent difference (Not Submitted to AFCEE)

UPPER_ACCURACY Upper accuracy established for this analyte (Not Submitted to
AFCEE)

LOWER_ACCURACY Lower accuracy established for this analyte (Not Submitted to
AFCEE)

11.3.27 OU (Operable Unit)
Definition of the remedial action activity.

Field Name VVL Definition

OUCODE A coded value representing the Operable Unit Name. Used
as part of the primary key.

OUNAME Name of the operable unit.

OUDESC Textual description of the Operable Unit.

11.3.28 OUC (Operable Unit Contaminant)
Type of contaminant being treated by the operable unit.

Field Name VVL Definition

OUCODE A coded value representing the Operable Unit Name. Used
as part of the primary key.

GROUPCODE VVLANG GROUP CODE: A unique code that identifies a group of
environmental contaminants, (e.g. CHLOR, SOLVENT, PEST).

MATRIX VVLMTY SAMPLING MATRIX: Coded value identifying the sample
medium actually being analyzed, (i.e., soil, water, etc.).

11.3.29 SOX (Site and Operable Unit Cross Reference)

Cross-reference table between operable units and sites.

Field Name VVL Definition

SITEID VVLGSI Number that uniquely identifies a site.

OUCODE A coded value representing the Operable Unit Name. Used
as part of the primary key.

11.3.30 LOX (Location and Operable Unit Cross Reference)

Cross-reference table between sampling locations and operdole units.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

OUCODE A coded value representing the Operable Unit Name. Used
as part of the primary key.
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11.3.31 RSI (Remediation System)

Series of remediation technologies that work in concert .

Field Name VVL Definition

RSID User defined name for the Remediation System. Used as
part of the primary key.

RSSTAGE VVLRSS Type of remediation system (e.qg., treatability study, pilot study,
field demo, full-scale remediation).

RSNAME Name of the remediation system.

RSDESC Textual description of the Remediation Train.

11.3.32 RSP (Remediation System Perfor mance)

Information about the effectiveness of the remediation system.

Field Name VVL Definition

RSID User defined name for the Remediation System. Used as
part of the primary key.

RSSTAGE VVLRSS Type of remediation system (e.g., treatability study, pilot study,
field demo, full-scale remediation).

BEGDATE Beginning date of the remediation.

ENDDATE Ending date of the remediation.

PARAMETER VVLPRF Performance parameter (e.g. Destroyed mass, extracted
mass, concentration, collection frequency).

PARVAL PARAMETER VALUE: value of calculated parameter reported
in units consistent with UNITMEAS.

PARUN A value that measures the uncertainty of the measurement
(expressed as + or - some value).

UNITS WLUTR UNITS OF MEASURE: Units of measure associated with a
record.

REMARKS Textual description of parameter and result.

11.3.33 RSX (Remediation and Site Cross Reference)

Cross-reference table between remediation trains and sites.

Field Name VVL Definition

SITEID VVLGSI Number that uniquely identifies a site.

RSID User defined name for the Remediation System. Used as
part of the primary key.

RSSTAGE VVLRSS Type of remediation system (e.g., treatability study, pilot study,

field demo, full-scale remediation).
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11.3.34 LSX (Location and Remediation System Cross Reference)

Cross-reference table between locations and remediation systems.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

RSID User defined name for the Remediation System. Used as
part of the primary key.

RSSTAGE VVLRSS Type of remediation system (e.g., treatability study, pilot study,

field demo, full-scale remediation).

11.3.35 ROX (Remediation and Operable Unit Cross Reference)

Cross-reference table between operable units and remediation trains.

Field Name VVL Definition

OUCODE A coded value representing the Operable Unit Name. Used
as part of the primary key.

RSID User defined name for the Remediation System. Used as
part of the primary key.

RSSTAGE VVLRSS Type of remediation system (e.qg., treatability study, pilot study,

field demo, full-scale remediation).

11.3.36 RTI (Remediation Technology)

Definition of a discrete remediation activity.

Field Name VVL Definition

RSID User defined name for the Remediation System. Used as
part of the primary key.

RSSTAGE VVLRSS Type of remediation system (e.g., treatability study, pilot study,
field demo, full-scale remediation).

RTID User defined name for the Remediation Technology. Used as
part of the primary key.

RTTYPE VVLRTT Type of remediation technology (e.g., slurry wall, in situ Type
vitrification, bio-reactor).

RTNAME Name of the remedial Technology.

RTCLASS VWLRTC A coded value representing the Remediation Technology
Class (in-situ, ex-situ or mixed).

GROUPCODE VVLANG | GROUP CODE: A unique code that identifies a group of
environmental contaminants, (e.g., CHLOR, SOLVENT, PEST).

MEDIA VVLMED | Coded value identifying the sample medium actually being
treated, (i.e., soil, water, etc.).

ESTDATE Date the construction of the remediation technology was
complete.

STARTDATE Date the remediation technology started operating.

RTDESC Textual description of the remedial unit.
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11.3.37 RTP (Remediation Technology Performance)

Information about the effectiveness of the remediation technology.

Field Name VVL Definition

RSID User defined name for the Remediation System. Used as
part of the primary key.

RSSTAGE VVLRSS Type of remediation system (e.g., treatability study, pilotstudy,
field demo, full-scale remediation).

RTID User defined name for the Remediation Technology. Used as
part of the primary key.

RTTYPE VWLRTT Type of remediation technology (e.g., slurry wall, in situ Type
vitrification, bio-reactor).

BEGDATE Beginning date of the remediation.

ENDDATE Ending date of the remediation.

PARAMETER VVLPRF Performance parameter (e.g. Destroyed mass, extracted
mass, concentration, collection frequency).

PARVAL PARAMETER VALUE: value of calculated parameter reported
in units consistent with UNITMEAS.

PARUN A value that measures the uncertainty of the measurement
(expressed as + or - some value).

UNITS VVLUTR UNITS OF MEASURE: Units of measure associated with a
record.

REMARKS Textual description of parameter and result.

11.3.38 LTX (Location Remediation Technology)
Cross-reference table between locations and remediation technologies.

Field Name VVL Definition

LOCID LOCATION IDENTIFICATION: Unique identifier assigned to a
location within a USAF installation where measurements or
samples are taken.

RSID User defined name for the Remediation System. Used as
part of the primary key.

RSSTAGE VVLRSS Type of remediation system (e.g., treatability study, pilot study,
field demo, full-scale remediation).

RTID User defined name for the Remediation Technology. Used as
part of the primary key.

RTTYPE VVLRTT Type of remediation technology (e.g., slurry wall, in situ Type

vitrification, bio-reactor).
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12. IMPORT/EXPORT SPECIFICATIONS

The following Data Loading Handbook Version 5.0 tables lay out the import specification used
by ERPTools/PC. Only those tables that will be part of electronic data submissions are
shown.

The Data Type column indicates what kind of data is expected during import. Below isalist
of the data types and a short description of each one.

Data Type | Description

B Boolean (Y or N).

C Character — any Alpha-numeric character is allowed.

D Date (DD-MMM-YYYY format, Ex: 12-JUN-2001).

F Floating Point Number (With a Decimal— see the Allowed Decimals
column).

N Number (No Decimals).

T Time (hhnn format Ex: 1423).

Figure 12-1 Data Types

12.1 LABPROJECT IMPORT/EXPORT SPECIFICATION
The Lab Project Import/Export specification is new to DLH ver 5.

12.1.1 SAMPLE (Lab Projects Sample Callection)
Reports information regarding a water, soil, or environmental sampling event.

Field Name Data Type |Start End Length |Allowed Decimals
LABSAMPID C 1 20 20 0
MATRIX C 22 23 2 0
LOGDATE D 25 35 11 0
LOGTIME T 37 40 4 0
SACODE C 42 43 2 0
SAMPNO N 45 46 2 0
LOGCODE C 48 51 4 0
FLDSAMPID C 53 82 30 0
COCID C 84 95 12 0
PARENTFLDID C 97 126 30 0
PARENTLABID C 128 147 20 0
REMARKS C 149 388 240 0
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12.1.2 TEST (Lab Projects Test Procedure)

Information on test preparation and procedures for an environmental sample.

Field Name Data Type |Start End Length [Allowed Decimals
LABSAMPID C 1 20 20 0
MATRIX C 22 23 2 0
ANMCODE C 25 31 7 0
EXMCODE C 33 39 7 0
LCHMETH C 41 47 7 0
RUN_NUMBER N 49 50 2 0
LABCODE C 52 55 4 0
EXTDATE D 57 67 11 0
EXTTIME T 69 72 4 0
LCHDATE D 74 84 11 0
LCHTIME T 86 89 4 0
LCHLOT C 91 100 10 0
ANADATE D 102 112 11 0
ANATIME T 114 117 4 0
ANALOT C 119 128 10 0
LABLOTCTL C 130 139 10 0
BASIS C 141 141 1 0
CALREFID C 143 152 10 0
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12.1.3 RESULT (Lab Projects Analytical Result)

Information on analytical results of an environmental sampling test procedure.

Field Name Data Type |Start End Length [Allowed Decimals
LABSAMPID C 1 20 20 0
MATRIX C 22 23 2 0
ANMCODE C 25 31 7 0
EXMCODE C 33 39 7 0
LCHMETH C 41 47 7 0
RUN_NUMBER N 49 50 2 0
PARLABEL C 52 63 12 0
PRCCODE C 65 67 3 0
PARVQ C 69 70 2 0
PARVAL F 72 86 15 4
PARUN F 88 100 13 4
PRECISION N 102 102 1 0
SPIKEADDED F 104 118 15 4
EXPECTED F 120 134 15 4
SPIKEADDEDPREC N 136 136 1 0
MDL F 138 152 15 4
RL F 154 168 15 4
UNITS C 170 179 10 0
VQ 1C C 181 182 2 0
VAL 1C F 184 198 15 4
FCVALPREC N 200 200 1 0
VQ_CONFIRM C 202 203 2 0
VAL_CONFIRM F 205 219 15 4
CNFVALPREC N 221 221 1 0
DILUTION F 223 235 13 4
DQTYPE C 237 238 2 0
EPA FLAGS C 240 245 6 0
QAPPFLAGS C 247 248 2 0
PERCENT_RECOVERY N 250 252 3 0
RPD N 254 256 3 0
UPPER_ACCURACY N 258 260 3 0
LOWER_ACCURACY N 262 264 3 0

12.2 PRIME PROJECT IMPORT/EXPORT SPECIFICATION

The Prime Project Import/Export specification has changed since DLH ver 4. The columns
that have changed are indicated by a note number in the Changed column and a description of
what changed is in the notes following the table.
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12.2.1 PROJECT (Contract)

A PC-only table with the contract information needed by ERPTools/PC. Thisinformation is
only included in a submission file. It cannot be exported or imported for local use.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
PROJECT_NAME C 1 16 16 0
AFIID C 18 22 g 0
CONTRACT C 24 29 16 0
DO C 411 44 4 0
SUBMDATE D 46 £6 11 0
SUBM GROUP N £8 £8 1 0
HANDBOOK C €0 €2 3 0
VERSION C €4 71 S 0
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12.2.2 LDI (Location)

Genera information about sampling locations.

Field Name Data Type |Start End Length [Allowed Decimals |[Changed
AFIID C 1 3] g 0
LOCID C 7 21 15 0
LTCCODE C 23 24 2 0
LPRCODE C 26 26 1 0
NCOORD F 28 28 11 2
ECOORD F 40 £0 11 2
CRDTYPE C £2 4 3 0
CRDMETH C £6 €0 g 0
CRDUNITS C €2 71 10 0
CRDUN F 73 79 7 3
ESTDATE D gl ¢l 11 0
ESCCODE C c3 <6 4 0
DRLCODE C c8 101 4 0
EXCCODE C 103 106 4 0
CMCCODE C 108 109 2 0
ELEV F 111 118 g 2
ELEVMETH C 120 124 g 0
ELEVUNITS C 126 135 10 0
ELEVUN F 137 143 7 3
ELFLAG B 145 145 1 0
DEPTH F 147 154 g 2
BHDIAM F 156 160 £ 2
BHANGLE F 162 167 € 2
BHAZIM F 169 175 7 2
DATUM C 177 188 12 0
STPZONE C 190 194 £ 0
STPPROJ C 196 200 5 0
UTMZONE C 202 206 5 0
GEOLOG C 208 242 35 0
LOCDESC C 244 483 240 0

12.2.3 SLX (Location Site Cross Reference)
Information about a site and location that has been selected for ERP study.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 <l g 0
SITEID N 7 el 3 0
LOCID C 11 25 15 0
GFCCODE C 27 27 1 0
SPCODE C 29 29 1 0
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assessment.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 <l g 0

GROUPCODE C 7 16 10 0

SITEID N 18 20 3 0

12.2.5 ZDI (Zone)

User defined groupings of sampling locations.

Field Name Data Type |Start End Length [Allowed Decimals |[Changed
AFIID C 1 Sl g 0

ZONEID C 7 16 10 0

ZNAME C 18 £2 35 0

ZONEDESC C £4 293 240 0

12.2.6 ZLX (Location Zone Cross Reference)

Cross-reference table between sampling locations and zones.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 Sl g 0

ZONEID C 7 16 10 0

LOCID C 18 22 15 0

12.2.7 MRI (Map Reference)

Description of the physical map o an ingtalation.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 & £ 0

MAPRID C 7 14 g 0

MAPCODE C 16 19 4 0

MTCCODE C 21 24 4 0

MCCCODE C 26 26 1 0

MAPSCALE N 28 31 4 0

LLNORTH N 23 40 8 0

LLEAST N 42 49 8 0

URNORTH N £1 £8 8 0

UREAST N €0 €7 8 0

BMDESIG C €9 €8 20 0

BMNORTH F <0 100 11 2

BMEAST F 102 112 11 2

BMELEV F 114 121 g 2

MAPDESC C 123 362 240 0
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12.2.8 WCI (Well)

Contains well placement and completion information.

Field Name Data Type |Start End Length [Allowed Decimals |Changed
AFIID C 1 <l g 0
LOCID C 7 21 15 0
INSDATE D 23 33 11 0
WELCODE C 25 28 4 0
WTCCODE C 40 42 3 0
WCMCODE C 44 45 2 0
GZCCODE C 47 47 1 0
SAQCODE C 49 £ 4 0
WDPROC C £4 <l g 0
MPELEV F €0 €7 g 2
MPFLAG B €9 €9 1 0
TOTDEPTH F 71 77 7 2
REMARKS C 79 318 240 0
12.2.9 WINT (Well Construction Interval)

Definition of each well interval.

Field Name Data Type |Start End Length [Allowed Decimals |Changed
AFIID C 1 <l g 0
LOCID C 7 21 15 0
IBDEPTH F 23 20 8 2
IEDEPTH F 32 29 8 2
CLASS C 41 45 E 0
SCRNO N 47 47 1 0
MATERIAL C 49 Sl 3 0
SDIAM F £3 Sl € 2
SOUA F €0 €5 € 3
PCTOPEN F €7 72 € 2
REMARKS C 74 313 240 0
12.2.10 WMI (Well Maintenance)

Historical log of maintenance activities at each well.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 Sl g 0
LOCID C 7 21 15 0
LOGDATE D 23 23 11 0
MTYPE C 35 29 g 0
MPELEV F 41 48 8 2
ELEV F £0 &7 8 2
REMARKS C £9 298 240 0
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12.2.11 LTD (Lithologic Description)

Lithologic descriptions and classifications of cuttings and cores taken from boreholes and test
pits.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 <l g 0
LOCID C 7 21 15 0
BEGDEPTH F 23 20 8 2
ENDDEPTH F a2 29 8 2
LOGDATE D 411 1 11 0
LOGCODE C E3 £6 4 0
LITHCODE C £8 €1 4 0
ASTMCODE C €3 €6 4 0
HS_UNIT C €8 G2 25 0
ST_UNIT C ¢4 113 20 0
VISDESC C 115 254 240 0

12.2.12 STU (Stratigraphic Unit)
Definition of the units in the interpreted stratigraphic column for an installation.

Field Name Data Type |Start End Length [Allowed Decimals |Changed
AFIID C 1 & g 0
ST _UNIT C 7 26 20 0
STRATORDER N 28 20 3 0
GRPNAME C 32 £1 20 0
FORMATION C £3 72 20 0
MBRNAME C 74 3 20 0
BEDNAME C ¢5 114 20 0
SUDESC C 116 255 240 0

12.2.13 HSU (Hydrogtratigraphic Unit)

Data for abody of rock with lateral extent that composes a geologic framework for a
hydrologic system.

Field Name Data Type |Start End Length [Allowed Decimals |Changed
AFIID C 1 5 5 0
HS UNIT C 7 21 25 0
HSTYPE C 23 26 4 0
HSDESC C 28 277 240 0
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12.2.14 CALC (Calculated Hydrology)

Parameters that are calculated or obtained from aquifer and tracer tests, such as pump or slug
tests.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 <l g 0
LOCID C 7 21 15 0
LOGDATE D 23 23 11 0
LOGTIME T 25 28 4 0
TESTMETH C 40 44 £ 0
CALCMETH C 46 £0 g 0
CALCPARCODE C £2 £6 g 0
LOGCODE C £8 €1 4 0
PARVAL F €3 74 12 6
UNITS C 76 €5 10 0
WELLDIST F &7 <3 7 2
WTDEPTH F ¢5 102 8 2
AQTHICK F 104 111 g 2
AQBASEDEPTH F 113 120 8 2
SUPPDATA C 122 124 3 0
REMARKS C 126 265 240 0

12.2.15 GWD (Groundwater Level)
Specific test data to determine the groundwater level over time at a location.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 & £ 0
LOCID C 7 21 15 0
LOGDATE D 23 23 11 0
LOGTIME T 35 28 4 0
IBDEPTH F 40 49 10 2
IEDEPTH F t1 €0 10 2
LOGCODE C €2 €5 4 0
STATDEP F €7 74 8 2
SOUNDING F 76 €3 & 2
FTCODE C €5 €5 1 0
MEASMETH C &7 €1 g 0
DRY C c3 ¢3 1 0
REMARKS C ¢5 234 240 0
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12.2.16 ATI (Aquifer Test)
Data describing an aquifer pump, slug or tracer test used to determine aquifer attributes.

Field Name Data Type |Start End Length [Allowed Decimals |[Changed
AFIID C 1 3] g 0
LOCID C 7 21 15 0
LOGDATE D 23 33 11 0
LOGTIME T 35 28 4 0
LOGCODE C 40 43 4 0
HEADDIR C 45 47 3 0
SLUGVOL F 49 £5 7 2
UNITS C 57 €6 10 0

12.2.17 PUMPRATE (Pump Rate)
Measurements of the change in pump rate over time.

Field Name Data Type |Start End Length [Allowed Decimals |Changed
AFIID C 1 5 5 0
LOCID C 7 21 15 0
LOGDATE D 23 23 11 0
LOGTIME T 25 28 4 0
STARTDATE D 40 £0 11 0
STARTTIME T £2 £5 4 0
ENDDATE D E7 €7 11 0
ENDTIME T €9 72 4 0
PUMPRATE F 74 €1 8 2
UNITS C €3 €2 10 0
REMARKS C ¢4 233 240 0

12.2.18 TWI (Test Well)
Specific data for pump test wells.

Feld Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 <l g 0
LOCID C 7 21 15 0
LOGDATE D 23 23 11 0
LOGTIME T 25 28 4 0
TIDEPTH F 40 49 10 2
BIDEPTH F t1 €0 10 2
DEPWAT F €2 71 10 2
FTCODE C 73 73 1 0
REMARKS C 75 314 240 0
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12.2.19 OWL (Observation Well Water Level)

Wl fluid measurements collected during timed intervals.

Field Name Data Type |Start End Length [Allowed Decimals |[Changed
AFIID C 1 3] g 0
LOCID C 7 21 15 0
OBS LOCATION C 23 37 15 0
LOGDATE D 29 49 11 0
LOGTIME T £l £4 4 0
MEASDATE D £6 €6 11 0
MEASTIME T €8 71 4 0
DEPWAT F 73 &2 10 2
FTCODE C €4 &4 1 0
WTCCODE C g6 &8 3 0
REMARKS C 0 329 240 0

12.2.20 TRI (Tracer Injection)
Definition of the tracer fluids injected into awell during well tests.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 Sl g 0
LOCID C 7 21 15 0
STARTDATE D 23 23 11 0
STARTTIME T 35 28 4 0
ENDTIME T 40 43 4 0
TRC_CONC F 45 £2 8 2
TRCUNITS C E4 €3 10 0
TRCTYPE C €5 €9 5 0
TRCVOL F 71 78 8 2
TRCVOLUNITS C €0 €9 10 0
REMARKS C c1 230 240 0

12.2.21 TOW (Tracer Observation Well)
Information on observation wells sampled during a tracer test.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 & £ 0
LOCID C 7 21 15 0
STARTDATE D 23 23 11 0
STARTTIME T 35 28 4 0
ENDTIME T 40 43 4 0
OBS_LOCATION C 45 £9 15 0
MEASDATE D €1 71 11 0
MEASTIME T 73 76 4 0
TRC_CONC F 78 €5 & 2
TRCUNITS C &7 <6 10 0
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12.2.22 PUMPINT (Pumping Interval)

Definition of the operation of an extraction a injection well over time.

Field Name Data Type |Start End Length [Allowed Decimals |[Changed
AFIID C 1 3] g 0
LOCID C 7 21 15 0
BEGDATE D 23 33 11 0
BEGTIME T 35 28 4 0
ENDDATE D 40 £0 11 0
ENDTIME T £2 £5 4 0
BEGDEPTH F 57 €6 10 2
ENDDEPTH F €8 17 10 2
LOGCODE C 79 €2 4 0
WTCCODE C g4 €6 3 0
PUMPDEPTH F &8 7 10 2
PUMPINGRATE F €9 105 7 1
UNITS C 107 116 10 0
REMARKS C 118 357 240 0

12.2.23 EMI (Environmental Measurement)
Result information for tests that fall outside the category of standard analytical testing.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 <l g 0

LOCID C 7 21 15 0

LOGDATE D 23 23 11 0

LOGTIME T 25 28 4 0

MATRIX C 40 41 2 0

SBD F 43 £0 & 2

SED F E2 £9 & 2

ANADATE D €1 71 11 0

ANATIME T 73 76 4 0

ANATYPE C 78 €2 g 0

PARVAL F &4 €1 8 2

UNITS C c3 102 10 0

QUALIFIER C 104 105 2 0 1
REMARKS C 107 246 240 0

1. New fidd.
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12.2.24 SAMPLE (Sample Collection)

Reports information regarding a water, soil, or environmental sampling event.

Field Name Data Type |Start End Length [Allowed Decimals |[Changed
AFIID C 1 3] g 0
LOCID C 7 21 15 0
LOGDATE D 23 33 11 0
LOGTIME T 35 28 4 0
MATRIX C 40 41 2 0
SBD F 43 £0 8 2
SED F £2 £9 8 2
SACODE C €1 €2 2 0
SAMPNO N €4 €5 2 0
LOGCODE C €7 70 4 0
SMCODE C 72 73 2 0
FLDSAMPID C 75 104 20 0
COCID C 106 117 12 0
COOLER C 119 120 2 0
ABLOT C 122 129 8 0
EBLOT C 131 138 8 0
TBLOT C 140 147 g 0
REMARKS C 149 388 240 0
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12.2.25 TEST (Test Procedure)

Information on test preparation and proceadures for an environmental sample.

Field Name Data Type |Start End Length [Allowed Decimals |[Changed
AFIID C 1 3] g 0

LOCID C 7 21 15 0

LOGDATE D 23 33 11 0

LOGTIME T 35 28 4 0

MATRIX C 40 41 2 0

SBD F 43 £0 8 2

SED F £2 £9 8 2

SACODE C €1 €2 2 0

SAMPNO N €4 €5 2 0

LABCODE C €7 70 4 0

ANMCODE C 72 78 7 0

EXMCODE C €0 €6 7 0

LCHMETH C g8 ¢4 7 0

RUN NUMBER N 6 &7 2 0

LABSAMPID C €9 118 20 0 1
EXTDATE D 120 130 11 0 2
EXTTIME T 132 135 4 0 2
LCHDATE D 137 147 11 0 2
LCHTIME T 149 152 4 0 2
LCHLOT C 154 163 10 0 2
ANADATE D 165 175 11 0 2
ANATIME T 177 180 4 0 2
ANALOT C 182 191 10 0 2
LABLOTCTL C 193 202 10 0 2
CALREFID C 204 213 10 0 2
RTTYPE C 215 219 £ 0 2
BASIS C 221 221 1 0 2

1. Sizeincreased from 12 to 20 to support LABSAMPLEID field in the LAB tool
2. Position changed because of growth of LABSAMPID field
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12.2.26 RESULT (Analytical Result)

Information on analytical results of an environmental sampling test procedure.

Field Name Data Type |Start End Length [Allowed Decimals |[Changed
AFIID C 1 5 5 0

LOCID C 7 21 15 0

LOGDATE D 23 33 11 0

LOGTIME T 35 38 4 0

MATRIX C 40 41 2 0

SBD F 43 50 8 2

SED F 52 59 8 2

SACODE C 61 62 2 0

SAMPNO N 64 65 2 0

LABCODE C 67 70 4 0

ANMCODE C 72 78 7 0

EXMCODE C 80 86 7 0

LCHMETH C 88 94 7 0

RUN_NUMBER N 96 97 2 0

PARLABEL C 99 110 12 0

PRCCODE C 112 114 0

PARVQ C 116 117 2 0

PARVAL F 119 133 15 4

PARUN F 135 147 13 4

PRECISION N 149 149 1 0

EXPECTED F 151 165 15 4

EVPREC N 167 167 1 0

MDL F 169 183 15 4

RL F 185 199 15 4

UNITS C 201 210 10 0

VQ 1C C 212 213 2 0

VAL_1C F 215 229 15 4

FCVALPREC N 231 231 1 0

VQ_CONFIRM C 233 234 0

VAL_CONFIRM F 236 250 15 4

CNFVALPREC N 252 252 1 0

DILUTION F 254 266 13 4 1
DQTYPE C 268 269 2 0 2
EPA FLAGS C 271 276 6 0 2
QAPPFLAGS C 278 279 2 0 2
PERCENT_RECOVERY N 281 283 3 0 3
RPD N 285 287 3 0 3
UPPER_ACCURACY N 289 291 3 0 3
LOWER_ACCURACY N 293 295 3 0 3

1. Changed data type to floating to support 4 decimal places (N12,4)
2. Position changed because of growth of DILUTION field
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3. New field added to RESULT. Thisfield is NOT submitted to the ALPHA but it is part
of the LOCAL IMPORT/EXPORT spec

12.2.27 OU (Operable Unit)
Definition of the remedial action activity.

Field Name Data Type |Start End Length [Allowed Decimals |[Changed
AFIID C 1 £ g 0

OUCODE C 7 ] 3 0

OUNAME C 11 45 35 0

OUDESC C 47 286 240 0

12.2.28 OUC (Operable Unit Contaminant)

Type of contaminant being treated by the operable unit.

Field Name Data Type |Start End Length [Allowed Decimals |[Changed
AFIID C 1 5 5 0

OUCODE C 7 ] 3 0

GROUPCODE C 11 20 10 0

MATRIX C 22 22 1 0

12.2.29 SOX (Site and Operable Unit Cross Reference)

Cross-reference table between operable units and sites.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 5 5 0

SITEID N 7 ] 3 0

OUCODE C 11 13 3 0

12.2.30 LOX (Location and Operable Unit Cross Reference)

Cross-reference table between sampling locations and operable units.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 £ g 0

LOCID C 7 21 15 0

OUCODE C 23 25 3 0

12.2.31 RSI (Remediation System)

Series of remediation technologies that work in concert .

Field Name Data Type |Start End Length [Allowed Decimals |Changed
AFIID C 1 5 g 0

RSID C 7 16 10 0

RSSTAGE C 18 20 3 0

RSNAME C 22 £6 35 0

RSDESC C £8 297 240 0
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12.2.32 RSP (Remediation System Perfor mance)

Information about the effectiveness of the remediation system.

Field Name Data Type |Start End Length [Allowed Decimals |[Changed
AFIID C 1 5 g 0

RSID C 7 16 10 0

RSSTAGE C 18 20 3 0

BEGDATE D 22 32 11 0

ENDDATE D 34 44 11 0

PARAMETER C 46 £0 g 0

PARVAL F £2 €2 11 2

PARUN F €4 74 11 2

UNITS C 76 €5 10 0

REMARKS C &7 326 240 0

12.2.33 RSX (Remediation and Site Cross Reference)

Cross-reference table between remediation trains and sites.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 £ g 0

SITEID N 7 ] 3 0

RSID C 11 20 10 0

RSSTAGE C 22 24 3 0

12.2.34 LSX (Location and Remediation System Cross Reference)

Cross-reference table between locations and remediation systems

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 g g 0

LOCID C 7 21 15 0

RSID C 23 32 10 0

RSSTAGE C 24 26 3 0

12.2.35 ROX (Remediation and Operable Unit Cross Reference)

Cross-reference table between operable units and remediation trains.

Field Name Data Type |Start End Length [Allowed Decimals |Changed
AFIID C 1 £ g 0

OUCODE C 7 ] 3 0

RSID C 11 20 10 0

RSSTAGE C 22 24 3 0
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12.2.36 RTI (Remediation Technology)

Definition of a discrete remediation activity.

Field Name Data Type |Start End Length [Allowed Decimals |[Changed
AFIID C 1 3] g 0
RSID C 7 16 10 0
RSSTAGE C 18 20 3 0
RTID C 22 26 15 0
RTTYPE C 28 42 g 0
RTNAME C 44 78 35 0
RTCLASS C €0 €0 1 0
GROUPCODE C 82 c1 10 0
MEDIA C c3 ¢4 2 0
ESTDATE D ¢6 106 11 0
STARTDATE D 108 118 11 0
RTDESC C 120 259 240 0

12.2.37 RTP (Remediation Technology Perfor mance)
Information about the effectiveness of the remediation technology.

Field Name Data Type |Start End Length [Allowed Decimals |Changed
AFIID C 1 & g 0
RSID C 7 16 10 0
RSSTAGE C 18 20 3 0
RTID C 22 36 15 0
RTTYPE C 28 42 g 0
BEGDATE D 44 £4 11 0
ENDDATE D £6 €6 11 0
PARAMETER C €8 72 g 0
PARVAL F 74 &4 11 2
PARUN F €6 6 11 2
UNITS C ¢8 107 10 0
REMARKS C 109 348 240 0

12.2.38 LTX (Location Remediation Techndogy)

Cross-reference table between locations and remediation technologies.

Field Name Data Type |Start End Length |Allowed Decimals |Changed
AFIID C 1 Sl g 0
LOCID C 7 21 15 0
RSID C 23 22 10 0
RSSTAGE C 24 26 3 0
RTID C 28 £2 15 0
RTTYPE C t4 £8 s 0
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12.3 LocAL METHODSIMPORT TABLE

The Loca Method import file is a pipe (]) delimited text file that contains the local methods
information in the following format. There is aso a header record that specifies the application
version.

Field Name Type Start End Length | Decimals Changes
METHOD_NAME C24 1 24 24 0
ANMCODE c7 25 31 7 0
MATRIX_TYPE C1 32 32 1 0
DEFAULT_UNITS C10 33 42 10 0
PRECISION N1 43 43 1 0
PARLABEL C12 44 55 12 0
PRCCODE C3 56 58 3 0
MDL N14,4 59 73 15 4
RL N14,4 74 88 15 4
UNITS C10 89 98 10 0
SURROGATE C5 99 103 5 0
RPD N3 104 106 3 0
UPPER_ACCURACY N3 107 109 3 0
LOWER_ACCURACY N3 110 112 3 0
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13. VALID VALUELISTS

Short Name Long Name

ANPARXREF Analytical Method/Analyte Cross Reference
EXT_AMC Preparation Method/AMC Cross Reference
GSI Site

PRC_AMC PRCCODE/AMC Cross Reference
VVLAFI Air Force Installation

VWLAMC Analytical Method Classification
VVLANG Analyte Group

VVLANM Analytical Method

VVLANT Analysis Type

VVLAST ASTM Code

VVLBAS Basis

VVLCHD Changing Head Direction
VVLCLA Well Segment Classification
VVLCMC Construction Method

VVLCMT Calculation Method

VVLCPC Calculated Parameter

VVLCRD Coordinate Method

VVLCRT Coordinate Type

VVLDQT Data Qualifier Type

VVLDRL Drilling Company

VVLEDQ EMI Data Qualifier

VVLELM Elevation Method

VVLESC Establishing Company

VVLEXC Excavating Company

VVLEXM Preparation Method

WLFTC Fluid Type

VVLGFC Geohydrologic Flow Classification
VWLGZC Hydrogeologic Completion Zone
VVLLAB Laboratory

VVLLCH Leachate Method

VVLLOG Logging Company

VVLLPR Location Proximity

VVLLTC Location Type

VVLLTH Lithology Code

VVLMAP Mapping Company

VWLMAT Well Construction Material
VVLMCC Map Coverage Code

VVLMED Media

VWLMMT Measuring Method

VWLMTC Map Type

VVLMTX Sampling Matrix

VVLMTY Matrix Type

VVLPAR Analyte

VVLPRC Analyte Classification

VVLPRF Performance Parameter
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VWLPVQ Parameter Value Qualifier
VWLQAP QAPP Flags

VVLRSS Remediation System Stage
VWVLRTC Remediation Technology Class
VVLRTT Remediation Technology Type
VVLSA Sample Type

VVLSAQ Sole Source Aquifer

VVLSM Sampling Method

VVLSPD Supporting Data

VVLSPR Site Proximity

VVLSTP STP Projection

VVLSTZ STP Zone

VWLTMT Test Method

VVLTRT Tracer Type

VWLUTM Units of Measurement
VVLUTR Remediation Units

VWVLUTZ UTM Zone

VVLWCM Well Completion Method
VVLWDP Well Development Procedures
VVLWEL Well Owner

VWLWMT Well Maintenance Type
VWLWTC Well Type
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14. TABLE FIELD DESCRIPTIONS

ABLOT
Prime Project, Type C
Ambient Blank Field Lot Identifier.

AFIID
VVL - AFI, Prime Project, Type C
Unique code used to represent an Air Force installation, plant, or base.

ANADATE

Prime and Lab Project, Type D

The starting date of the sample test. This attribute is used if the samples are related to an
aquifer test or tracer test. A series of samples taken at different times can be
related using the start date and times.

ANALOT

Prime and Lab Project, Type C

The batch designator of an autonomous group of environmental samples and associated QC
samples analyzed together.

ANATIME

Prime and Lab Project, Type T

The starting time of the sampletest. This attribute is used if the samples are related to an
aquifer test or tracer test.

ANATYPE

VVL — ANT, Prime Project, Type C

The type of test being performed on the sample (e.g., air sampling, water velocity, soil sample,
well bore fluid sample, etc.).

ANMCODE
VVL — ANM, Prime and Lab Project, Type C
Coded value representing the method of analysis of a given parameter.

AQBASEDEPTH
Prime Project, Type F
The estimated depth of the aquifer used to make the calculation.

AQTHICK
Prime Project, Type F
The assumed saturated thickness of the aguifer used to perform the calculation.

ASTMCODE

VVL — AST, Prime Project, Type C

ASTM Soil Classification Code. A 2 or 4 character code used in ASTM classification of
unconsolidated deposits. Deposits possessing characteristics of two groups are
designated by combinations of groups.

PAGE 287



F41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

BASIS

VVL - BAS, Prime and Lab Project, Type C

Basis. For tissue or solid samples enter whether results are reported on a wet (W) or dry (D)
basis.

BEDNAME

Prime Project, Type C
Name of the geological bed of which the unit is a part.

BEGDATE
Prime Project, Type D
The starting date the pumping was performed.

BEGDEPTH

Prime Project, Type F

Upper depth of alithologic stratum, measured below the ground surface in feet (reported as a
positive value).

BEGTIME
Prime Project, Type T
The starting time the pumping was performed.

BHANGLE
Prime Project, Type F
Angle at which borehole was drilled.

BHAZIM
Prime Project, Type F
Azimuth (degrees on a compass) of which the borehole was drilled.

BHDIAM
Prime Project, Type F
The diameter of a borehole in inches.

BIDEPTH
Prime Project, Type F
The lower depth of the interval that is being tested.

BMDESIG
Prime Project, Type C
Code, |abel, name, etc. of a benchmark.

BMEAST
Prime Project, Type F
The x-value of a map benchmark.

BMELEV
Prime Project, Type F
The ground surface elevation of a map benchmark.
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BMNORTH
Prime Project, Type F
The y-value of a map benchmark.

CALCMETH

VVL — CMT, Prime Project, Type C

The type of method used to calculate the results (e.g., Theis, Theim, Chow, HantusiJacob,
etc.).

CALCPARCODE

VVL - CPC, Prime Project, Type C

The type of result of the calculation (e.g., transmissitivity, hydraulic conductivity, storage
coefficient, etc.).

CALREFID

Prime and Lab Project, Type C

A coded value that establishes a reference link between environmental and QC samples and
their corresponding calibration records.

CLASS
VVL - CLA, Prime Project, Type C
Classification of the casing interval. May be seal, screen, well foot, blank, or filter pack.

CMCCODE

VVL — CMC, Prime Project, Type C

Coded value identifying the method by which a borehole or test pit was constructed (Drilling
or Excavation Method).

CNFVALPREC
Prime and Lab Project, TypeN
Number indicating the precision (number of digits after the decimal point) of the results.

COCID

Prime and Lab Project, Type C

Unique identification reference to the chain of custody describing the transport of the sample
to the laboratory.

CONTRACT

Prime Project, Type C

Contract number, consisting of afiscal year and contract sequence number (i.e., F33615-84-
D-4402).

COOLER
Prime Project, Type C
The unique number assigned to the cooler transporting the sample.

CRDMETH
VVL - CRD, Prime Project, Type C
I ndicates the method used to determine the location (e.g., survey, GPS, estimated, digitized).
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CRDTYPE
VVL — CRT, Prime Project, Type C
The type of coordinate system used (i.e., UTM,STP,GEO).

CRDUN
Prime Project, Type F
The expression of the precision of the location coordinates.

CRDUNITS
VVL — UTM, Prime Project, Type C
Units of measure of the surveyed northing and easting values.

DATUM

Prime Project, Type C

Identifier representing the geodetic datum used in the survey (e.g., State Plane Coordinate
System NAD 1983, Florida Western Zone).

DEPTH

Prime Project, Type F

The total depth of a borehole (including boreholes drilled to install wells) measured in feet
relative to ground surface.

DEPWAT

Prime Project, Type F

The depth from the measuring point to the top of the fluid in the well bore. These
measurements will include the water level at the beginning of the test (time=0).
These measurements are used to calculate drawdown.

DILUTION

Prime and Lab Project, Type F

Numeric expression of the amount of dilution required to bring the analyte concentration in the
sample into analysis range.

DO

Prime Project, Type C

Sequentia identifier assigned to the Air Force form “Orders for Supplies and Services.”

DQTYPE
VVL - DQT, Prime and Lab Project, Type C
A code identifying the type of data qualifier.

DRLCODE

VVL — DRL, Prime Project, Type C

Coded value identifying the organization that drilled a borehole at a sampling or measuring
location. This organization is typically the drilling subcontractor.

DRY
Prime Project, Type C
Y/N flag indicating whether the well is dry.
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EBLOT
Prime Project, Type C
Equipment blank field lot identifier.

ECOORD

Prime Project, Type F

The x-value (East-West) of the distance in feet of a sampling or measuring location from the
reference location of known state plane coordinates.

ELEV

Prime Project, Type F

Elevation of ground surface (for groundwater, soil, or sediment sampling) or water surface
(for surface water sampling) at a sampling or measuring location.

ELEVMETH
VVL — ELM, Prime Project, Type C
Method used in to determine the location’ s €levation.

ELEVUN
Prime Project, Type F
The expression of the precision of the location coordinates.

ELEVUNITS
VVL —UTM, Prime Project, Type C
The unit that the elevation was measured in feet (f).

ELFLAG

Prime Project, Type B

Flag that indicates whether or not more current measurements for the Ground Surface
Elevation are available in the Well Maintenance table.

ENDDATE
Prime Project, Type D
The ending date.

ENDDEPTH
Prime Project, Type F
The lower depth of the interval that is being tested.

ENDTIME
Prime Project, Type T
The ending time.

EPA_FLAGS
Prime and Lab Project, Type C
Codes that are assigned during chemistry data validation.

ESCCODE

VVL - ESC, Prime Project, Type C

Coded value identifying the organization that establishes a sampling or measuring location,
typically the prime contractor.
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ESTDATE
Prime Project, Type D
Date the action was complete.

EVPREC
Prime Project, Type N
Number indicating the precision (number of digits after the decimal point) of the results.

EXCCODE

VVL — EXC, Prime Project, Type C

Coded value identifying the organization that excavated a test pit at a sampling or measuring
location.

EXMCODE
VVL — EXM, Prime and Lab Project, Type C
Coded value representing the method used to extract or prepare a sample.

EXPECTED
Prime and Lab Project, Type F
The target result for a quality control sample or surrogate spike.

EXTDATE

Prime and Lab Project, Type D

Preparation date is a more genera identifier to indicate extractions or other preparation
methods. For compatibility with DESCIM.

EXTTIME

Prime and Lab Project, Type T

Preparation time is a more general identifier to indicate extractions or other preparation
methods. For compatibility with DESCIM.

FCVALPREC
Prime and Lab Project, Type N
Number indicating the precision (number of digits after the decimal point) of the results.

FLDSAMPID
Prime and Lab Project, Type C
Unique number assigned to the sample in the field.

FORMATION
Prime Project, Type C
Name of the geological formation of which theunit is a part.

FTCODE

VVL - FTC, Prime Project, Type C

The type of fluid encountered in the well. This would normally be groundwater. If another
type of fluid is encountered in the well bore during the test, then it should be noted
here and explained in the comments.
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GEOLOG
Prime Project, Type C
Contains the reference to any/all geophysical logs created during drilling operations.

GFCCODE

VVL - GFC, Prime Project, Type C

The GFCCODE is a single character that describes the hydrologic relationship between a
location and a site.

GROUPCODE

VVL — ANG, Prime Project, Type C

A unique code that identifies a group of environmental contaminants, (e.g., CHLOR,
SOLVENT, PEST).

GRPNAME
Prime Project, Type C
Name of the geological group of which the unit is a part.

GZCCODE
VVL — GZC, Prime Project, Type C
Geologic Completion Zone. General Zone hydrologic description of well completion zone.

HANDBOOK
Prime Project, Type C
Indicates which handbook version (2.3, 3, 4, or 5) the datais formatted in.

HEADDIR

VVL — CHD, Prime Project, Type C

The direction of the observed or expected well drawdown trend during a slug or aquifer test.
This may be expressed as rising head, falling head, drawdown, residual, or
recovery.

HS UNIT
Prime Project, Type C
Working name given to the unit.

HSDESC
Prime Project, Type C
Textual description of the hydrostratigraphic unit.

HSTYPE

VVL - LTH, Prime Project, Type C

USGS soil or rock classification for the type of soil/rock that comprises this hydrostratigraphic
unit.

IBDEPTH
Prime Project, Type F
Depth in feet to the top of the described interval.
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|IEDEPTH
Prime Project, Type F
Depth in feet to the bottom of the described interval.

INSDATE
Prime Project, Type D
Date that awell casing is installed.

LABCODE

VVL — LAB PROJECT, Prime and Lab Project, Type C

Analytical Laboratory Code. Coded value identifying the analytical laboratory that performed
the analysis of a sample.

LABLOTCTL

Prime and Lab Project, Type C

Preparation Lot is a more genera identifier to indicate extractions or other prepardion
methods. For compatibility with DESCIM.

LABSAMPID
Prime and Lab Project, Type C
Laboratory Sample Identification.

LCHDATE
Prime and Lab Project, Type D
Date the sample was leachated.

LCHLOT

Prime and Lab Project, Type C

The batch designator of an autonomous group of environmental samples and associated QC
samples leached together.

LCHMETH
VVL — LCH, Prime and Lab Project, Type C
Coded value identifying the leachate method.

LCHTIME
Prime and Lab Project, Type T
Time the sample was |leachated.

LITHCODE
VVL — LTH, Prime Project, Type C
4-Character code indicating lithologic description of layer.

LLEAST
Prime Project, Type N
The lower left x-value of a generd area of interest.

LLNORTH
Prime Project, Type N
The lower |eft y-value of a general area of interest.
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LOCDESC
Prime Project, Type C
Any additiona information to describe a sampling or measuring location in text format.

LOCID
Prime Project, Type C
Name of alocation on an installation.

LOGCODE
VVL - LOG, Prime and Lab Project, Type C
Coded value identifying the company performing field tests.

LOGDATE
Prime and Lab Project, Type D
The date the sample was taken.

LOGTIME
Prime and Lab Project, Type T
The time the sample was taken.

LOWER_ACCURACY
Prime and Lab Project, Type N
Lower accuracy established for this analyte (Not Submitted to AFCEE).

LPRCODE

VVL - LPR, Prime Project, Type C

Location Proximity Code. Coded value indicating whether sampling or measuring location is
within or outside the Air Force installation boundaries.

LTCCODE
VVL - LTC, Prime Project, Type C
Coded value describing location where measurements or samples are taken.

MAPCODE
VVL — MAP, Prime Project, Type C
Coded vaue identifying the company responsible for producing a map of a designated area.

MAPDESC
Prime Project, Type C
Textual description of the mapped area.

MAPRID
Prime Project, Type C
Unique identifier assigned to each map for an installation.

MAPSCALE
Prime Project, Type N
The drawing scale of a map expressed as inches of drawing per feet of terrain.
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MATERIAL

VVL — MAT, Prime Project, Type C

The material being used for well casing or construction includes grout, filter pack, screen, well
seal, etc.

MATRIX
VVL - MTX, Prime and Lab Project, Type C
Coded value identifying the sample medium actually being analyzed, (e.g., soil, wakr, etc.).

MBRNAME
Prime Project, Type C
Name of the geological member of which the unit is a part.

MCCCODE

VVL — MCC, Prime Project, Type C

Coded value delineating the extent to which a reference map covers specified features
associated with a site, zone, or entire installation.

MDL

Prime and Lab Project, Type F

Minimum detectable quantity of a parameter based on laboratory conditions, anaytical method,
or field conditions.

MEASDATE
Prime Project, Type D
Date that the observation well was measured.

MEASMETH
VVL — MMT, Prime Project, Type C
Coded value representing the method used to make the measurement.

MEASTIME
Prime Project, Type T
Time that the observation well was measured.

MEDIA
VVL - MED, Prime Project, Type C
Coded value identifying the sample medium actually being treated, (i.e., soil, water, etc.).

MPELEV

Prime Project, Type F

Elevation of the measurement reference point used for groundwater depth level measurements,
expressed in feet above Mean Sea Level.

MPFLAG

Prime Project, Type B

Flag that indicates whether or not more current Flag measurements for the Point Elevation are
available in the Well Maintenance table.
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MTCCODE
VVL — MTC, Prime Project, Type C
Coded value identifying the type of map.

MTYPE
VVL - WMT, Prime Project, Type C
The type of maintenance performed on the well.

NCOORD

Prime Project, Type F

The y-value (North-South) of the distance in feet of a sampling or measuring location from the
reference location of known state plane coordinates.

OBS LOCATION
Prime Project, Type C
Name of alocation on an installation.

OUCODE
Prime Project, Type C
A coded value representing the Operable Unit Name. Used as part of the primary key.

OUDESC
Prime Project, Type C
Textual description of the Operable Unit.

OUNAME
Prime Project, Type C
Name of the operable unit.

PARAMETER

VVL — PRF, Prime Project, Type C

Performance parameter (e.g. Destroyed mass, extracted mass, concentration, collection
frequency).

PARENTFLDID
Lab Project, Type C
FLDSAMPID of the parent record.

PARENTLABID
Lab Project, Type C
LabSAMPID of the parent record.

PARLABEL
VVL — PAR, Prime and Lab Project, Type C
Parameter Label Code - An abbreviated, common acronym representing a parameter/analyte.

PARUN
Prime and Lab Project, Type F
A value that measures the uncertainty of the analytical test (expressed as + or - some value.).

PAGE 297



F41624-99-D-8513 ERPTOOLS/PC V. 4 USER M ANUAL 7 JuLy 200

PARVAL
Prime and Lab Project, Type F
Value of calculated parameter reported in units consistent with UNITMEAS.

PARVQ
VVL - PVQ, Prime and Lab Project, Type C
Coded value qualifying the analytical results field (PARVAL).

PCTOPEN
Prime Project, Type F
Percent of screened interval that is open for water flow.

PERCENT_RECOVERY
Prime and Lab Project, Type N
Percent of the amount spiked that was recovered (Not Submitted to AFCEE).

PRCCODE

VVL - PRC, Prime and Lab Project, Type C

Coded value identifying a class or group that a parameter is associated with (e.g. ORG, MET,
STD, etc.).

PRECISION
Prime and Lab Project, Type N
Number indicating the precision (number of digits after the decimal point) of the results.

PROJECT_NAME

Prime Project, Type C

User defined name for the project. Thisfield is normally used to differentiate between
quarterly monitoring projects where the AFIID, CONTRACT _ID and DO _ID are
the same.

PUMPDEPTH
Prime Project, Type F
The depth of the pump.

PUMPINGRATE
Prime Project, Type F
The rate the well was pumped.

PUMPRATE
Prime Project, Type F
The measured rate of the pump.

QAPPFLAGS
VVL — QAP, Prime and Lab Project, Type C
A coded value assigned to analytical results during laboratory or validation review.

QUALIFIER
VVL - EDQ, Prime Project. TypeC
Data Qudlifier.
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RECNO
Prime and Lab Project, Type N
Auto-generated number by the system.

REMARKS
Prime and Lab Project, Type C
Textual description of parameter and resullt.

RL

Prime and Lab Project, Type F

Laboratory Detection Limit - Minimum detectable quantity of a parameter based on laboratory
conditions, analytical method, or field conditions.

RPD
Prime and Lab Project, Type N
Relative percent difference (Not Submitted to AFCEE).

RSDESC
Prime Project, Type C
Textual description of the Remediation Train.

RSID
Prime Project, Type C
User defined name for the Remediation System. Used as part of the primary key.

RSNAME
Prime Project, Type C
Name of the remediation system.

RSSTAGE

VVL - RSS, Prime Project, Type C

Type of remediation system (e.g., treatability study, pilot study, field demo, full-scale
remediation).

RTCLASS

VVL - RTC, Prime Project, Type C
A coded value representing the Remediation Technology Class (in-situ, ex-situ or mixed).

RTDESC
Prime Project, Type C
Textual description of the remedial unit.

RTID
Prime Project, Type C
User defined name for the Remediation Technology. Used as part of the primary key.

RTNAME
Prime Project, Type C
Name of the remedial Technology.
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RTTYPE
VVL - RTT, Prime Project, Type C
Type of remediation technology (e.g., lurry wall, in situ Type vitrification, bio-reactor).

RUN_NUMBER
Prime and Lab Project, Type N
Thisinformation is stored in the Test Procedure class and is replaced by the use of Test

Sequence.

SACODE
VVL - SAC, Prime and Lab Project, Type C
A coded value identifying whether the sample is QC or normal and the type is QC.

SAMPNO
Prime and Lab Project, Type N
This is the numeric portion of the Sample Type.

SAQCODE
VVL — SAQ, Prime Project, Type C
Coded vaue identifying the sole source aquifer in which the well was compl eted.

SBD

Prime Project, Type F

The upper depth in feet from the ground surface or the water surface at which asampleis
collected.

SCRNO
Prime Project, Type N
Identifier used to group segments beonging to the same screened interval.

SDIAM

Prime Project, Type F

The inside diameter of the well casing being described. For screen intervals, it is the inside
diameter of the screen.

SED

Prime Project, Type F

Sample Ending Depth - Lower depth in feet & which a soil sample is collected for anaysis,
relative to the ground surface.

SITEID
VVL - GSI, Prime Project, Type N
Number that uniquely identifies a site.

SLUGVOL
Prime Project, Type F
The volume of a slug used to displace groundwater during a slug test.

SMCODE
VVL - SM, Prime Project, Type C
Coded value identifying the sampling method used to collect a sample.
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SOUA
Prime Project, Type F
Vertica size of dot opening in inches.

SOUNDING
Prime Project, Type F
Total depth to the bottom of well in feet & time of test, measured from the reference point.

SPCODE
VVL - SPR, Prime Project, Type C
A coded vaue indicating whether the location is in the site, outside the site or background.

SPIKEADDED

Lab Project, Type F

Amount that the sample was spiked. In the UNITS field specify the actual units of measure
used.

SPIKEADDEDPREC
Lab Project, Type N
Number indicating the precision (number of digits after the decimal point) of the spike results.

ST_UNIT
VVL — STU, Prime Project, Type C
Descriptive name given to the unit.

STARTDATE
Prime Project, Type D
The date the activity started.

STARTTIME
Prime Project, Type T
The time that the activity started.

STATDEP
Prime Project, Type F
Depth to water in feet measured from the measuring point.

STPPROJ
VVL — STP, Prime Project, Type C
Geographic projection used by the state planar system.

STPZONE

VVL — STZ, Prime Project, Type C

The coordinate zone needed in order for the Geodetic Datum attribute to make sense. For
Compatibility with DESCIM.

STRATORDER

Prime Project, Type N

Number assigned to the unit by the interpreting geologist; unit 1 is the oldest; the number
decreases with age.
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SUBM_GROUP
Prime Project, Type N
Indicates which submission group (1-4) the data belongs to.

SUBMDATE
Prime and Lab Project, Type D
The date the record was submitted.

SUBMDATE
Prime Project, Type D
The date the record was submitted.

SUDESC
Prime Project, Type C
Textua description of the stratiographic unit.

SUPPDATA

VVL - SPD, Prime Project, Type C

Indicates that primary data (e.g., pump test or slug test data) supporting the calculation are
available.

TBLOT
Prime Project, Type C
Test Blank Field Lot Identifier.

TESTMETH
VVL — TMT, Prime Project, Type C
The type of test that is being performed on the well for which the calculation is being made

TIDEPTH
Prime Project, Type F
The upper depth of the interval being tested.

TOTDEPTH

Prime Project, Type F

Total depth in feet (positive value) below land surface of well casing including screen, blank
casing and well foot.

TRC_CONC
Prime Project, Type F
The value of the concentration of the tracer that was injected into the well.

TRCTYPE
VVL — TRT, Prime Project, Type C
The type of tracer that was used for the tracer test.

TRCUNITS
VVL — UTM, Prime Project, Type C
The units of measurement for the tracer concentration value.
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TRCVOL
Prime Project, Type F
The volume of the tracer that was used for the tracer test.

TRCVOLUNITS
VVL - UTM, Prime Project, Type C
The units of measurement for the tracer volume.

UNITS
VVL - UTR, Prime and Lab Project, Type C
Units of measure associated with a record.

UPDATE
Prime and Lab Project, Type D
The date and time the record was inserted or edited.

UPPER_ACCURACY
Prime and Lab Project, Type N
Upper accuracy established for this analyte (Not Submitted to AFCEE).

UPUSER
Prime and Lab Project, Type C
The last user to insert or edit the record.

UREAST
Prime Project, Type N
The upper right x-value of a general area of interest.

URNORTH
Prime Project, Type N
The upper right y-value of a general area of interest.

UTMZONE

VVL —UTZ, Prime Project, Type C

The coordinate zone needed in order for the Geodetic Datum attribute to make sense. For
Compatibility with DESCIM.

VAL _1C

Prime and Lab Project, Type F

Field that represents the primary or initial value for a analyte generated from aGas
Chromatography or Gas Chromatography / Mass Spectroscopy results.

VAL_CONFIRM

Prime and Lab Project, Type F

The confirming value of a chromatographic analytical result that requires second column
confirmation.

VALSTATUS
Prime and Lab Project, Type C
The validation status of the record.
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VERSION
Prime Project, Type C
Indicates which version of the ERPTools/PC software produced the submission.

VISDESC

Prime Project, Type C

Visua Description - Textural and mineralogical description of the material comprising the
layer, to augment or qualify the lithologic codes.

VQ_1C
VVL - PVQ, Prime and Lab Project, Type C
A coded vaue qualifying the VAL _1C field.

VQ_CONFIRM
VVL - PVQ, Prime and Lab Project, Type C
Code value qualifying the confirming analytical result.

WCMCODE

VVL — WCM, Prime Project, Type C

Coded vaue identifying the method used to complete the well or the nature of the openings
that allow water to enter the well.

WDPROC
VVL - WDP, Prime Project, Type C
Indicates the type of well development procedures used.

WELCODE
VVL — WEL, Prime Project, Type C
Coded value identifying the owner of awell that is monitored or tested.

WELLDIST
Prime Project, Type F
The distance from the pumping well to the observation well.

WTCCODE

VVL - WTC, Prime Project, Type C

Coded value identifying the type of well in which the measurements are being taken (e.g.,
slugged, observation).

WTDEPTH

Prime Project, Type F

The estimated depth of the water table used for the calculation; this value would be the top of
a confined aquifer.

ZNAME
Prime Project, Type C
Name of the zone.

ZONEDESC
Prime Project, Type C
Textual description of the zone and its purpose.
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ZONEID

Prime Project, Type C

Unique identifier for a group of individual locations maintained for collective study and
evaluation.
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About ERPTools/PC, 87, 118
Acrobat, 104
Acronyms, 245
Add Limiting Criteria, 65
Equivalency Options, 66
Adding a User, 37
Admin User Responsibilities, 17
Administrative Users, 16
Privileges, 17
AFCEE
Data, 49, 50
Responsibilities, 17
Supplied Data, 21
Support, 12
Air Force
Center for Environmental Excellence, 11
Major Commands, 11
And Statement, 65
ANSI Character Set, 67
Application Menu, 108
Applying
Filter, 63
Sort Order, 62
ATI, 257
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Backup, 89

Base Table Changes, 18

Binoculars Tab, 86

Blue Fields, 93

Brackets, 67

Business Process Changes, 19

Buttons
Print Preview, 119, 121
Report Preview Menu, 118
Toolbar, 107

—C—

CALC, 256
Calculate Percent Recovery, 68, 111
Cascade, 117
Cascading Worksheets, 94
Change
Local Methods Report, 81
Password, 115
Password Screen, 37
Registration Information, 88
Changed

Loca Methods Report, 116
VVLs Report, 82, 117
Changing
Column Order, 97
Column Width, 98
Passwords, 36
Row Height, 98
Charlist, 67
Check Boxes, 93
Child, 15
Records, 101
Choose Destination Location, 27
Close, 108
All, 117
Project, 109
Closed Book Icon, 84
Closing a Project, 46
Common
Table Fields, 246
Techniques, 35
Configuration, 26
Contents Area, 103
Converting Existing Projects, 30
Copy, 99, 111
Create
Default Results, 24, 110
Project, 109
Sort, 63
Submission, 110
VVL Ligt, 115
Creating
aProject, 44
And Managing Projects, 43
Crystal Reports, 23
Cut, 99, 111
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Data
Entry, 59, 110
Entry User Responsibilities, 17
Entry Users, 17
Entry Worksheets, 93
Loading Handbook, 56
Menu, 110
Types, 269
Database
Changes, 18
Level Validation, 73
Maintenance, 88
Default Results, 72
Delete, 101
All, 101, 112
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All Records, 101

Project, 16, 109

Selected, 101, 112
Deleting

a Project, 46

aUser, 38
Deselect All, 97, 112
Dialog Screens, 92
Drop Down Lists, 92
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Earlier Versions, 30
Edit
Menu, 111
Menu Delete All, 102
Project, 109
User Accounts, 115
VVL Data, 115
Editing
a User Record, 38
Errors, 74
Functions, 99
Project Information, 46
Valid Values, 39
EMI, 261
Entering Data, 100
ERP Information Management System, 11
ERPIMS
Data, 16
Data L oading Handbook, 14
Home Page, 86
ERPIMS4.MDB, 44
ERPTools Projects, 14
ERPTooIS/LAB, 14
ERPTools/Lab 2.X Projects, 32
ERPTools/PC
Purpose, 14
Using, 35
ERPTools/PC 3.X Projects, 30
Error
Editor, 110
Messages, 123
Report, 76, 103
Errors, 86
Evaluation
Copy, 26
Installation, 88
Exit, 109, 119, 120
Exiting ERPTools/PC, 89
Export
Changes, 23
Current View, 69, 111
Data, 110
Local Methods, 116

Exporting
Data, 55
Local Methods, 49

—F—

F1 key, 118
Field & Record Validation, 110
Field and Record Validation, 73
File
Dialog, 90
Menu, 109
Filter, 62, 63, 111
Warning, 94
FILTER Flag, 62
Filtering, 61
Data, 63
Records, 24
Find, 60, 111
and Replace, 24
Dialog Box, 60
Vaues, 60
First, 113
Page, 121
Fit In Window, 121

—G—

General System Error, 86
Goto, 112

Menu, 113
GWD, 257

—H—

Hardware Requirements, 25
HASLMs?, 72
Help, 118
Contents Tab, 84
Desk, 12
Find Setup Wizard, 86
Find Tab, 85
Index Tab, 85
Menu, 118
Options, 24
Screen, 83
System, 83
System Icons, 83
Topics Button, 84
History, 23
HSU, 255

Import
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Changes, 19 Maintaining
Data, 110 Users, 36
Local Methods, 116 Valid Value Lists, 38
VVL Data, 115 Making Submissions, 80
Import/Export Specifications, 269 Maximize, 108
Importing Menu, 116
Data, 52 Bar, 106
Local Methods, 47 Menus and Toolbars, 106
Valid Values, 39 Message Boxes, 90
Installation Microsoft Access, 66
Complete, 28 Minimize, 108
Restoration Program, 11 Mission Support Computer Division, 11
Installing Screen, 28 Move, 108
Interactive Help, 86 Moving Worksheets, 94
Items of Interest Report, 79 MRI, 252
—K— —N—
Key Tab, 85 Navigation
Bar, 94
—L— Screens, 90
New, 113
RESULT, 248 Project, 16
SAMPLE, 246 Record, 94, 99
TEST, 247 Next, 113
Lab Project, 14, 45 Page, 121
Import/Export, 269 NT Administrator, 26, 29
Submissions, 81
Tables, 246 —0O—
Lab Transfer Utility, 32
LAB4.MDB, 44 Open
LAB97.DAT, 33 Book Icon, 84
Last, 113 Book Tab, 84
Page, 121 Project, 16, 109
LDlI, 250 Screens, 117
Like, 66 Screens Menu, 117
List Local Methods Report, 81 Opening a Project, 43
Load AFCEE Supplied Data, 110 Optimize Database, 115
Loading AFCEE Supplied Data, 50 Optimizing Databases, 88
Loca Option Buttons, 93
Methods, 47, 116 Or Statement, 65
Methods Maint, 114 Order By Clause, 62
Methods Maint Menu, 116 Other Information Required, 25
Methods Tables, 19 OuU, 265
Log File, 20, 54 OUC, 265
Logging In, 35 Overwriting Duplicates, 51
Login Screen, 35 OWL, 259
LOX, 265
LSX, 267 —P—
LTD, 255
LTX, 268 Page
Icon, 84
—M— Parent, 15
Password, 35
Main Menu, 106 Passwords, 36
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Paste, 99, 111
PC Conversion Utility, 30
PCHelp, 118
PDF Export, 119
Permissions Sub-menu, 29
Preview
Error Report, 109
Previewing
a Report, 103
Records, 70
Previous, 113
Page, 121
Prime
Project, 45
Project Import/Export, 271
Project Submissions, 81
Project Tables, 249
Projects, 14
Print, 119, 120
Current Page, 120
Current View, 70, 109
Preview File Menu, 120
Preview View Menu, 121
Some Pages, 120
Printer Setup, 119
Printing a Report, 104
Privileges, 17
Program Management Group, 27
Project
Management, 14
Types, 19
PROJECT, 249
PUMPINT, 260
PUMPRATE, 258

Quick Sort, 112
Menu, 114
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Read Me File, 26

Recent Projects List, 109

Record Menu, 112

Referenced Documents, 13

REFINFO, 31

REFINFO4.MDB, 44

Registration Screen, 26

Registry, 29

Removing a Sort or Filter, 68

Replace, 60, 111
Permissions on Existing Subkeys, 30

Replacing Values, 61

Report, 116
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Preview File Menu, 119
Preview Screen, 102, 103
Reporting Features, 23
Resetting a Password, 38
Restart, 29
Restore, 108
RESULT, 264
Result Table, 18
Rich Text Format, 104
ROX, 267
RS, 266
RSP, 266
RSX, 266
RTF Export, 119
RTI, 267
RTP, 268
Rules
Pattern Matching, 67
Run Sort, 62
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SAMPLE, 262
Save, 99
Record, 112
Saving a Report, 104
SCC, 251
Screen Tip, 104
Searching. See Find
Security, 17
Measures, 36
Select
All, 112
Record, 112
Selecting, 96
Selection Worksheet, 90
Serial Number, 26, 88
Setup, 26
and Configuration, 25
Default Data, 110
Short Titles, 245
Shortcut Key, 108
Show All, 111
Size, 108
SLX, 251
Software Requirements, 25
Sort
Ascending, 114
Descending, 114
Quick, 68
Removing, 68
Sorting, 61
Data, 62
SOX, 265
Specified Formats, 69
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SQL Statement, 63
Standard Query Language, 61
Start Installation Screen, 28
String Comparisons, 66
STU, 255
Submission, 77
Errors Report, 79
Status Report, 81, 117
Type Codes, 82
Validation, 78
Submissions, 22
Submitting Data, 77
Support, 12
System
Overview, 14
Requirements, 25
Resources, 118
Statistics, 23, 81
Statistics Report, 103
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Table
Fields, 246
Descriptions, 246
Fields, 246
of Contents, 77
Relationships, 15
Technical
Support, 86, 118
Support Options, 24
TEST, 263
Test Table, 18
Text Field, 92
Tiling, 117
Worksheets, 94
Tools Menu, 114
TOW, 260
TRI, 259
TWI, 258
Type of Access, 30
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Undo, 100, 111
Unsaved Values Warning, 58

Updating System Configuration, 28

Upgrading, 88

Use Default Datg 110
Vaues, 58

User
Maint, 114
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Maint Menu, 115
Maintenance, 37
Name, 35
Responsibilities, 17
Security, 17

Using
Default Data, 57
ERPTools/PC, 35
Local Methods, 47
the Help File, 83

—V—

Validate

Current View, 74, 111

Validating Data, 73
Validation, 22

History Screen, 82, 117

Rules, 14
Status Codes, 81
View

System Statistics, 114

VVL Data, 115

Viewing Valid Vdues, 38

VVL
Arrow, 96
Changes Report, 80
Listing, 42
Maint, 114
Maint Menu, 115
Tables, 19
Tables Screen, 38
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WCI, 253

Website, 12

Welcome Screen, 26
What’s New, 18

Where Clause, 63
Wildcard Characters, 66
Window Menu, 117
Windows NT, 25, 29
WINT, 254

WMI, 254

ZDl, 251
ZLX, 252
Zoom, 121
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